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j -3 IMPORTANT NOTICE TO ALL MULTISCRIBE CUSTOMERS
it When you boot up side 2 of MultiScribe your screen should look like this:

-
=

3 J . PR
In‘roducin Welcome to MultiScribe, the writing tool that brings state of the ant ol e 1 W
MuillSCr}bg text processing capabilities to your ipplc Me/1lc. MultiScribe is the E = :
: first word processing program 0 fully utilize the Apple's double ] fava C%/%kﬁ
high resolution technology — which means your documents can [ o - 7@. &4
have a clarity and wealth of detail never before seen on an Apple oy - " "j‘%'q%
lle/llc. Unlike other word processors you may have used, what J L/ y/4 &
you see on the MuliiScribe sereen is what you get on the printed E " - A (4»
pire — no confusing control codes on the screen, no unexpected e ‘ 2
relonnatling on your printouts. : ! . i Ak Lhe ‘d‘, 'Cb\’
oy WEVET, ! f’ .
VWit MultiScribe you can create customized documents using a r-:‘ i B ch et tam Mema ‘el @a b
vinety ol Jifferent type styles, called fonts, and you can even create i . A
your own fonts with MuliScribe Fontliditor, You can stylize fonts, - 11
ton. 1 b funt can appear in a wide range of sizes and in any E o
{

combination of styles, from boldface, itulic, and underline 10 outline
and shadow to subscript and superscript. MultiScribe converts your
Apple e/tle and printer into a software-powered printing press. E

sl

Aside from its unique font-handling capabilities, MulliScribe has all

the features you expect from a coniplete, professional word E
processing program. Ruler-based formalting options let you center

and ju51i$( text, adjust line spacing, and set tabs, margins, and page
breaks, You can search for any word — or any part of a word — in E
a document, and, if you want, replace it with a different word. You

can delete, copy, move, and replace (ext quickly and easily — with

a mouse or without. &

el

ANIC! The problem does not lie with your copy of MultiScribe, your Apple, or your
lr?gnbjgrr Rather, the p%blcm involves your extended 80 column card, Touse MultiScribe, your
Apple must be able to use the double high resolution graphics capabilities provided blh,w'
3 extended 80 column card. The double high resolution mode requires that the Double High Res
Enable pins (labeled "J1" on the lower left comer of your extended 80 column card) be connected
by a small plastic sleeve called a jumper cap.

iesaj i it shi do not own
Apple, [nc. supplics a jumper cap with every extended 80 column card it ships. Lf you

a Puprnpu:r cup.[;zur Ap]p'u: ﬁulcr or an clectronics stre should be able 10 supply you with m\e.f !
Simply place the jumper cap over the prongs labeled "J1," located on the buitom left comer of your
extended 80 column card.

i | .

Tor all its power, MultiScribe is remarkably casy to use. There are

no complicated commands to learn, no special codes o memorize, E
Pull-down menus let you view all your options at a glince, 0 you

can spend your time working on your decuments, not re-reading

(3 0

o
this manual Lrying 1o figure out how to perform a task. E o | by | x
i
So if you're used to old-fashioned word processors, you'll like the Jumper Cap

advanced Teatures and user-friendliness of MultiScribe. If you're E
new to word processing, you picked a great ime 10 start,

EE.

/b

1" pre L st s e
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Please let us kmow if you are unable to locate n&umpant if you are having asy other problema.
Our technical support number is (713) 668-0739., -
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About This Manual \a\\%q" Q&*v‘mhgmanunl explains how to use MultiScribe's many features
%,

\:ﬁb fo create, edit, and print stylish, professional documents.
o

Because MultiScribe’s FontEditor contains so many features
ofits own, it is meated separately from the rest of the program.
This manual is therefore divided into three pans: an
introductory chapter, three chapters dealing with MultiScribe,
and three chapters dealing with FontEditor. Appendices at the
end of the manual provide additional technical information.

Chapter 1, "Getting Started," explains how to start up the
program and how to get around in the MultiScribe
environment. This chapier should be read by everyone, but it
is designed especially for unyone who has néver used a mouse
or mouse:based softwiire before,

The next three chapers, “Leaming MultiScribe," "Using
MultiScribe," and "MuldScribe Reference,” discuss the
MultiSceribe word processor. Chapier 2, “Leaming
MultiScribe," is a self-paced wional aimed at helping you get
started with the basic word processing tasks of formatting and
eduing text, This chapter is especially important reading for
anyone who has never used a word processor before,

Chapter 3, “Using MultiScribe,” provides detailed instructions
for using ull the word processing features to be found in
MultiScribe. If you've used a word processor before, you
might want to skip Chapter 2 and go on to Chapier 3 after
reading Gening Stared. |

Chapter 4, "MuliiScribe Reference," provides a summary of
all the menus, commands, and dialog boxes found in the word
processing portion of the MuliiScribe program. Use this
relerence section when you need a quick, detailed description
of a puarticular MultiScribe function, i
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The following three chapters deal with the MultiScribe FontEditar.
Chapter 5, "Learning FontEditor," is a self-paced rutorial designed
to help you begin creating fonts and editing and designing
characters. This is followed by Chapter 6, "Using FontEditor,
which covers in detail the various tools FontEditor provides for
changing existing fonts and designing new ones. Chapter 7,
“FontLditor Reference,” provides a summary of menus, commands,
and dialog boxes used in FontEditor.

The Glossary contains definitions for some terms you may not
understand in your reading of the manual. The Appendices cover
technical matters relating to hardware and file management not
discussed elsewhere in the manual,

While we have made every effort to be thorough in explaining every
aspect of MultiScribe's operation, you may want 1o supplcmcml

our reading of this manual with a review of the ProDos User's
Khnuul, published by Apple Computer, Inc., which will greay
increase your understanding of the File Menu commands. If you
are unfamiliar with mouse techniques, you should look at the )
tutorial program on the MousePaint disk, which came bundled with
your AppleMouse I1.

11 ABOUT THIS MANUAL
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The purpose of this chapter is to get you started using MultiScribe,

The first part discusses what you need to get started, material you
should read and things you should know before smmn§
MultiScribe, ard how 1o make backup copies of MultiScribe ﬁlcs.

The sccond pan of this chapter, Starring MultiScribe, provides
step-by-step instructions for starting up MultiSeribe and explains
the MultiSenbe sereen layout and important features of the
MultiScribe environment,

In the third part of the chapter, Mouse, Keyboard Mouse, and

& Key Comnands, the three methods of user input aviilable 1o
you in MultiSenbe -- the mouse, the Keybouard Mouse, and

G key commands -- are explained in detail, 1f your mouse skills
are rusty, there's a brict review of mouse techniques berore more
specific uses of the mouse in the MuluScribe environment are
discussed, If you're not using a mouse -- or even if you are --
the explunations of the Keyboard Mouse and 3 key commands

will Elovuh. you with the information you need to perform tasks
quickly and easily in MuluiScribe.

Chapter 1 concludes with a discussion of dialog boxes -- what
they are, what they're |c11mg you, and how to use them.

15 CONTENTS
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Getting
Stanted

What You Need
lo Gel Started

Balore You
Begin...

Referenca
Matrrials

Getting started using MultiScribe is quick and easy. The Instructions on the
next few pages will get you up and running in no time,

MuliiSeribe comes on one double-sided disk. Side 1 contains ProDOS, the

startup program, and FontEditor. Side 2 contains the MuliSc rogram
and ten ditterent fonts you can use with MultiScribe. '@&

To use MuliiScribe, you'll need: 5, Gy, .@&

%, 9
V' an Apple llc computer OR an Apple Ile computer with a3

o, 0 .
I
1

extended 80 column card;
the MultiScribe Master disk;

blank 5 1/4" disks (MultiScribe can autornatically format
blunk 5 1/4* disks) or ProDOS formarted 3 172" disks for
document files;

V' adot mawix printer (optional),

Before you start up MultiScribe, there are a few things you should know
and a few things you should do, i

First, you should be familiar with The Apple ProDOS User's Manual
and The Apple ProDOS User's Disk, both of which came packaged

With your Apple computer when you purchased it. While the MulliScribe
User's Manual covers everything you need to know to use MultiSeribe,
you'll have a greater understanding of both MuliiSeribe and the ProDOS
operating environnient if you read the ProDOS manual and become familiar
with the vseful uulity programs included on the User's Disk. With your
incredased understanding, you'll be able to take full advantage of everything
MuluScribe has 10 offer.

Il you're using a mouse with MultiScribe, you'll probubly want to run the
MousePuaint worial included on the MousePaint disk that came with vour
AppleMouse TLIE you haven't run the program before, it's an excellent
introduction to the basic techniques involved in using a4 mouse. If you've
run the witorial before, run it again for review -- it'll serve as a good
warmup for MulliScribe,

16 CHAPTER !: GETTING STARTED
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MultiScribe
Terminology

R — ——

You'll find that this manual uses some very familiar words in ways that are
not quite so familiar to you. Some of these words are discussed below;

others are defined in context later in the manual. Please take the time 10 read _

the following definitions,

document -
A MultiScribe document is any text and formatting you create at one time in
MuliiScribe. When you save a document, it becomes a file on disk and has
a ProDOS filename.

task

A task or operation is any word processing job performed by MuliiScribe.
command L .
A MuliScribe command is any instruction you give MultiScribe 1o perform
an operation or task.

oplion

Frequently, a MultdScribe command gives you a choice of several different -

wilys it can perform a task. These choices are called options.

highlight
When something - text, a ruler, a filename - is highlighted, it appears in
inverse video on the screen. The pans of the highlighted material which
normally appear light will appear dark, and vice versa,

sclect

When something is highlighted in MultiScribe, it is usually selected, which
means that it has been chosen as the portion of the document to receive the
action of the next command.

chouse
Whereas you select something to receive the action of a command, you
choose a command to perform a task.

17 BEFORE YOU BEGIN




%0 F-3
6‘0 I
e . T e 5%, 4 :‘3‘1&"’*0& AR Starting’ = - Insert the MultiScribe disk, sld: I1 fa:lng up, Into
ackups ccause MultiScribe 3.0 is copy-protected, you may want to obtiln d'y : ive and closse the drive door.
Pagkvp.copy of the proeram. oucan get  backup of MultiScribe 34, fér "%, H MultiScribe your disk drlv
8 Ssmu o] i

¢ by contacting StyleWare at cither of the product order phofi 7
numbers listed in the inside back cover of this manual, or write to ~
StyleWare at the address also listed on the back cover. Both protected anﬁ'{( s
unprotecied backups are available to registered MultiScribe owners. 2

A

= Turn on your Apple computer and your monitor.

A
G

The drive stanis whimming, and, a few seconds later, the MultiScribe
title screen appears. 1f you're using a 5 1/4” drive, a message appears
a few moments later, asking you o inscrt side 2 and press Return,

=
&

ml\
é@ﬂu

You can copy MultiScribe 1o mass storage devices such as hard drives and
3.5-inch dnves. For instructions on copying MultiScribe to a hard drive
or 3.5-inch drives, see Appendix F, "Using MultiScribe with a Hard Disk
Drive or 3.5-Inch Disk Dnve."

wd
$

If you're using a 5 1/4" drive, \ake the MulliScribe
disk out of the disk drive, turn it over so that side 2
faces up, and place It back In the drive. Close the
drive door and press Return.

MuliiScribe can also be installed on your RAM drive. For information
about installing und using MultiScribe on RAM drives, see appendix |,
"Using MuluScnbe with a RAM Drive,

e

mom m

Han| el o] o] fon] loo| ol fi-—T] 3

The drive stans whirring again. The screen clears, and after a few
moments your screen looks like this:

ki

The scroll bar lets you

- ; i move a document up and
R e i
i ’ indow by draggin
Creating You'll probably want to create blank, ProDOS formatted disks on which menus from which you ~~__g fiv 6 Seurch Formal Foal Sua Sire :;nm:m :. LEing
niulhiSeribe 10 save your MultiScribe documents. If you're usinis 14" drives, you choose commands. | 0
Document cun have MultiScribe automatically format your disks using the Save or

Save As commands (see “Saving a Document with No Room on Disk” in
Disks Chaprer 3, "Using MuliiSeribe”). If you're using 3 1/2" drives, you'll
wint to use either the Apple 1| System Utilities or the Copy 11 Plus utilities
w Tornat some blank data disks. .

A
The Mashing vertical bar is

called the cursor, 1t marks
the insertion point, the

plivce where (ext appeans b
us you lype,

The document /

window is just

Ll ikl

The thumb contains the
number of the page
displayed i e

I you're using the utilitics on the ProDOS User's Disk (version 1 of dociment wikhiw,

the Apple B System Unlities), choose the "1 - FORMAT A VOLUME"
contnand hronthe VOLUMIEE COMMANDS menu of the Filer utility. 1f
you're using the Apple 11 System Utilities (version 2 of the Apple 11
System Utiliies), choose "6. Format a Disk" from the main menu, If
you're using the Copy Il Plus utilities, choose "FORMAT DISK" with the

w

i

-
‘

that -- the
PRODOS" option from the main menu. :! “window* th-ough NI you press the serol
§ which you viw arrows using te
wd edit your vord mouse, the ks wincid
'J rocessing wikdow srolls
: documents, conunuously,

This s the MultiScribe document window, through which you'll create
and edit text. i

19 STARTING MULTISCRIBE
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Mouse,
Keyboard
Mouse, and
" Key
Commands

1.

Using the
Mouse

Movlng the
Polnter

...........Q‘. armie wain s i) ) _ J‘-"
% C = s
o(h 'Qﬂ’zookp -
G 1y G e
MultiScribe works with two inrpul devices — the keyboard and thepignsz
- and lets you perform each of its word processing operations at Jéast i —:
and sometimes three, different ways. The next part of this chapter cxﬁl Sf"s :"" >
how to use both the mouse and the keyboard to edit text and choose T ‘74{,
communds. If you're using a mouse, you'll want to read the next three N4

sections below, since you can combine mouse and keyboard actions and )
ity find it uselul ut times 1o do so. If you're using the keybourd only,
Justread scedons 2 and 3, which discuss different wiys olychoosing
commands with the keyboard.

If' you've run the tiorial that comes on the MousePaint disk, you're
probubly Familiir with the basic techniques involved in using the mouse
and will wint 1o skim down 1o the discussion on choosing commands
from the menus. If you don't have the MousePaint ttorial or if you're
using a mouse other than an Apple mouse, you'll want to read the next
section carelully, expenimenting with your mouse as you read.

Notice the arrow in the upper left comer of your screen. This is
called the pointer,

= Move your mousa on a clean, flat surface, walchlng
the polnter as you move the mouse.
The pointer moves on the screen in the direction that you move the
mouse. When you move the pointer in the menu bar and scroll bar, it

remains an aow, but it changes (o an I-beam when you move it into
the document window,

20 CHAPTER 1: GETTING STARTED
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Review of
Mouse
Techniques

To use your mouse
with MuluScnibe
‘vull only need 1o
zl,n\\ these
tlechinigues:

< Clicking, 10
Chownsg an apton,
Place ninsertion
watan text, or
conbinm uan
uperaton,

. l)ullhlc-k'lickin}!,
Yuiorly chicking the

modse button e,

atlowes you o select
donitnent and font
filesin seroll
Wildow s,

¢ Pressing, 1o
el a Lontinuous
i Ly,

* Dragping, 10
cunbinaonsly select
sutticthing (like
lext) or choose a
command from a
men,

tlx
."
Yo Click Ee =3

= Posltlon the polnter on the place In text or option you
want to choose,

= Press and quickly release the mouse button.

In MuliiScribe, c]ickmg 15 usually used for selecting oplions and

placing the wsenion point at a specific place in text. Double-clicking,

uickly clicking the mouse bution twice, is used 10 select and deselect
ocutnent and font files in scroll windows,

a
To Press (00&
= Position the pointer, e, 04/00&
<%, 1
4,«0 410
= Press and hold down the mouse button wnhﬁqj s, (@4,
moving the mouse.

The effects of pressing continue until you release the mouse buttoi’

To Drag
= Positlon the polnter.

= Press and hold down the mouse button while moving
the mousa.

= Releass the mouse button.

To cancel a drag in propress, move the pointer back to the place where
you began the drag before releasing the mouse button,

22 CHAPTER I: GETTING STARTED
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You press rather than click when you need to cause a connnous agtion,
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Using a Mouse:
Pulling Down &
Menu

Pressing:
Looking at
the File
Menu

Dragging:
Invening the
Screen

. Fl : . . ; . . hod
t you'll use clicking, pressing, and dragging while leaming one met
| Efe:hg:sl;ng commands;girlt)Muhj cribe -- pulling down a menu.

| You'll begin by pressing o look at a menu.
; At the top of the screen is the menu bar, which contains the names of the
menus from which you'll choose commands.

| = Use the mouse to position the polnter on the word “Flle" In the
menu bar.

= Press the mouse button and hold It down. Look over the Flle
Menu.
The first line on the menu contains the word “Untitled." This is where

the title of your document appears -- and MuldScribe is telling you that
your current document has not yet been piven a name.

| = Release the mouse button.

i i ¢ isplayed or “pulled
sssinp on a menu title causes that menu to be displayed
zlj):JL\;:i."hthu you release the mouse burton, the menu disappears.

Each MultiScribe menu contains commands grouped together by the

=l

type of task they perfonm: all the commands on the File Menu, for

%
(2

= Drag the polnter down the G Menu until the words
“Invert Screen” are highlighted.
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i eni avi inting files. You can think ot |
example, deal with opening, saving, and printing les.
of l!w[ n:cnu bar s a collection of Flll: drawers containing all lr}c 1ools =
you need o create and edicdocuments. thnlynu pull down a mc:nu’%J % Oo
you “open adrawer” W choose a partcular ol ;%1‘ 7;4‘-“- -
; " !
Next, you'll choose a command by dragging. % ca\/ ,90
d 5 Tk
= Position the pointer on the G character on the menu bar an ”‘a, _;%; j
press the mouse bulton. o‘ % %
. - ﬂ .
“The % Menu, contuning miscellancous commands, is pulled down. . .

Clickingon a
Button to
Confirm an
Operation

= Release the mouse button.

As you drag the pointer over a command on a menu, it becomes
highlighted, indicating that it is the currently selected command. -

Releasing the mouse button while a command is selected chooses the ™

commaund and performs the action associated with it

You've just chosen the Inven Screen command, which reverses the
way the background and characters appear on the screen. In this case,
you've changed the screen to light characters on a dark background.
Choosing Inven Screen again returns the screen to durk characters on a
light buckground.

Next, you'll learn how to click to confirm an action.

= Pull down the 3 Menu and choose About MulliScribae.

A box appears inside the document window. Boxes like this are called
dialog buxes, and they appear in MultiScnbe whenever you're
perfonning an operation which calls for additional informarion, a choice
of severul options, or your approval before proceeding, Here the dialog
box appears 10 complete the command you've chosen by providing you
with infonnation about MultiScribe. The box tells you the version
nuniber of the program, the authors of MultiScribe, and the amount of
memory left for the current document.

At the bottom of the dialog box is another box containing the word
"OK." Liule boxes like this are called buttons in MultiScribe. When
you “press™ a button by clicking on it, you perform the action
assuctated with the word on it, 1t's as if the mouse button becomes a
physical extension of the buton on the screen.

Here you'll tell MultiScribe that you're finished reading about
MuliiScribe by clicking on the OK button.

= Posltlon the polnter on the OK button and click the

mouss bullon, -

The dialog box disuppears.
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2. Using the
Keyboard
Mouse

Y, J

To sum u[;cwhm you've leamed so far about using the mouse with
MultiScribe:

Y The mouse allows you to perform tasks through the use of a
Ko pointer.

Y% “4,¥  The pointer appears in three different forms on the screen -- as the

@ 5, 9, the I-beam, and the wristwatch
b O arrow, the I-beam, and the wristwatch.
(O 3, 4’0

i SaV 'ﬁ{frc are three basic mouse techniques used to perform tasks in
MuliuSeribe -- clicking, pressing, and dragging.

You pull down menus by pressing.
You choose commands from menus by dragging.

N
v
V' You click on buttons to confirm a choice or perform an action.
v

The Invent Screen command reverses the way characters and
background appear on the screen.

v The About MuliiScribe command tells you about the version

number and authors of the program, as well as how much memory
is left for the current document,

Next, you'll learn how to perform the exact siume tasks -- with the
keyboard,

A mouse is an extremely handy input device, but not everyone owns one,
and some people prefer not to use one. For those people who don't use a
motse, Mulli.&fnhc implements what's called the Keyboard Mouse -- a
proup of keybourd keys used topether ina special way to imitate the way the
mouse lets you perform tasks, like choosing comnuands from pull-down
menus, 1 you do use i mouse, you can still use the Keyboard Mouse as
well, and it tmes you may find it convenient to do so,
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Choosing
Commands
with the
Keyboard
Mouse

To choose a command with the mouse, you first use the mouse to pull
down a menu. To pull down a menu with the Keyboard Mouse, you must
first activate the mer.u bar,

= Press the Esc kay.
A menu appears under the 3 character, which is highlighted, indicating

that that menu is selected. You've just "pulled down” the 3 Menu.
The first choice on the menu, About MultiScribe, is highlighted.

Pressing the Esc key activates, or tums on, the menu bar.
= Press the Esc key again.
The B Menu disappears.

Pressing the Esc key a second time deactivates, or tums off, the menu
bar. The Esc key is like 2 toggle -- an on/off switch -- for the menu
bar.

= Press the Esc key.

The G Menu is again pulled down,

The last menu displayed when Tu)u deactivate the menu bar is the menu
which will be displayed when the menu bar is again activated.

= Press the | key.

The sccond command on the G Mcnu, Invert Screen, is highlighted.

o~

=» Press the | key again.
The third command on the menu, Printer Setup, is highlipghted.

= Pross tho T koy.

The Invent Screen command is again highlighted, '
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M - ] ~
< pPY T a3l Per i§
> 05 -
CABE cponn P E0 oM fie - :
8-> : 5 Pulling Down So far, each time you've activated the menu bar, you've seen only the &
V9 The Tand & keys Je you move up and down through a menu, Menus with Menu displayed. Next you'll use the Keyboard Mouse to look over some
When a command appears highlighted on g menu, that command is the ru d of the menus,
currently selected command, which means thyt the action F- '+ the Keyboar
associated with the command wil| be performed if you confirm the Mouse = Press Esc,
command by choosing it, When you're using a mouse you choose a ™
command by releasing the nioyse button while the command is selected. F- "oy A is pulled d
When you're using the Keyboard Mouse, you choose » command by The G Menu is pulied down,
pressing the Reyurn key while the command i sclecied, i
B0y = Press the — key,
= Press Return,
The word "File" is highlighted, indicating that thar menu s selected.
The & Menu disappears and the dark ynd light portions of (he F“ 1 -; Phe File Menu is pulled down,
#r.cc? ound " rsed so that light characters APpear on a dark The first line in the File Menu contains the word “Untitled.” This is
background : S
: EC where the title of your document appears -- und MuliScribe is telling
. . = - you that your current document hay not yet been given a name,

Congratulations -- you've just chosen the Invent Screen command, '
which, as you can see, reverses the way things are displayed on your ] = Press the « key.,
SEreen. Some people prefer light characters on a dark screen; some ‘ =
prefer alighy screen with dark characiers. Now you know how 1o The File Menu disappears and the & Meny is pulled down. About
adjust the sereen display 1o suit your preference, & 0z . MultiSeribe is selecied,

For now, however, lel's retumn the'screen 1o the way it was before you . 5
chose the Invert Screen command, — When the menu bar is acuvated, the ¢« and — keys let you move from

m “ title to title on the meny bar, pulling down each menu as it's selevied,
= Press Esc. You've just leamed 4| you need 1o know abaout the Keyboard
y ) , : ' Mouse for now, Ol course, there's more 1o hnow -- for example,
Mhe 3 Meau is pulled down, =) how 10 use (he Keyboard Mouse 1o select text the way you select text
with a mowe. [or now, however, you know enough,
= Press the | key. ;
¥ E s Before you go on 10 the next section,"Using he (3 Key Commands,”
The Invert Sereen command is highlighted, you should know about the Keyboard Mouse and dialog boxes.
' =y d = Press Return to choose About MultiScribe.
= Press Return, S
4 : ) ’ i IF you read section L"Using the Mouse you hiow that the oy
The (3 Menu disappears and the Screen again shows dark characters on E ARSEY displayed is ealled g dialog bow, |f YOU'TE 0L Ustng 4 miogse and
@ hght back pround, - didn't read section 1, you should know thut a dialog box is a messape
displayed by MultiScribe whenever you're performing a task which
E ") 5 requires additiony] information or your approval before proceeding,
[ =
28 CHAPTER |- GETTING STARTED ﬁ oy 29 USING TIHE KEYBOARD MOUSE
-_d
>y

= =



R

S

%

Here the dialog box gives i i

L you the information you've request

choosing the command About MultiScribe. Agoul MmSCrigcd l!.):)l’ls ou th

;f:j.\lulc(;r;ynrumbgrland'_aullr}ulors of the program as well as the amount ofy i
ory remaining for the current document. It will stay o i

you conlirm that you've finished reading the message b;pg;&;;e}ﬁf&:ﬂﬂl

?és =» Press Return.

o OO& ;
4,% h‘algfga!ug box disappears.
Ve
A 0-3'; (ff
R ICTNLZ)
Levs St Fize lipey
e W Ebgy ve leamed using the Keyboard Mouse:
15
v Prcssn@ the Esc key activates the menu bar. The menu bar

ins activated Llnul yOu ]'Jllts (-1 ES’C kc agall 00!
s lh
remea y g n or Ch €

V' You choose a command by:

1) Using the T and ! keys to select a command on a
pull-down menu;

2 I TESSIN RCIU“I to COIlleIll our C]IOI.CG of thc sC]CClcd

V' You move from menu to menu with the « and — keys

V' The Invert Screen ¢ :
: command reverses the way characters
v H a
back ground are displayed on the screen, ; &

Vo About MuliiScribe tells you about the version number and the

authors of the progrm, as well iy i
i, as its the amount of room in
left for the current document. i

°

= Before golng on, praclice using the Keyboard Mouse to
look at each of the menus.

In the next section, you'll learn i
: about the & Key equivalents for th
pull-down menu commands, 4 Lo
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While looking over the menus, you may have noticed that some of the
commands on some of the menus appeur dimmed.

Pull down the Edit Menu.

For example, on the Edit Menu the commands Cut and Copy appear
dimmed, whereas the Paste command is displayed normudly.
Comminds that you cun't use right now are dimmed on the menu and
can't be selected or executed. Cut and Copy can't be used right now
because they require that you select text o cut or copy and you have no
text in the docunent wimhxw. Paste, on the other hand, copies the
contents of the Clipbourd into the document window, and 15 always

usuble,

While you have the Edit Menu pulled down, notice the charicters 10 the
right of each of the commands on the mend. These are called 3 Key
Communds, and they represent the key bouard equivalents of the
commands on the menu. These are the keys you press on the keyboard
1o elfect commands without using the pull-down menus uat ull. To
perform the Cut command without pulliing down the Edit Menu, for
example, you would hold down the & key (or the @ key) and press

the X key.

Most of the Apple Key Commands have been assigned charucters
which are easy to associate with the action they perfonm. Copy, for
example, is (GC. Cut, which removes text, is X -~ the text is "X-ed
out.” Paste, which insens text into the document window, is ZV-- and
the V symbol is a copyreader's symbul which means, “insent additional
material between theye characters.” Also, cichi ol these commonly used
commands is located close 1o the (3 key on the second row from the

bottom of the keyboard, and so can be typed eanily using one hand.

Most of the commands hiave easily remembered ("mnenwonic”)
characters associated with them. There are only 26 leters ol the
alphabet, however, and not every command could simply he given the
first letier of the command name. Also, there are I key commands
for scrolling text which are not located on any of the menns, For sour
convenience, therefore, there's a chart i Appendix B “Keshwoard
Commands,” which lists cach commund with a heyboard cyuivatlent,

the action performed by the commiand, and a handy tip for remembering

the command.
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Dialog Boxe\s@% Wi 81 you chose the About MultiScribe command, a dialog box was
{
Qv

¥y

=
i &5 »i 23 Xi

At the top of the dialog box is the PATH input bar. Input bars allow
you to type in information. When you click on the input bar with the

~ mouse, click on the PATH button, or press GP, the insertion point
appears in the input bar, allowing you to type.

. “isplayed on the screen until you clicked on the OK button (or pressed
o Rewum) to indicate that you were finished with the message.

Y MultiScribe uses dialog boxes to obtain information from you or 1o get
your approval before performing an action,

=

The large box on the left is called a seroll window. Scroll windows
contain information, usually in lists, which you scroll up and down by
clicking on the scroll arrows or by pressing theTand L keys. The
document window, for example, is a large scroll window. When a path
is selected, the Print Merge seroll window normlly contains a list of
filenames.

i |

The About MuliiSeribx dialog box is pretty much a pical dialog box
== it provides information and requesis your input before disappearing
froni the screen, Some dialog boxes use methods other than Kutwns ]
get infomation from you. This section will examine each of these
mput methods by revicwing one command which uses wo dialog
boxes «- the Print Merge commund, located on the File Menu.
Cubined, these two dialog boxes demonsirie practically every
method used by MuliScribe diglog boxes 1o obtain your input,

- .

Once you've provided the necessary information, the buttons on a
diidog box either confirm a decision, perform an action based on your
input, or allow you to cancel the operanon altopether. On this dialog
box, fur example, the OK button tells MuliiScribe that you've

finished providing the informanon requested by the tirst dialog box and
that you're ready 10 go on 1o the next one,

The actaal function of Print Merge is 10 allow you to link files together
for printng documents, but that will be discussed in a later chaprer.
Whatis impornt for now is the way the Pring Merge dialog boxes
wolk,

moMom m
;

ECIEEE!DEEDDICICIGIL

lal

= Choose Print Merge from the File Menu. = Click on the OK button or press Return.

al

The first dialog box appears.

l

optlon lines the EurTent; ssing seltings

m m

roll arrows -
L] . —— L]
iapataar l Print Harge ] = rint /
7 ; ol . Teagewrifer Super kerial or fr'e Ile porl
[PATH_iLniseRizes it o .o Quality: ONLAL ONLO2 O Hlgh @ Standard O Drafl o'Tex! O Preview
f | KD wr | ﬂ Input Dar——— 1 Pepies={T_] Paper feed: o Conlivuous  0Cul Sheel
2 [{..m;k:isdﬂnﬂ g; b o Page range: @Al 0Froa [_] o
; F TS LeF : l_] Press RETURN) 4
| Aot L i @E Press )‘“/ o= A butt n,/-.__ — —4 o
3 § PalLlubala Le'f ' [] o Input bars
| SIVUITEND  LeF ; . ;
: ] ff..t'fsm I3 Selecl 7| Press (SPACE) Ry A second dialog box appeirs.
: [ E] i Like the previous one, this dialug box contains buttons and input bars,
= i 22 IHowever, this dialog box also contains yet another device used by
l Dﬂ fiss e [Wms L Jm e :j MuliiScribe to obtain your input -~ the option line.
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St : : v i ! red everything you need to know to start Jeaming
An option line consists of multiple settings — empty circles 1o the left G "4 Summary In this chapter you've covered ;
of the options they represent -- which you mark 10 indicate a choice how to use MuliiScribe. You've leamed how to:
amony several options. The Quality option line in this dialog box, for ) b
fx:ump'!;c, gives you the choice of having your document printed in Text, E ‘. V' start up MuliiScribe;
Jralt, Standard, or High quality, NLQ\ (near letter quality), or NLQ2 ’ Qi huae
(also near lever quality) print mode. The current setting is marked. : aa V' muke backups of MultiScribe; i
To mark a setting: 3 & v use the mouse and/or Keyboard Mouse to perform tasks; >
/ : g . ands from the menus;
¢ Il you're using a mouse, click on the setting. E : q j stiwosc ebmmaasfronithe
choose communds with keyboard equivalents;
» Il you're using keyboard controls, press theT and | . o _ ]
keys 1o move up and dewn between option lines, The selecied E y ¥ provide information to the program through dialog boxes.
setung flashes. Use the « and — keys or Tab and GTab
keys 10 move left and right among seuings. When the setting = ) In the next chapter, “Learning MultiScribe,” you'll start leamning the basics
you wunt to mark is chosen (it will be flashing), press the = : of word processing with MuluScnbe. If you huve questions about how to
space bar, rform a specilic task, refer to Chapter 3, "Using MuluScnbe.” If ou
e : ‘ ; == ﬁfm questions regarding a specific command, see Chupter 4, “MuluScribe
Some optivns, like Page Range, combine settings and input bars. o] Refértnees
Since you have no document files to print, you'll want to eancel this T
operation, Canceling an operation simply returns you to what you =

were doing before you begun the operation.
Y
Qg Click on Cancel or press Esc,

% 04,':'?@& ditlog box disappears,

) la

= r
[V ¥ LE.

[ § &

9
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Introduction

This chapter will teach you the basics of word processing with
MultiSeribe. The first part, Creating Text , discusses the insertion
point and shows you how 10 insert text. You'll learn how word
processors use word wraparound to give your typing greater speed
and efficiency. You'll also learn how 10 delete what you've just
typed and how 1o use carriage reums (o insert blank lines.

The second parnt of Chapter 2, Formatting Text, discusses the
various wiys you can armungie your writing on a page and shows
ou how 1o use margins and tabs, as well as more advanced features
ike multiple line spacing, justification, and centering.

In the third section, Editing Text, yow'll learn how to select text and
how to insert over, delete, copy, and replace selected text. You'll
also learn how to change the style of your text by changing the

. fonts, font styles, and sizes.

Chapter 2 concludes with a short exercise in which you'll create and
edit a short business letter using your new MultiScnibe word
processing skills.
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locition in your text at which you'll be typing, Everything
you do 1o your text -- inserting, editing, or deleting text -- is
done at the insenion point. When you sian a new document,
the insertion poing js always placed ap he 1op left of your page.

= Press the « key until the Insertlon polnt Is to the
lett of the word "betler."

1

"a litlle" and press the Space bar,
= To seo how the Insertion point works, type In the = Type the words P

Elg i
‘ f
o F=3 |
Crea[ing Text 'nm{wug }ﬁ[‘%mm. Yyou will use most frequently in D It You'rs Using the Keyboard
ored fn%gg:m’naw 18 Iserung, or typing your text, £ .
\,\36% R 53;0 BE o= ~ Use the &, =, L, and T keys located at the lower right of
gl 4 ' inserti int to the place in your
Typlng at the pifee the blinking bar at the top left of your screen, This is U ﬁg“j{,r',‘fcﬁm‘::f y'gﬂv\ijﬁftgfﬁ'ﬂmﬁm Sl 4
Insertion Point alled the cursor. It marks the insertion point, or the F' ma :1 '
g 3

1 am
following sentence: . D The words "a little" are insened into your text.
A penny saved is better than nothing, - ; r
penny g 2 D - If you're using a mouse, notice that while yglllhl c&mc I
! isappe: again, and the 1-beam
Notice that when you press 2 key the letier appears on the lefy ::c;m Q‘:;»;IPPCMS- Move the mouse ag
side of the insertion point, When yOu type, your text appears T i
wherever the insertjon point is located on your screen, D , :
E pevony E Look at your text. The insertion point is now[lhocalcd in the i
, ; : ; : . i - Inorder 1o 1type another sentence, you
Inserting Text The insertion poing controls where your text is placed on the middle of your sentence. In s
screen, You, however, control where the inscm%n point D must move the insertion point 1o the end of your first sentence,
&ppears on the screen, By moving the insention poini, YOu can (=== 3
add a word 1o the middle of a sentence or a sentence o the — e Us/ Mouse !
middle of a paragraph, U If You're Using a Mous i
Let's insert some words into the middle of the sentence YOu just - = Move the I-beam 1o the right of the perlod at the end
typed, of your sentence and click the mouse button,
Inorder 10 move (he insertion point to the place in your E ﬂ . I
document where you wish to insert text: v ; i
: It You're Using the Keyboard ;
It You're Using a Mousa E . ﬂ ;

= Press the - key unlil the Insertion polnt Is located

jpoul use the mouse 1o move b Lbeam (ihe verical bar that to the right of the perlod at the end of your sentence.

looks like the lener “I') to the place in the document where you
wish 10 insert texi,

LE

The cursor is now at the end of the first sentence.
= Move the I-begm lo the left of the word

"better" and click the mouse,
40 CHAPTER 2: LEARNING MULTISCRIBE
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: B W ﬂ
| ‘ R\ a3 - MultiScribe uses word wraparound to adj
! paround to adjust your text
i g‘h %’5\ ‘er;‘bg lﬁﬁ. space bar twice and type the following F : whenever you make a change involving more than one line of
‘ o A o EHtence: text. For example, word wraparound adjusts your text when
j QWY cRT” W B = = you insert or delete words or change the margins.
1 N Unfortunately, a penny won't buy much, ) :
f o U Let's see how word wraparound adjusts your text as you insert
‘ The new sentence is insened after the first sentence, and the F.' = q charcters. :
insertion point is now located at the end of the second sentence. D i
You can move the insertion point to any location in your text. F‘,‘ - q If You're Using a Mouse
Remember, the insertion point marks where your text will ]
fRpeat o) D : = Fosltlon the -beam to the left of the word *Luckily”
B o and click the mouse once,
Word When rou typed the sccond sentence, the whole sentence didn't
Wraparound fiton the first line, and the words that didn't fit wrapped around -

{4

¥

1o the line below. This is called, naturally, word wraparound. It You're Using the Keyboard
Word wraparound is a word processing feature that
automatically moves the insertion point and the word that you're
typing from the right margin lo the beginning of the next line.
With this feature, you don't have to press the Rerurn key when
your text is at the right margin,

= Move the Insertion point to the left of the word
“Luckily."

L4
)

m

b

= Type the following sentence and press the space bar

= With the Insertion polnt localed at the end of the second tylga:

i sentence, press the space bar twice, and type tha

£

following text without pressing the Return key.

Nowadays, you'll need a lot of pennies to buy
anylhing at all. To buy a hamburger and french fries
you'll need appruximately 400 pennies. Luckily, we
have currencies other than pennies, which makes

That's a lot of pennies|

The sentence is inserted into your document, MultiScribe has
reformatted the paragraph to make room for the added text. If
{:{)u press the Rewrn key atthe end of each line in a paragraph,

urléiSa-ibc will not reformat your text when you add or delete
words,

i life easier - especially for hamburger stand owners.

NOTE:  Always allow MultiScribe to word wrip
textan the ght margin, Press the Retumn key only at
the end of a puragraph or when skipping a line,

|
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| Usling the Delete The Q&c\‘; kéy ?vcs the insention point backwards, removing E oY If You're Using the Keyboard
. Key |c1ﬁbn Heg,at & time from your screen. Use the Delete key to D
%0‘31:55@ Q@kcs. = - = Usae the arrow keys to move the cursor to the end of
. : the paragraph.
\\:3(:, Qp\*ﬁ)‘ﬁ%'ra Using a Mouse D parageAp
()\a of - - a
"= Posltion the I-beam at the end of the last sentence E ~ " = keess e RGO RACe.
and cllck the mouse. [] o You've started a new paragraph. The insenion point is now at
" et o= ) the left margin, one line below your first paragraph.
It You're Using the Keyboa D -
_ - 3 = Type the foliowing list. Press the Return key after each
= Use the arrow keys to move the Insertlon polint to the E ok | word In the line.
end of the last sentence. D
E— 1~ nickels
= Press the Delete key until the entire last senlencs Is : dimes
deleted. & D . quarters
B X
The insenion point moves backwards, deleting text one letter at [] L4 —
s E — lI:JOTE: If you hold the Retum key down 100 long, the
. m 8 ey repeats, putting in unwanted camage returns. |
_ MultiScribe word wraparound reformats the paragraph. Notice have 100 mar?y linfs alter pressing the F%ctum key, sir?w?;ljy
: that when the number of characters 1o the left of the insertion _ press the Delete key. Unwanted carriage retumns are removed.
point equals the number of spaces available for characters at the t -
end of the line above, the remaining characters on the line and L=
the insertion point move up 1o the end of the line above. This is n ;
called word wrap up. E m 4 Formatting Text You format text in MultiScribe by using rulers to set margins
e and tabs, line spucing, and text justification.
i Carrlage The Return key is used e end paragraphs, skip lines, and when . H )
Returns: the ) typing text which ends before the right mur.rgm. MglnScnbc 1 E -
Return Ke considers a paragriph to be any amount o o = from severa. ﬂ " Rulers To set the formats for your text, MultiScribe uses rulers that
’ y pages 10 one character -- followed by a carmiage retum. contain various format specifications. MultiScribe stanis ;ich
E CES 5 new document with a ruler located at the top of the page.
| If You're Using a Mouse ﬂ X To see the ruler, you'll use the Show Rulers command.
' - a4
f = Posltion the I-beam at the end of the paragraph and = C = Choose Show Rulers from the Format Menu or
i click the mouse. B “ press tho G and M keys simultaneously.
= E o
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(’ngiblc. you can change the various ruler formats,

&%Q Q"ﬁg‘:‘\t?ucr appears at the top of the page. When the ruler is
Lelt margls markerC

spex ifics the lelt
magin of your
donument,

Indentalion murker
wi e ualentation
ol the Linst line ol

<

T

|

L

The Inch scale lets Tabs define Justification option Right margla

you delermine where the Tab key settlngs let you marker

where 0 place tabg will mave the choose o lefi-, right-, specifies the nght [
and margus for nseruon point or full jusufy or margin of your
formatung your when pressed. docyment,

Cenler your Lext
document I

Every puagtaph,

I;|.I.|.|Ei|.l‘.lix13.1.£1|.N‘l.\nl"il,.l.l\ls.k.ln,l?n;l\l

ng spudin A i h ] & ] [
S \Eucmm ob 81 02 03 Juslity: elefl Jm‘ght \oruu\om'ter

let yra et
line sjwung w0 rero-,
sngle | double |

and wiple spacing

Sctting the
Indentation Alarker

The sections below explain in detail how to use cach of the ruler
sclings.

The second marker located on the left side of the ruler is the
indentaion marker, This marker is a small straipht line with a
trangle on the bottom right side of the line. When you first
st up MuluScribe, the indentation marker is on top of the left
murgin, and together the twa settings look like this:

The indentation marker tells MultiScribe to indent.the first line
of every paragraph, To move the indentation marker;
i You're Using a Mousa
= Move the mousae Into the ruler.
The pointer changes from an I-beam to an arrow,
= Drag the Indentation marker to the 1 1/4 * marl.
The indentation marker moves 1o the 1 1/4 inch mark.

= Move the polnter back Into your text,
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The pointer once again becomes an I-beam.

Notice that your text isn't changed until you move the pointer

out of the ruler. MultScribe lets you make multiple formatting
changes at one time by waiting for you to move the pointer out

of the ruler before redrawing the screen,

It You're Using the Keyboard

= Press the T key to move upward through your text
until the cursor Is localed on the left margin marker
(the triangle located at the far left side of the ruler).

NOTLE: The cursor will always move o the left margin 3
mirker first when you move the cursor to the ruler. When the
cursor is in the ruler, the insenion point disappears from the
document.

The left margin flashes when the cursor moves onto it

= Press the — key once to position the cursor on the
Indentation marker.

The indentation marker blinks when the cursor is placed on it. i

= Holding down the G or @ key, press the — key
until the Indentation marker moves to the 1 1/4"
mark on the ruler's Inch scale, ’

The indentation marker moves to the right each time you press
the — key. To move the setting selector -- in this case the
indentation marker - to the right in greater increments, press the
T key while holding down the & or & key.
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Sslling Margins
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= Press the | key twice to move the cursor from tne
ruler to your text.

The insertion point retums to your text.

Look at your text. The first line of your first paragraph has
shifted 10 the right, us have each of the words below 1t
(remember, MultiScribe reats any text -- even a single
word -- followed by a cardage retum as a paragraph). Each
4, time you move the indentation marker, your text will be
3 ’O(F;-:sdjm:cd accordingly.

Stidaly

"Rmember, in order for MultiScribe to reformat your text
according to the fomut options on the ruler, you must move the
puinter or cursor from the ruler 1o your text. This wiy,
MuluSeribe ullows you to make as many format changes in the
ruler as you want before your text is actually reformatied,
O

There are two margin markers on the ruler. The left margin
marker is the tiungle locuted on the far left of the ruler. This
marker tells MuluScribe where (o begin the text on the left
margin, :

The right margin marker is a triangle located on the fur right of
the ruler. This marker tells MultiScribe where 1o end text on the
right margin.

To chinge the left margin:

If You're Using a Mouse

= Drag the left margin marker to the 1 * mark on the
‘ ruler's Inch scale.

= Move the polinter from the ruler to your text.
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It You're Using the K_ayboard
= Move the cursor to the left margln marker.

= As you hold down the G or ¢ key, press the —»

or T key until the cursor's positioned on the 1 Inch
mark on the ruler's Inch scale .

The left margin marker moves to the right each time you press
the — key.

= Press the | key twice to move the cursor
back to your text.

The left margin narrows and your text is reformatted accordingly.

To change the right margin:

If You're Using a Mouse

= Drag the right margin marker to the 7 Inch marker on
the ruler's Inch scale,

= Move the polnter from your ruler back Into your text.

Il You're Using the Keyboard
= Move the cursor Into the ruler.

= Press the — key untll the cursor moves to
the right margin marker.

The cursor moves over each of the tab stops on the ruler as you

press the = key. The right margin marker flashes when the
cursor is on it,
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Setting Tabs

PauLg— untll the right margin marker Is set at
the 7 * mark on the Inch scale.

The right margin marker moves to the left each time you

press the  key. To move the selecied seting -- in this case the
right margin marker -- (o the left in greater increments, press the
4 key while holding down the (3 or & key.

= Press the | key twice to move the cursor
back into your text,

The right margin is moved 1o the left, nammowing your text,

MultiScribe provides you with ten tab stops per ruler, These b
stops are the diamond-shaped markers located at even intervals
along the ruler, Each time you press the Tab key, the cursor
Jumps to the next 1ab stop.

Place the Insertion polint at the beglnning of
each ltem on your Iist and press the Tab key at
the beginning of each Item.

8 Mo Fon taareh Jorml font (i i
e £ et iy sy v,
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Jsriary i

=

Each item on the list is repositioned at the first 1ab stop.
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= Repeat this p;ocedure unlll each of the Iltems Is
repositioned at the second tab stop. '

Now let's move the second tab stop to another location,

If You're Using a Mouse

= Drag the second tab stop to the 2 1/2" mark
on the ruler's Inch scale.

The tab stop moves 1o the right with the pointer.

= Move the polnter back Into your text.

If You're Using the Keyboard

= Movae the cursor 1o the ruler and press the —»

key until the cursor Is positioned on the
second lab stop.

The 1ab stop flashes when the cursor is placed on it.

= As you hold down the G or & key, press the

- key or T key until the tab stop Is moved to
the 2 1/2" Inch mark.

The tab stop moves to the right each time you press the —
or T key,

= Press the | key twice to move the cursor
back to your text.

The list of currencies moves 1o the right with the new
positioning of the tab stop.
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This feature determines the alignment of {our text. There are four
justification options on the ruler: left, right, full, and center.

=\

NOTE: Because right and full justification and centering take
too long to display, you'll be unable to see how these optipns
readjust your text on the screen, When you print your (/&
document, however, it will be formatted according to the —9&
. Speeilied justification seilings.

=\

1 |

21

Left Justify i .%3%

a
i

P i

<1

S

MuliiSeribe presets the ruler to left justification. All text is %o 4o
alipned Mush against the left margin, and the text is uneven on 0&
the nght margin, E _: ‘

Right Justity

L)

Al text is alipned flush apainst the right margin, and the text
is uneven on the left margin,

m

Full Justity

The text is spaced evenly across each line, aligning it at both -
margins. —
Center

The text is centered on each line between the margins.
Let's use the Center option to center your text on the page.

If You're Using a Mouse

= Click on tha Center optlon setting.

A "e" appears inside the Center option setting, indicating
that it's the new text justification setting.

"o mom M m

Rl L= =1 jon] ] fme ] fun) Jow) | o) junl 1)
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= Move the polnter back Into your text.

If You're Using the Keyboard -
= Move the cursor Into the ruler and press the | key.

= Press the — key until the Center option
setting flashes.

The cursor is placed on the center justification option setting
when it flashes.

O

= Press the space bar key.

A "e" appears inside the Center option setting, indicating
that it's the new text justification setling. t

= Press the ! key to move the cursor back Into
your text.

When you choose Center, your text will be centered on the page {
when you print. Remember, you won't see centering -— or '
right and full justification - - on the sereen.

Scrolling is a feature that lets you move your text up and down

on the screen so you can bring any part of your document into

view. Il you're using a mouse, scrolling is done with the

use of the scroll bar, IT you're using keyboard controls,

;‘crolling is done with the (3> and G< keys, and the (31-C19
eys.

Let's take a look at scrolling text,

Place the Insertlon polnt at the end of your text
after the word “quarters.”
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= Press Return and type In the followlng words, pressing
Relurn after each ona.

G,
LU@&I& 5
fiveg,, .~ 4pp, .
frapg X 4.'\ 708 411‘&/’4 4
twenllesdo 5~ 8q;0 4000
hundreds * 4Ug ! i

" Sp

Notice whit happens to your document as you type in the new
additions (v your currency list. Part of your text moves off the
screen -- 11's serolled up, out of the document window. As you
type, MuluScribe automatically scrolls your document up, to make
room for new ext. When you scroll up, you move down in the
document. When you seroll down, you move up in the document.

To move your text buck into view, you'll use the scroll bar if you're
using a mouse, or the 3> and (< keys and G1-G9 keys if you're
using key bourd controls,

As you type, leat ds
wrolled up, out of the
document window, and you
move forward in your
document. You scroll up
by moving the thumb in
the scroll bar down, either
with the mouse or with
control keys,

When you seroll down by
moving the thumb in the
semll bar up or with the
keyboard controls, you
move backward through
your text, lowand the
beginning of the document.
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» To Scroll Down
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get back to the beginning of the document, you'll scroll down,

moving back up in your document.

If You're Using a Mouse

= Place the polnter on the up arrow located at the top
of the scroll bar and press the mouse button.

Notice how the thumb moves up in the scroll bar as you
press on the scroll bar up arrow, ;

=s Drag the scroll bar thumb up, to the top of the scroll
bar.

If You're Using the Keyboard
= Simultaneously press the G and < keys.

= Slmultaneously press the G and 1 keys.

Notice how the thumb moves up 1o the top of the scroll bar.

The @ and < keys seroll down one screen at a time.

The G and | keys wke you to the very beginning of a
document, no matter how long the document is. When you
press the @ key in conjunction with a number key from 1
to 9, the screen scrolls 1o the position in the document
represented by the number you press, and the thumb is
repositioned in the scroll bar accordingly. For example, if
you pressed G35, the screen would scroll to the middle of
the document; if you pressed €13, you would seroll 1o the
fiest third of the docunent, cie.

 The beginning of your text and the ruler appear on the screen, and
the bottomn part of the document scrolls downward off the screen.

SCROLL BARS
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To Scroll Up

T

To get to the end of a document, you'll scroll up, moving forward,

CLUBE o8 RFHLE RRiTaCos

L

CAIXA POSIAL 54131
1296 - JAY Q0 ¢/s/ng a Mouse

= Place the polnter on the down arrow localed at the

Notice how the thumb moves down in the scroll bar as you
press on the scroll biar down arrow.

OR
= Drag the scroll bar thumb down, toward the bottom
of the scroll bar.

If You're Using the Keyboard

= Simultaneously press the G and > keys.
OR
= Simultaneously press the G and 9 keys.

Notice how the thumb moves down the scroll bar. The @
and > keys scroll upone screen at & time.

“The (3 and 9 keys take you to the very end of a document,
no matter how long the document is,

The end of your document, the currency list, appears on the screen,
and the top part of the document scrolls upward off the screen.

Before we leave scrolling, let's go back to the top of the document.

= Simultaneously press the G and 1 keys or drag the
thumb to the top of the scroll bar.
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bottom of the scroll bar and press the mouse button.
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Saving Your Text
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As you create a document, you'll want to save it on disk frequently.
It's very annoying to spend time preparing a lengthy document,
only to lose it because of a power failure or interruption,

To save your text, you'll use the Save command,

= Choose Save from the Flle Menu.

A dialog box appears.

Save fs 68K free on vol.

[ PATH: AASLTISCRILEY |
[Knig: Il * Press ol
Press QRETU24) [Drive 2 ) Press 62
lEanceI |Press (ESC) | Palh | Press 6P

O MulliScribe file  OASCIL Text 0014 MulliSeribe file

The insertion point appeurs in the NAME input bar.

= Typo In a namo for the document. It can be any name
you want, provided It conlorms to the ProDOS
conventlons for lilenames.

l\"our dtx:qm;:nt name appears in the NAME input bar,
“or more information on PruDOS filename conventi
Appendix D, "ProDOS Pathnames and Filenames. -

= Click on the drlve 1 button or press (1.

The pathname of your disk in drive |, /MULTISCRIBE/
appears in the PATI input bar. l

= Click on the Save bulton or press Return.
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61 SELECTING TCEXT
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\g} b‘{b\ & F o a Your first sentence is selected.
Qv 9 TR o
N\ wYaupdocument is saved on your MultiScribe disk with the l
" Q(ff RO RAE Yon gavei — - = Place the |-beam anywhere In your document and
‘ o .
%% Q‘\.}*} A If you click on the Cancel button or press the Esc key, the Save - click the mouse button. -
Q\,\) Q#‘ i command will be canceled. Your document will remain on the H
< v sereen and in the computer's memory, but it will not be saved to = ] The line of text is no longer selected. To deselect text, you
disk. - just click the mouse button anywhere in your document
l and, since you're defining a new location for the insertion
; s q point, any selected text will be deselected.
Editing Text : While you're typing a document, you may decide to change a few I It You're Using the Keyboard
% sentences, delete some words, or rewrile an entire paragraph. ;‘ Py q . . a
MuliiScribe's editing features allow you 1o mike major changes To select text using the keyboard, simultancoulsy press the
within your document. H key and the T, L, , or = key. The text that the cursor moves
wea N A b o
There are seven lext editing features: insening over selected text, ; = ovmc;Swlll be selected according to the arrow key that you
deleting selected text, changing style of lcxtf. cut, cop | p&s)t:;dand I ik
eplaci tlected text with material pasted from the Clipboard. —
ey b e 2 m om j = Move the Insertion point to the beginning of your text
and simultaneously press the O and — keys. Move
Selecting Text You may have noticed that the word “selected” is used frequently — 2 the Insertlon polint to the end of the first sentence.
when discussing text editing. A basic rule to follow is: Before you e ) L
can edir text, you must first select ir. Selecting 1ext means choosing H i s : =
some text -- characters, words, sentences, even paragraphs -- to o e The first sentence is highlighied, 10 show that it's selected.
receive the action of a comumnand. This section expliins how to m om o
select text == one of the most powerful and important word S E = Press the « key.
processing techniques used in MultiSeribe. - The first sentence is no longer sclected. To deselect
' ) m selected text, just press any armow key. Because you're ;
I You're Using a Mouse defining a new locution for the insertion point, any selecied
: ] ! text will be deselected,
.You sclect text using the mouse by holding down the mouse E a8
button und dragging the I-beam across the text you wish to ] You can select as much text as you want; you can even use the
select, The text becomes highlighted as the I-bcam moves I Select All comimand (QZ) 1o select the entire current document!
across i,
m
E :3 In addition 1o text, you cin also select non-text material, such as
= To select a line of text, place the |-beam at the ﬂ rulers and pape breaks. This is covered in detail in Chapter 3,
beglnning of the text you want to select. E m i "Using MultiScribe,"
[ |
= Drag the l-beam to the end of the first sentence and I ¥ E;‘:‘ g‘::v’:g”u::m;%‘:;‘:fcﬁ‘t:;‘f desclect text, you're ready to
release the mouse button. i -1 :
M
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Deleling
Selected Text

Inserting Over
Selected Text

gy
e
The Delcte key allows you to quickly and easily remove selected E i s Holding down the mouse button, drag the kbeam to
words, sentences, and paragraphs from a document. Tos?é ﬂ il ng :J\;ﬂ al = ol
Rﬂc;m dclcur}g selected tct}:l works, let's delete the first sentence F ra igenEatin fience.
your first paragraph. 2k
" ﬂ If You're Using the Keyboard
= Select the first seatence In your first paragraph. o r’ 8
; e R = Move the Insertlon polint to the beglnning of the first
= Press the Delete key, og\ ﬂ b sentence.
The selected sentence is del %O J: =
e tence is deleted, permanently removed from 27,0 = Select the sentence by pressing the G and —»
ext. You can delete any amount of text you want -- even® . ¢ oL
an entire document, if you wish, You can also delete non-text '2& W,y keys.
.’11"“.‘_“"““ Ilr! your document, such as rulers and page breaks. % [7] 'l% 2
Mulsurééir;s.tiuiwd in more detail in Chapter 3, “Using Shs The sentence is highlighted, indicating that it is selected.
; . 7§ -
Chiy -
‘e ‘%H,; = = Press the Delete key.
\ '
Yo
'ﬂ;}is feature allows you to replace selected text, which is useful E\ = ?:-F ,= Type the following sentence.
when you want to replace a word (or sentence) with another )
word (or sentence). E - A penny saved Is a penny eamed
[~ ) j
Let's stan by inserting over a word. You'll i >
the word you wish 1o insert over. RS mabyeloing U The old first sentence is replaced by the new sentence.
1 omm
= Select the “ » B " i i
word “twentles" In your text. D Customizing Text MultiScribe allows you to perform several operations to stylize
— selected text. You can change the font, the size of the letters, and
= Press the Delete key. E =i the style of the letters. These options are found, appropriately
D enough, in the Font, Size, and Style Menus, which are located at the
; 1op of the screen.
= Type the word "fiftles.” o= = : '
sxd
The word "twenties" is replaced by the “fiftics." D
B T SRk B == = Changing the Font = Select the fIrst sentence.
Now let's replace an entire sentence. D
If You're Using a Mouse E = : = ::dhoose the Shakespeare font from the Font
enu.
= Placo the I-beam at the beginning of the first [] peare
senlence. o The selected text changes to Shakes font.
R e
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1z =
E =3 fus
= Cllck the mouse button or press an arrow key to U gg}df;:,:m )?;ou;! ;:n:; g:ma%cd 1;1; usrcyaﬁ :lr S; Zi'l’ﬁ{;fih'i’i' r;?c
g8 e ton F o :1 while you're typing. Just choose the style that you want, and
—— U as you type the text will change to the new style. As with fonis
NOTE: You can change the font of a sentence thar is already E = 3 ﬂ”‘f‘flh]“??"}_'f 5'3‘?5-_15':‘?“ can type a paragraph or sentence using |
on your screen (like you just did), and you can also change the S SEXERVCIHL RSy ey, =
font whale you're typing. Just choose the name of the font that U
bu wint, and the font will change as you type. You can type a
|yx?1ru.xgmph :lar Scn:’anCC using scvfml di)ir:fcl:cr)l([pfonls. i E e q The Cut command allows you to quickly delete words, sentences,
e e Cut or parugraphs fiom your text. The Cut command is very similar to
the Deleting Selected Text feature, with one major difference; when
: E K0n q you press the Delete key to remove text, the text is gone forever;
Changing the Size = Select the first sentence agaln. when you use the Cut option 10 remove text, you can get it back by
of Your Text using another Edit Menu commund called Paste. We'll sce how the
gy . h 3 . e
= Chooso 2.0 from the Size Menu, F — Cutand Paste communds work together,
' U First, let's see how the Cut option works by cutting a sentence from
The sclected text doubles in size. = E your paragraph,
= Click the mouse button or press an arrow key to D = Select the first sentence In the first paragraph again.
desslect the text. ; . E :
A 2 — U = Choosa the Cut command from the Edit Menu or
; : e — simultaneously press the (3 and X keys.
NOTE: You can change the size of a scntcncq(ﬁ?ﬂq alrcady o mm uf yP HKlkey
o ‘ya:ur ’wmﬂn' md rou il }aJso CHangE the S”‘ﬁ?’w oure [] The first sentence is delcied from your paragraph. All that work
:)'I}tln\ﬁilllj:ll;\lutblﬁzcyl()ﬁ: tSI]z):“‘?t)z%L:mwta;[' aan“ fﬁ%}. r).lgur = = with fonts, sizes, and styles -- down the drain? N;)t quite
X hnge | . ' By b e H .
sentence using several dﬁl‘crcm sizes, S Y ’go& “% ¢ B = ﬂ When you cut selected wext, the text is put on your disk in a
Wt o Wy /g, (73 D Ialacc culled the Clipboard. The Clipboard hurds the text that
e, O < = 1as been mast recently cut or copied.  You can restore lext
‘ Lo 3y ot W from the Clipbourd -- with Paste.
Changing Style = Select the first sentence agaln. S CE] ]
; E — :! Paste The l:luslc conmur:;l lets you place the contthcnts of the Clipboard into
your document at the insertion point. In other words, you can move
= Choose ltallcs from the Style Menu. D text around in a document by cutling the text, inoving the insertion
E . paint. and pasting the text from the Clipbourd back into your
The selected text becomes italicized. D b : documeent at the new location.
= Cllick the mouse button or press an arrow key to E _— = Move the Insertion polnt to the end of the first paragraph.
deselect the texl B
R
& g

Y
L1

e S e S




Copy

= Choose Paste from the Edit Menu or simultaneously
press the G and V keys.

The sentence is pasted onto the end of your paragraph,

——

NOTE: You can paste the same line of text as many times
a5 you want until you cut or copy another line of text.
- e % O\S‘
T
5 Q
0
The Copy command allows You 1o copy words, sentences, or 40(
paragraphs and place the text in another location while leaving the <

onginal text in place. Like the Cut command, the Copy command
stores the selected text on the Clipboard and i used in conjunction
with the Paste command.

Let's copy a sentence in your text and paste it to another location.

= Select a line of text.

= Choose Copy from the Edit Menu or simultaneously
press the G and C keys.

MultiScribe copies the selected text onto the Clipboard, while
leaving the wext unaliered in your document. Now when you use
the Paste command, the text will be copied into your document
at the insenion point, just like when you pasted the cut sentence
into the document. When you copy or cut another line of text,

the new text will tuke the place of the text that is currently on the
Clipboand,

= Move the Insertlon polnt to the beglnning of your

documant.

= Choose Paste from the Edit Menu or press GV.

The copied line is pasted at the beginning of your text.
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This Paste command allows you to paste text that you have cut or
copicd over selected text

= Selact any sentence In your document.

= Choose the Paste command from the Edit Menu. .

The text you had copied to the Clipboard replaces the text you
just selected. You can use this replace feature to replace entire
sentences and paragraphs with whatever you cut or copy to the

Clipboard.
Find is a MultiScribe command that allows you to find a
specific phrase, word, or group of words within a document.

To see how this command works, let's find a specific word.

= Place the Insertion polnt al the beginning of
your text.

NOTE: MuliiScribe searches from the insertion point to the
end of a document, so for MultiScribe to find eac occumence

of the specified text, the cursor must be placed at the beginning
of your document.

=» Choose Find from the Search Menu.

This dialog box appears.

finde | i
Olhole Word o hirtinl Word
Olise O lynoce Case

Prass QEIUED Press (E56)
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7

= Type the word "pennles” In the FIND Input bar and press

The Find dialog box contains four options, tha Return key or click on the FIND button. y

LA ) S\ §

{6 o o] fon] | fn | [ e [ o] [ g 1

¢ Whole Word -- This option tells MultiScribe 10 search for
the specified text as a distinct word, A distinct word in
MultiScribe is any alphabetic text surrounded by spaces,
nuinbers, punctuation characiers, or other special
characters, Selecting this option cancels the Partial Word
oplion,

A U

The first occurrence of the word "pcnni'c.s“ from the insertion
point to the end of the document is highlighted.

-l

This dialog box appears.

*  Case -- This option tells MultiScribe 1o acknowledge the
dilference between uppercase leters and lowercase letters in

thaeBt you specily. Selecting this option cancels the
e d

|

ase option,

l

Press (RETURK) Press (ESC)
o ‘
WO
0‘5 0 )c;\P* W

\‘\3%?’ g,tx\"‘h 6"‘0 P *  Partial Word -- MuliScribe finds the next occurrence of
G 2 the specified text in the document, regardless of whether or

A\%}%/\IMP_LE: If you search for the word Mother,
o MultiScribe would not find the word mother. Press the Return key or click on the FIND button.

&l
]

The next occurrence of the word "pennies” is highlighted in

) . . .
oV not the specified text is a distinct word, You can specify a k2 your text. This feature of the Find command is helpful when
few letters, and MultiScribe will find every word that i you have several occurrences of specific text to locate, or you
contains the leuers in the order you have specified, or you want to find the wurd"u!'n amc_ullz:u part of your document.
Spec s This feature acts as a "Find Again” option.
can specify several words -- up 10 43 characters - and b

MuluSeribe will find every group of those words in the
document, Selecting (his option cancels the Whole Word

= Press the Esc key or click on the Cancel button.
opuon,

L&)

The Find command is canceled and the last occurrence of the

EXAMPLE: If you search for the word me, MultiScribe specified word that was found remains highlighted.

would also find the words men, women, mean, and game,

[y

L&)

Editing a Now let's use the different editing features that ou've learned
:j Busi Letter to create and edit a business letter. Before you begin your
usiness Lette business letter, however, you'll want to cledr your screen of all
your old text. To do this you'll use the New command to create
5 a new, empty document.

* Ignore Case--This tclls MuliScribe to search for text
regardless of case, treating lowercase and uppercase letters
8s ¢quivalent characters, Selecting this option cancels the
Case option,

EXAMPLE: If you search for the word Mother,

MultiScribe would also find the word mother. = Choose New frbm the File Menu, or simultane ously

mmomomomomomomomoT T oTm oM

RN I

- press the <3 and N keys.
: A dialog box appears, asking if you want to save your changes.
: Click on the No button or press the N key.
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'l !

= Press the Tab key three times,
| gy
The cursor is now tabbed over to the third tab position, Lo
= Type In tha following Imaginary letterhead. Press the F A q
Return key at the end of each lIne and the Tab key
three limes at the beginning of each line to line up the
lines of the letterhead. Eoa o
=
James N. Fussell p—
6001 Glenheath B oe o
Houston, Texas 77081
November 15, 1986 - - =
P L |
= Press the Return key twlce. I
= s -
= Type the following. Press Return at the end of each — -
line. l
Ms. Penny Smith B
7654 Bowie Dr, E
Dallas, TX 75074 (e =
- ST =
= Press Return once. E
E = m =
= Choose Insert Ruler from the Format Menu or press i
simultaneously press the O and Y keys. & ﬂ ‘ =
m o
A secord ruler is inserted into your text. ﬂ x
= Choose the double line spacing optlon. = E -
= Type the following beneath your newly-Inserte . E e
é‘ .-
I'look forward to seeing you at the board meeting in Dallas, | %005' H
will bring the project pruspectis and estimated timelines, | ®up g -l

also bring the job descriptions that we are most anxious to fill. ™~ o AO&, S -

by W/4 n
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My plane amives in Dallas on March 29 at 6:00 p.m. I expect
to arrive at the Turtle Creek Inn about 6:30. You can reach me
at my hotel room if the need arises,

Sincerely yours,

James N. Fussell
Scroll to the beginning of the first paragraph.
We forgot to include a salutation.

Place the Insertion polnt before the first paragraph, type
the following text, and press Return.

Dear Penny,

Now, after the letter is written, we realize that maybe pruspectis
is misspelled. First let's search for it.

Place the Insertlon point at the beginning of your text.
Choose Find from the Search Manu.
Delete tho word "pennles,” type the word

“pruspectis” In the FIND Input bar, and press the Return
key or click on the Find button.

The word pruspecris is highlighted in your text,

Now, taking a good ook at this word and, chccking a
dictionary, we realize that it is indeed misspelled. So let's type
it again,

EDITING A BUSINESS LETTER
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Since you have not printed before, the Printer Sewp dialog box
appears, to allow you to specify which printer and interface card
you're using. When you tell ultiScribe which printer and
interface card you're using, this information is stored on disk,

so that you don't have to provide these hardware specifications
every time you choose the Print command.

= Presa Esc or click on the Cancel button to cancel the
Find command.

= Press the Delete key to erase the word pruspectls.

19 S S G ¢

= Type the word “prospectus.” Once you've provided these specifications 1o MultiScribe, the

Printer Setup dialog box no longer uppeirs when you choose
Print. To change your hardware configuration afier you've
provided MultiScribe with this Printer Setup information, you'll
choose the Printer Sewp command from the O Menu.

The correct spelling of the word replaces the misspelled word,

il

Now let's indent the first line of both paragraphs.

i

] |on] |50 [on] o] [om] |}

k] L

= Uslng elther the cursor or the polnter, move tha
indentation marker to the 1 1/2 * mark on the ruler Inch
scale.

= ‘Using the polnter or the arrow keys, scroll the
list In the Printer scroll window.

mmm M M M

NOTE: The word Printer on the left scroll window is
highlighted, indicating that that scroll window is active. Use

the T and L keys to scroll tie different printers until you find
your printer.

= Bring the cursor or -beam down Into your text.

The first line of each paragraph indents, and both paragraphs
adjust accordingly.

L&l

= Find your printer on the list and highlight It,

You're ready to printl aither with the pointer or with the arrow keys.

1 your Apple is connected to a printer, do the following.
= Uslng the polinter or the arrow keys, scroll the

= Choose Print from the File Menu or press GP. Interface Card scroll window.

m m om omom

Tan] o | | 5] Joms] fson] lum] jas] {aws] jom) | wm)

I W W

This dialog box uppeirs C‘}é R .
Ny e u ars.
o - : c%\ NOTE: Press the = key to highlight the words Interface.
Tialer
5 mmm' (':r - i 2, Card on the scroll window 1o the right. Then use the T and 1
: 1Y v v % b 2, E :j keys to highlight the different interface cards until you find
et b 10 i e Sy your interface card,
[pin Ko 11 Crapsler v -punabel o S s e S B
fhar Faracs Soappter 4 sserind or bl fered 'Vé o, 2
Cabtii ||| K 5% 5% o=
vl A Ceappler (hafere -7, ' N .
A | e T | (?o&”{,a % sosd = Uslng the polnter or the arrow keys, find your printer
prater et (12 108 6 1 bress Gkl pusker) L% Interface card on the llst a I N
[(HT) tran atineo tress (L80) Yy _¢(,0 t d shangi gh”ght i
d\ ,
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= Click on the slot number In which your printer card |s This dialog box contains several printing options.

Installed, or simultaneously press the ¢} key and the
number key representing the slot number In which your
printer card Is Installed.

¢ Quality
*  NLQOI- Near Letter Quality print mode 1.
NLQ2-- Near Letter Quality print mode 2,
High — Highest quality non-NLQ print mode.
Standard -~ Print is normal dot matrix graphics print.,
Draf: -- Print is light and quickly printed.
Text -- One font, one size only; fustest print mode.
Preview-- Shows on the screen how your document
will look when printed.

—

NOTE: MuhiScribe allows you 1o have up to six printer
cards installed atone time. MultiScribe also allows you to
have your printer card in any of the seven slots located inside
your Apple. Slot numbers tor all expansion slots containing
printer cirds appear in normal print on the screen. The rest of
_the slot numbers are dinuned,

® s & o v @

& o ¥

-l
*

Copies - Allows you to print multiple copies of your

ORI TIESIEgIC

L D ) B 4 B 2 G, o R+ ¢

s — —— dOCUJTlCﬂL
66\ a—
= Click on the OK button or press Return. o 4 ¢ Paper Feed
‘(g Qf/ OJ\ ¢ Continuous -- Use this option when you're using
This stores your printer and interface card information on yéﬁﬁ' 4,0 Is F E ractor feed computer paper, . B
MuluScribe disk, so that the next time you print, you won't Sy %, % ¢ Cur Sheer -- Use this option when you're using single-
have 10 specify your printer and interface card again, O,-o ’q( <“,’,’ :gifér?cﬂw. i.e., letterhead or other special
4(?0*5,@4,% = > ry
A different dialog box now appears. This Print dialog box, ) ¢ Page Ranpe
shown below, will appear from now on whenever you choose - o Al - Prints every page of a document,

the Print command from the File Menu.

*  From-To -- Prints specified pages only. For example,
if you have a long document, you can specify that
only pages 3 to 5 be printed. Click on the option
setting in front of From and enter the page range
in the two input bars,

Print
Ivgewriter -_Super serial or Apple I1¢ port

Lalily: OKLOL OKLO2 0 High 6 Standard O Drafl O Text OPreview
Cu;i:rD Paper feed:  @Conlinuous  OCul Shael
Pige range: @ fll OFrnrDIND

Press (RETURK) Press (ESC)

I Wl

NOTE: In order to select these option settings, use the mouse

inter or the ammow kcd):s in conjunction with the Rerumn key.
n other words, select these options the same way you would
select any other MultiScribe options.

m m m m m >

lC]lEZIDIEZ]IEDIE:]IEDIDIEJIE
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= Select High quality print.
= Speclty 2 coples.

= Selecl Continuous or Cut-sheet paper feed,
depending on whether you're using sheet-
feed or tractor-feed with your printer.

= Select All for paper range.

= Click on the Print bulton or press Return to
print the letter.

The business letter is printed twice.

Congratlations! You've leamed how to use MultiScribe 10 perform
basic word processing tasks.

For more detailed, step-by-step instructions on performing each of
the MultiScribe tasks, see the next chapter, “Using MultiScribe."
For details about specific MultiScribe commands, see Chapter 4,
"MultiScribe Reference.”
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[ = Introduction - InChapters 1 and 2, you leamned the basic elements of MultiScribe:
79 Introduction how 1o start up the program, the MultiScribe environment, how (o
B0  Mouse and Keyboard Mouse: A Review F e :: enter, cdit, and format text. This chapter provides detailed =
80  Review of Keyboard Mouse D ;rr:;itrg::ﬁr}\; er:;s iﬂ::soi E;Jc tasks covered in the first two chapters,
81 Review of Mouse Techniques .
g2 Scroling o= -3 This chapter consists of four parts: the first part reviews the basic
84 Getting Around In the Document Window D mouse, keyboard, and scrolling techniques you'll need to get around
84 To Go to a Particular Place in Your Document in the document window. The second section, Editing Texr,
85  To Goto a Specific Page ia Your Document F T discusses how to enter, insert, delete, move, and copy text. The
86  Editing Text D third part, Formatting Texr, explains how 10 use rulers and
86 - Text commands such us Insen Pape Break, Ser Heuder, and Set Footer o
ntenng Tex F = ,] format text. In the last section, Working With Docinents, you'll
88 lnsegmg learn how (0 save documents as files on your disk, how 1o open
q0 Sel “@5 D documents by reading them from disk, how 1o delete document
92  Doleling 009 ;‘ e files, and how to use the print commands 1o produce printed copies
93 Moving CA,‘,mk APPA e i of your documents,
95 Copying™96 ' :03;4( Man, A v U
97 Replacing 0 Pay, S113, 08 o O
98 Finding Text - J
100 Finding and Replacing Text ‘
103 Changing the Style of Text =3
105 Changing the Size of Text J
106  Changing the Font S iy =
111 Formalling Text E 3
112  Using Rulers ; ) ]
114 Changing the Setlings on a Ruler Bi e )
117 Changing the Format as You Enter Text []
118 Changing (he Format of Existing Text =
119 Inserting Paga Broaks B = .o
120  Repagination []
121 Using Hoaders
128 Using Foolers fa = ud
135 Working With Documents D
136 Saving Documants =
143 Opening Documants L -:
148  Deleling Files
150  Printing Documents i.: = :
160  Qullting MultlScribe H
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Mouse and Keyboard Mbuse:
a Review

Review of Keyboard Mouse

Activating the Menu Bar

= Press the Esc key.

The List menu from which a command

wibs thasen s pulled down, indicating
that the menu bar 1s active,

Pulling Down a Specific Menu

= Press the « or - key to
choose a menu.
The « key pulls down the menu 1o
the immediate left of the currently
selected menu, while the = key pulls

down the menu 1o the immediate right
of the currently selected menu,

Choosing a Command

«~E

"

1. Pressthe Tor | keyto
sclect a command. -
A conminand is selected when it is,
highlighted.

2. Press the Roturn koy
perform the commina.
Ihe commind is exccuted.

1

15 s g——
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Revlew of Mouse Techniques

Clicking

1. Poslilon the polnter on the
place In text where you want
to set the Insertion polnt or on
the optlon you want to choose.

2. Press and quickly release
the mouse button.

Pressing

1. Positlon the polnter.

2. Press and hold down the
mouse button without
moving the mouse.

Draggling

1. Poslition the polnter.

2. Press and hold down the
mouse button while moving
the mouse.

3. Release the mouse button.
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Scrolling

When you scroll a
document, you move it up
and down in the decument
Alndow, This allows you
1o display any par of the
document. -

Think of the thumb as
tepresenting the document
window arad the length of
the seroll bur as
representing the entire
docunient. As you move
the thumb down orup,
you're in etrect "opening”
the document window on
that part of your document
tepresented by the scroll
huar.

The number in the thumb
represents the number of
the pave currently in the
document window, Il two
pages are displayed in the
documient window at the
same ume, the number in
the elevaton box is the
mumnbwr of the pape
vecupying the top line of
the ducument window,

O

Yo Scroll Text Down

= If you're using a
mousae, click on the
up scroll arrow on
the top of the scroll
bar.

= If you're using
keyboard contrals,
press the T key until the
Insertion point Is on the
top line. Pressthe T
key agaln and the
screen scrolls down,

Your text scrolls down.

The elevator moves up in
the scroll bar to indicate
your new position in the
document

To Scroll Text Up

= If you're using a
mouse, click on the
down scroll arrow
on the bottom of the
scroll bar.

= If you're using
keyboard controls,
press the | key untll
the Insertion point Is
on the bottom line.
Press the | key agaln
and the screen scrolls
up.

Your text scrolls up.

The elevator moves down
in the scroll bar (o indicate
your new place in the
document.
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To Scroll Down One
Window

= M you're using a
mouse, click Inslde the
scroll bar above the

‘thumb.

= If you're using
keyboard controls,
press Gx.

Your text scrolls down one
window.

The elevator moves up in
the scroll bar to indicate
your new position in the
document.

To Scroll Up One
Window

= Il you're using a
mousae, click Inslde the
scroll bar below the
thumb.

= If you're using
koyboard controls,
press Cs.

Your text scrolls up one
window.

The elevator moves down
in the scroll bar w indicate
your new position in the
document.

As you fype, teat is scrolled up,
out of the document window, and
you move forward in your
document. You scroll up by

—~ muving the thumb in the scroll

bat down, eiher with the nwuse
or wing the 0> control keys.

Whent you sixoll doven by
moving the thumb in the scroll
bar up or with the O< keyy, you
move backward through your
el wward Ue beguaung of e
document.

 —
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Getting Around in the
Document Window

MultiScribe offers you a
number of ways to move
about in the document
window: using the scroll bar,
using the (41-9 keys, and
using the Goio

Page # cominand.

NOTL: If you have text
selected when you use the
scroll bar or hey board
controls  move to a new
place in the document, the
Insertion point rening with
the selected text. I you press
ahey, the keypress takes *
ellect at the wsernon point:

» the sereen serolls back
10 the selected text;
o the texi s deselected;

¢+ the elfuets of the
keypress ke place
ingyediately following

lh%muerly sclected

To Go to a Particular
Place In Your Document

Using the Scroll Bar

= If you're using a
mouse, drag the thumb to
the place Inside the scroll
bar that approximates the
place In your document
whero you want {o move
the Insertlon point.

If you've moved (o a new
page, the new page number
15 displayed in the thumb.

Think of the thumb as
represenung the document
window. By dragging the
thumb inside the scroll bar,
you're in effect moving the
document window to the place
in the document represented
by the new relative position of
the thumb in the scroll bar,

Using the Keyboard
Controls

= If you're using
keyboard controls, press
the G key In comblnation

wlth any number key from
110 9.

The insertion point moves to
the position in the document
represented by the number
you press. The thumb is
repositioned in the scroll bar
accordingly.

If you press 31, the insertion
point moves to the beginning
of the document; press G5
and it moves to the middle;
(9 takes you to the end.

Think of the G-number key
combinations as "floors" at
which the thumb, like an
elevator, stops in the scroll
bar. As the thumb is
repositioned, so is the
document window,
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To Go to a Spaclfic
Page In Your Document

= Choose Goto Page
# from the Search Menu
or press GG.

A dialog box appears. The
dialog box contains an
input bar for entering the
nu:mber of the page to
which you want to move
the insention point, as well
as butions fur confimiing
(OK) or canceling (Cancel)
the operation.

The input bar contains the
number of the page
currently in the document
window.

= Enter In the Input
bar the number of the
page to which you want
to movao the [nsertion
polnt. If nccessary, use
tho Delete koy lo dclete
tho old page number
and type a now page
number.

= Click OK or press
Return.

The insertion point moves
10 the specified page
number.

If you enter a number
greater than the total
number of pages in the
document, the insertion
oint moves to the last page
in the document. 1f you
leave the current page
number vilue in the input
bur and click OK or press
Return, the insertion point
moves to the beginning of
the first line on the puge,
which becornes the first line
in the document window.
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Editing Text

Enterlng Text \')Q)%
(J\/

AU
5Th MoltiSeribe, text

«hsists of one or

®more characters, A
charucter is anything
typed into a
document with a
characier key.
Charuacter keys
include keys for
leters, numbers,
special characters,
and puncluation
marks, as well us the
Tub key, the space
bar, and the Retum
key.

You enter ext in the
document window
simply by typing. As
you press the
number, letter, and
special character keys
on the keyboard, the
characters
represented by those
keys are displayed in
the document
window.
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You enter text by
typing at the
insertion point,

the blinking vertical
bar which marks
where charucters
appedr as you type.
As text is entered, the
insertion point moves
in [ront of it.

When the inscrtion
point reaches the
right margin, the
word you're lyping
and the insertion
point move
automatically to the
bepinning of the next
line. This is called
word
wraparound.

Simultaneously
pressing a letter key
and the Shift key
causes the uppercase
letter assigned Lo that
key to appear in the
document window,
Pressing any other
character key and the
Shift key
simultaneously
causes the top
character on the kcﬁ
to be displayed in the
document window.

To Enter Text

= Enter text by
typing at the
Insertion polnt.

As you type, the
character associated
with each key you
press appeurs at the
inserion point and
the insertion point
moves forwird one
character space,

When you reach the
right margin, the
insenion point and
the word you're
typing wrap around
to the start of the next
line.
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To Delete Text

=> Press the
Delete key to
remove
characters.

When you press
Delete the character to
the left of the
insertion point is
removed and the
insertion point moves
one space backward.

When the number of
characters to the left
of the insertion point
equals the number of
spaces available for
charicters at the end
of the line above, the
remaining characters
on the line and the
insertion paint word
wrap up to the end of
the line above.

To Entera
Carriage Return

= Press the
Return key to
enter a carriage
return.

A carriage retum is
placed in your text at
the insenion point.
The insertion point
moves 1o the
beginning of the next
line,

You'll press Retumn
to start a new line, to
Start a new
paragraph, and 1o
skip lines, To skip a
line, press Return
twice.

To Enter Tab
Stops

= Press the
Tab key to move to
the next tab stop.

The insention point is
moved to the location
of the next wb stop
on the current line.
Tab stops are set on
the ruler preceding
the text you're
entering. (See
“Using Rulers" under
“Formatting Text.")
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Inserting

Insenting is an important
clemerntof any word
processing program. This
15 e pecially rue of
MuluScrbe, In
MuluScnbe, you insert not
only text but also puge
bicahs and rulers.

Betore you insert, you
pasition the insertion point
== represented by the
blinkang verucad b, or
cursor -t the plice in the
dovument whiere you want
o insert niatenal,

Il you're using a

5o, posltion the
I-beam pointer on the
place In your document
where you want to set
the Insertion polnt.
Click the mouse button.

The insertion point moves
10 the place in text where
you clicked.

= If you're using
keyboard controls,
use the «,T,., and —
keys to mova the
Insertion point to the
deslred plzce In text.

To Insert Text

= Set the Insertlon
polnt where you
want to enter text.

= Type the new
text.

Any text following the
insertion point moves to the
right and down, to make
space for the new text.
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To Insert a Carriage
Return

= Set the Insertion
point where you
want to place the
carriage return.

= Press Relurn.

To insert a blank line, press
Retumn once if the Insertion
Point is at the beginning or
end of a paragraph, twice if
it's in the middle of a

" paragraph.

To Insert a Page Break

= Get the Insertion
point at the place In
your document where
you want a new page.

= Choose Insert
Page Break from the
Format Ménu or
press G-,

The text following the
insertion point is moved to
the stun of a new page,
along with the inseruon
point. The screen scrolls
down to display the first
line of the new page on the
top line of the screen,

All pages following the
new page are renumbered
accordingly.
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To Insert a Ruler

= Sel the Insertlon
polnt.

= Choose Insert
Auler from the
Format Menu or
press QY.

A new ruler is placed in the
document at the inserion
point. The insenion point
and any text following it
move below the new ruler.

The new ruler is a copy of
the ruler preceding it. For
more information on rulers,
sce "Formating Text."
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Inserting d;,
(@

. . . V
Insening is an imponant<o %% I

clement of any word

To Set the Insertion

<l Point

! you're using a

processing progrum, This S ‘l%uso, Position the

15 expecially mue of
MuluSenbe, In
MuluiScribe, you insert not
only text but also page
breaks and rulers,

Hetore you insen, you
posiicon the insention point
- represented by the
blinking verticol Lur, or
Cursur == at the place in the
docunment where you want
0 nsert matenal.

-bcam pointer on the
place In your document
where you want lo set
the Insertion polnt,

The inseriion point moves
to the place in text where
you clicked,

= It you're using
keyboard controls,
use the «,T,l, and —
keys to move the
Inscrtion point to the
deslred plzce In toxt,

Click the mouse button.

To Insert Text

= Sel the Insertion
palnt where you
want to enter text,

= Type the new
text.

Any text following the
insertion point moves to the
right and down, to make
space for the new text.
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To Insert a Carriage
Return

= Set the Insertion
point where you
want to place ths
carrlage return.

= Press Relurn.

To insert a blank line, press
Retum once if the Insertion
Point is at the beginning or
end of a paragraph, twice if
it's in the middle of a

" paragraph.

To Insert a Page Break

=» Sat the Insertion
point at the place In
your document where
you wanl a new paga.

= Choose Insert
Page Break from the
Format Menu or
press G-,

The text following the
insertion point is moved to
the stant of a new page,
along with the inseruon
point. The screen scrolls
down to display the first
line of the new page on the
top line of the screen,

All pages following the
new page are renumbered
accordingly,

89 INSERTING TEXT

To Insent a Rular

S

= Set the Insertlon
point.

= Choose Insert
Ruler from the
Format Menu or
press QY.

A new ruler is placed in the
document at the insertion
point. The insertion point
and any text following it
move below the new ruler.

The new ruleris a copy of
the ruler preceding it. For
mare information on rulers,
see “Formatting Text."
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Selecting To Select Text

= Set the Insertlon
point at elther the
beginning or end of the
text you want o selecl.

= If you're using
keyboard controls,
hold down the O key
and press the arrow
key which
represents the
direction of the text
you want to select.

In MultiScribe, most text
cdning ti+ks require that
soethang == lext, a page
hre ik, a ruler -- be selected
hetore that tsk can be
pertonned. The selection
then taecomes the object of
the action uf the tasy  For
exnatnple, when something
is rofeated, e can be ety
cural eplacal, vr
delsed, selected teat can be
Changed woadiferent size,
sty i, ur font,

= If you're using a
mouse, drag In the
dlrection of the text
you want to selzct.

The ¢ and — keys select
direction you drag. If you one character at a ime; }hc
drag venically in cither Tand b keys selecta line
direction, text is sclected ata time.

one line atatime. [ you
drag honzontally in either
direction, text is selected
one character ata ime, If
you drag diagonally in
cither direction, text is

Text is selected in the

Whon semedun by
selowludd, I apyas.
higtdighted, whs

Micey Uittty difplayed in
insvrse Viddg fERmuhe rest
of the dovuifienz ©

If you select beyond the top
or bottom of the document

. window, the document
scrolls until you're finished
muking the selection.

e selected a line at a time with :
5 vertical movement and a To cancel a selection in
< v o character at a time with Progress, just press any
ol = —.,9— horizontil movement. arrow hey. A selection is
= canceled when no text is
O = ;?; If you drag beyond the top highlighted.
ks or botom of the document
2 = window, the document
8 continues 1o seroll until
wn you're finished making the

selection.

To cancel a selection in
progress, click anywhere in
text o reposition the
insertion poinl. A selection
is canceled when no textis
highlighted.
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To Select a Ruler

= Set the
Insertlon polnt
at the left
margin on the
line below the
ruler

OR

to the right of
all text on the
line above the
ruler.

" The first rulerin a

document cannot be
selecled. If rulers are
hidden , they'll
Appeir as a rinc of
inverse video when
selected.

= Il you're
using a mouse,
drag dlagonally
across the ruler
to the margin
on tha side of
the document
window
opposite the
placo whaore
you began the
seloctlon.

To select text and a
ruler or rulers, just
select any ruler in the
document along with
the text and continue
dragging untl the
destred ruler(s) and
text are selected.

= If you're
using keyboard
controls, press
3 — if the
Insertion polnt
Is to the right of
text above the
ruler

OR

press G « If the
Insertion polnt
Is at the left
margin below
the ruler.

To select textand a
ruler or rulers, hold
the G key down and

use the Tand L keys

1o select any rulers in
the document along
with the desired text.

To Select a Page
Break

= Set the
Insertlon polnt
at the left
margin on the
line below the
page break

OR

to the right of
all text on the
line above the
page break.

= If you're
using a8 mouse,
drag dlagonally
across the page
break to the
margin on the
side of the
document
window
opposite the
place where -
you began the
selection,
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To select textand a
gagc break or page
reaks, just select the

page break(s) along
with the text and
continue dragging
until the desired

page breakis) and
lext are sclected.

= It you'ra
using keyboard
controls, press
G — It the
Insertion point
Is to the right of
text above the
page break

OR

press G « If the
Insertlon polnt
Is al the left
margin below
the page break.

To select tentand a
page break or page
breaks, hold the &3
key down and use the
T and | keys to select
any page breaks in
the docunment along
with the desired teat.
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To Move Between MultiScribe Documents

1.

2,

Select the materlal — text, ruler(s), page break(s) -
to be moved.

Choose Cut from the Edit Menu or press OX.

The selection is deleted from the document and stored on the
Clipboard, where it will remain until the next cut or copy.

Save the current document, If you wish.

. Open the document to which you want to move the

Clipboard malerlal using either the New command
(_N) for a new document, or the Open command (3J)
to open an existing document, both of which are on
the File Menu.

. Set tho Insertion paint at the place In the new

document where you want to put the Clipboard
meterial.

. Choose Paste from the Edit Menu or press GV.

A copy of the contents of the Clipboard is placed in the
document following the insertion point,

If a ruler is moved into a new document, text bclwecn the rﬁ:’vly
inserted ruler and the next ruler in the document is reforma

accordingly. <%\
If a page break is moved to a new document, the pages in%g % :
new docunent are reformatted and renumbered according! 41-’ fy
. ‘Q‘ v
5%
o T
v, %
%%
° %,
%
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’ Copying
You can copy
anything in a

document that
you can select.

N U S §

Copying works much
like Cut, except that
the materiul copied to
the Clipbourd remains
unaffected by the

- operation,
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Copying Within a Documant
1. Select the material — text, ruler(s), page

break(s) = to be copled. -

2. Choose Copy from the EdIt Menu or press GC.

A copy of the sclection is stored on the Clipboard, where it will
remain until the next cut or copy.

The selection itself is unaffected.

3. Set the Insertlon point at the place In the document -

«where you want to put the copled materlal.
4. Choose Paste from the Edit Menu or press GV.

A copy of the contents of the Clipboard is placed in the
document following the insertion point.

If a ruler is copied to a new place in the document, the text
between the copied ruler and the next ruler is reformatted
accordingly.

If a page break is copied to a new place in the document, all the
pages in the document are reformatied and renumbered
accordingly.
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Copying Between MutiScribe Documents

1.
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Select the materlal -
- to be copled.

text, rulers, page breaks

. Choose Copy from the EdIt Menu or press GC.

A copy of the selection is stored on the Clipboard, where it will
remain until the next cut or copy.

The selection itself is unaffected.

. Save the current document, If you wish,

. Open the document to which you want to copy

the Clipboard malerial using elther the New
command (UN) for a new document or the Open
command (3J) for an exlsting document, both of
which may be found on the File Monu.

Sel the Insertlon polnt at the place In the new
document where you want to put the Clipboard
material.

. Choose Paste from the EdIt Menu or press GV.

A copy of the contents of the Clipboard is placed in the
document following the insertion point,

If a ruler is moved to a different document, text between the
new ruler and the next ruler in the document is rcan,nancd
accordingly. G»

If & page break is copied to a different document, the pﬁ}cs
in the new document are reformatied and nnumﬁ@;&j‘; O
accordingly. o
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Replacing

You can replace
anything in a
document that
you can select.

To Replace a To Replace a

Selection with Selection with

Text the Contents
ofthe

= Select the Clipboard

materlal - text,

ruler(s), page = Selact the

break(s) — materlal to be

be replaced. replaced.

= Press =Choose

Delete once. Paste from the

: Edit Menu or

= Enler new press GV,

text.
A copy of the
contents of the
Clipboard
replaces the
selection,
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To Replace a
Selection with
a Ruler

= Select the
materlal to be
replaced.

= Choose
Insert Ruler
from the
Format Menu
or press O,

A copy of the
nuler
immediatel
preceding Lﬁc
mscruon ﬂoml
replaces t
selecton,

To Replace a
Selection with
a Page Break

= Select
tha materlal
fo be
replaced.

= Choose
Insart Page
Break from
tha Format
Menu or
press G-,

A page break
replaces the
selection,
reformarting and
renumbering
subsequent
pages
accordingly.
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Finding Text

The Find command
lets you scarch for
some or all of the
occurences of a
word or phrase from
the inserbon paint
the end of the
dovument. As each
weeurrence of the
speciied text s
located, itis selected
SOt it can be
deleted, copied,
moved, or modified.

You can specify
whether you want 1o
search fora whole
word -- a word
distinet from the text
around it == or just
partof a word. You
can alsoell
MuluScnbg whether
or not ymﬁ\‘(‘ t the
scareh to be live
o differences in &),

0y, Qo

uppereiase apsl 4
%

low civiase.

&40

7

1. Set the
Insertion polnt
at the place In
your document
where you want
to start the
search.

The search will be
made from the
inserzion point to the
cnd of the document.

2. Choose Find
from the Search
menu.

A dialog box
appedrs,

The Find dialog box
contains an input bar
for the text you want
1o locate, setings for
Whole Word/Partial
Word and
Case/lgnore Case,
and buttons for Find
and Cancel.

J. Type In the
Input bar the
characters,
word, or words
you want to
locate In the
text.

The input bar
contains the last text
for which you
seurched, followed
by the inserion
point. If you have
not yet searched for
text, the input bar is
empty except for the
insertion point.
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4. Choose
whether you
want to search
on Whole or
Partial Word
and whether
you want the
search o be
case-sensitive
or to Ignore
case.

To select Whole
Word/Purtial Word
and Case/Ignore Case
settings:

« If you'ra using
a mouse, click
on the desired
sefting.

« If you're using
keyboard

controls, press

the ! and T keys to
move back and
forth from the Input
bar to the optlon
lines.

s o S——— e St = e oy e — st g

Use the « and —
keys or Tab and
(Tab to move
from setting to
selling on an
optlon line. When
a selting Is
selecled, It flashes.
Press the space
bar to choose the
selling.

If you choose Whole
Word, MuliiScribe
looks for the next
occurrence after the
inscriion point of the
specitied text as a
distinet word. In
MultiSeribe, a
distinct word is any
group of alphabetic
characters separated
from other alphabetic
lext by spuces,
numbers, punctuation
chiricters, or other
speciil chiaracters,

I you choose Partiul
Word, MuliiScribe
looks for the next
occurrence afier the
insertion point of the
specified charucters,
whether they
constitute a distinet
word or are part of a
larger word,

If you choose Case,
the search is case-
sensitive, which
means that
MultiSeribe is
looking for text that
matches the specified
charuacters exaculy

-- including whether
the specilied
chiaracters are
uppercase or
lowercase.

If you choose Ignore
Cise, MultiSenbe
loaks (or text that
matehes the specified
fext except with
regard 1o case.
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[}

5. Click on the
Find button or
press Return.

MuldScribe finds the
next instance of the
specified textin the
document alter the
insention point, and
highlights it. The
text is now sclected,
and you can edit it
At the sume time, a
diulog bux appears,
The diddog box
contdinsg o bultons
== one for I'ind wnd
one fur Cuncel,

If you chouse Cancel
by clicking on the
Cancel button or
pressing Esc, the
operation iy canceled
and the Last match
remains selected.

If you choose Find
by clicking on the
Find button or
pressing Keturn,

“ MuliiSenlbe looks for

the next occurrence
of the specified text
in the document. If it
finds another match,
it highlights the new
mualteh, 1( it Joesnt,
a dinlog box appears
1o tell you that no
match was found.
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Finding and
Replacing Text

The Replace
command lets you
find some or all of
the occumences of a
specitied proup of
Chracters from the
uecttion point to the
end of the dovument,
Lo h e you tind an
oceurrence of the
s Hed 1ext, you're
pivan the opportimty
ol replacing it,
contimung the scarch
for thie neat
ovcurrence of the
speaitied text, or
stoppung the
operation,

As with the Find
commuand, you can
specify whether you
want 1o search fora
whuole word or just
part of aword, and
whicther o not you
wattil the sedarch (o be
Cawemiive,

sertion polnt
at the place In
toxt whare you
wanl to start the
search.

The seiarch will be
niwle from the
inscition point 10 the
end of the document.

If no instances of the
specificd textare
tound, a dialog box
appears o tell you
tiat a match wasn't
found.

2. Choose
Replace from
the Search
Menu.

A dialog box
appears,

The Replace dialog
box contains input
bars for the text you
want to find and the
text with which you
want to repluce it, ns
well as settings for
Whole Word/Partial
Word and
Case/lgnore Case and
butions for Find and
Cancel.

3. Type In the
Find Input bar
the characters,
word, or words
you want to
replace.

The Find input bar
contiing the last text
you searched for with
either the Find or
Replace commands,
folrowcd by the
insertion point.
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4. Type the
replacement
text In the
Replace with
Input bar.

The Replace with
input bar contains the
last replucement text
you entered,
followed by the
inscrtion point.

To move from the
Find input bar to the
Replace with input
bar:

« If you're using
a mouse, click
on the Replace
with Input bar.

« It you're using
keyboard
conlrols, press

the | key.

5. Choose
whether you
want to search
on Whole or
Partial Word
and whether
you want the
search to be
case-sanslilive
or to Ignora
case.

To select Whole
Word/Punial Word
and Casc/Ignore Case
settings:

« If you're using

a mouse, click

on the desired
setting.

o« If you're using
keyboard
controls, press
the | and T koys to
move back and
forth between the
Input bar and
option lines.
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Use the ¢ and —
keys or Tab and
OTab to move from
seiting to setting on
an option line. When
a setting is selecied, it
flashes. Press Retum
to chovse the setting.

If you choose Whole
Word, MuluScribe
looks for the next
occurrence after the
insenion point of the
specified 1ext as a
distinct word. In
MuluScribe, a
distinct word is any
group of alphabetic
characters separated
from other alphabetic
text by spaces,
numbers, punctuation
charuciers, or other
special characters.

If you choose Partial
Word, MultiScribe
looks for the next
occurrence afier the
insertion point of the
specilied charucters,
whether they
constitute a distinct
word or ire part of &
larger word.

If you choose Case,
the search is case-
sensitive, which
means that
MultiScribe is
looking for text that
matches the specified
characters exactly

- including whether
the specified
charucters are
uppercise or
lowercase,

If you choose Ignore
Case, MulliScnbe
looks for text that
matches the specified
1ext except with
regard to case.




6. Click on the
Find butlon or
press CF.

MultiScribe finds the
neal instunce of the
specilied text in the
docunient and
highlights it

The text is now
selected and you can
editit us you would
any sclected text,

At the same time, a
dialog box appears.
The dialog box
contuns live buttons
- ind Nexr,
Replace; Replace,
Find Next; Replace
All, and Cancel.

If y ou choose Cancel
by clicking on the
Cancel button or
pressing Lise, the
operation is canceled
and the Last miatch
remains selected.

If you choose Find
by clicking on the
Find button or
ressing Return,
fultiSeribe looks for
the next occurrence
of the specitied ext
in the document
without making a
replacenient. I it
finds another match,
ithighlights the new
match. Ificdoesn't,
a diilog box appears
to tell you that no
other match was O
found. ((

If you choose
Replace, Find Next
by clicking on the
Replace, Find Next
bution or pressing
OGN, the specified
text is changed to the
replacement text and
the next occurrence
of the specified text is
located und

on the Replace button
or pressing GR, the
slxciﬁml (Ext is
chianged to the
replacement lext.

If you choose o)
Replace by clicking Q;JJF‘% O@

highlighted.
L
£
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+
q
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If you choose
Replace All by
clicking on the
Replace All button or E'
pressing GA, all
occurrences of the
specified textin the E
document are

chanped 1o the
replacement text, F

If you choose Cancel e
by clicking on the e
Cance! buton or

pressing Esc, the F’
operation is canceled. ©°
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Changlng the Style of
Text

The Style Menu provides
several styles with which you
can change the appearance of
your text.

Once you set the insertion
point or once you've selected
the text you want to chnnﬁc,
you can change the style by
choosing one of the styles
from the Style Menu, Styles
can be combined, as well.
With the exceptions of
subscripy/superscript and
uppercase/lowercase, which
are mutually exclusive, any
two or more styles can be
combined for a variety of
stylistic effects.

Unless you change the style
before typing, ext entered or
inserted at the insertion point
is in the style of the character
immediately preceding the
insertion point,

For more information about
styles, see "Style Menu" in
"MultiScribe Reference."”

1. Select the text you
want to change or sat
the Insertion polnt
where you want to
enter or Insert text of
a partlcular style.

2. Choose a style

from the Style Menu

or press the keyboard __
equlvalent for that

style.

The uppercase and lowercase
styles have no keybourd
equivalents and must be
chosen from the Style Menu.
Also, unlike the other styles,
uppercase and luwercase
cannot be chosen unless a
sclection has been made. To
enter uppercase and lowercase
text at the insention point, use
the Shift and Caps Lock keys,

The selected text changes to
the new style and remains
h\iﬁhlightcd. A check mark

(V) appears on the Style Menu
1o the ﬁcl'x side of the style
you've chosen,
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To Combine Styles

= Select the text
you want to changs.

= Choose a style
from the Style Menu
or press the
keyLodard caulvalent
Tor that styla,

The textchanges and
fenans highhiphted,

=> Choose the
szcond style from
the Stylo Licnu or
press the 3
keybourd equivalent
for that style.

The text chanpes 1o a
cambimation of the two
styles and remiing

I bl haed,

You can continue 1o
combine styles in this
fashion,

The subscript and
supenseript styles cannot be
combined as they are
mutually exclusive, The
sdie is also rue of
upirrcase and lowercase.

To Desslect a Style

= Select the fext

you want to change,

or set the Insertion
polnt where you want to
enter or Insert text In a
new slyla.

= Choose the

checked style on the
menu.

The cheek mark is removed
from the Style Menu, and
the style is removed from
the selected text,

If styles have been
combined - if the Style
Menu contains more than
one checked siyle -- the
styles cannot be deselected
individually, You must
deseicer all styles, retuming
the selection Lo Plain text,

The Tall and Wiq%stylcs

only work with te t%sizc
1.0or L.5. o
e, C 00
%0 %, Qp
b 7y
. %ﬂc
S
o %
Y,
(O

To Deselect All Stylas

= Select the text
you want to change,
or set the Insertion
point where you
want to enter or
Insert plain text.

= Choose Plaln
from the Style Menu
or press OT.

All check marks are
removed from the Style
Menu and all styles are
removed from the selected
text. The selection remains
highlighted.
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Changlng the Size
of Text

The Size Menu contains
font scaling options for
enlarging the size of a -
charucier from 1 to 3 times
its base font size. You can
also change the vertical or
horizonial scaling with the
Tall and Wide styles on the
Style Menu, thereby
doubling only the height or
widih of a character,

For more information about
sizes, see "Size Menu” in
"MuluScribe Reference.”

1. Select the text
you want to re-size,
or sot the Insertion
point where you
want to enter text In
a new size.

2. Choose a size
from the Slze Menu.

A check mark (V) ap

in the Size Menu 1o the left
of the size you've chosen.
Selected text changes and
remuins highlighted.
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Changlng the Font

The Font Menu displays the
names of the fonts on your
MuluScribe disk and allows
you 10 choose fonts.

1. Select the text
you want to change
to a new font, or set
the Inscrtion polnt
whers you want to
enter toxt In a new

Text entered at the insertion font.
pointis in the font of the
teat preceding it unless you
chunge fonts before typing.
For more ifomtion on
fonis, see "Funt .\1cnur')‘p
Chupter 4, "MuliSen (O
Reference.” &<°
b
o, &, NO
% TS
N
ilo
'Vj Le ((4
AT S
‘Fo & "-;7
s Y
o v
N 00
I?“ d\

2. Choosa a font
from the Font Menu.

A check mark (V) appears
on the Font Menu to the left
of the font you've chosen.
Selected text changes and
remains highlighted.
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Selecting New Fonts

The Select New Fonts
command expands the
selection of fonts available
for creating a document by
letting you choose an
alternative selection of 1 to
16 fonts from another path.

1. Choosa Select New
Fonts from the Flle
Menu

When you choose Sclect
New Fonts, a dialog box
appears. The Select New
Fonts dialog box contains
an input bar for Path, a
scroll window, buttons foc
ath selection (Drive 1,
nive 2, Path, List Yol.)
and a button for Sclecting
and Desclecting fons.

If no path has been
specilied yet, a message
instructing you 10 select one
will appear in the scroll
window.

If you select a path which
contains no fonts, a
message appears in the
scroll window, telling you
that no fonts have been
found on the specified path,
and asking you to ry a
different disk or path,
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Click on OK or press

Retumn o return to the

g;lcct New Fonts dialog
X,

You can't create a new set
of 110 16 fonts
combining selections of
fonts from different paths.
Selecting fonts from a path
automatically deselects all
the fonts chosen in the
previous path.

e R




. )
2. Select the fonts, cne U

at a time, which you
wish to Include In your
new set of selecled
fonts.

To sclect fonts:

« Il you're using a mouse,
duuble click on the
tontname -- or scroll the
list by clicking the scroll
arrows until the desired
fontname is highlighted
and click on the Select
button,

¢ Il you're l.ising keyboard
controls, use the the |

and T keys to scroll the
font list unul the desired
tontname is highlighted.
Press the spuce bur 1o
select the destred font,

A fontis sclected when an
now appears o the left of
the tontame,

If you're editing &
document when you choose
Select New Fonts, those
fonts you were using 1o
create the document which
are also on the new path
appear italicized in the
scroll window, so you can
recreate your original
documentexactly. If you
do not sclect a font which
has been used in creanng
the document, it will
automatically be replaced
throughout the docunient
with the lowest numbered
font froin the new set of
selected fonts. Fonts are
provided by Style Ware
with a unique number from
1 to 200,

Those fonts which were
selected when you chose
Select New Fonts and
which also appear on the
new path appear selected,
with an arrow 1o the left of
the fontname,

The font number of a font
is indicuted 1o the right of
the font when it appears in
the scroll window,
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3. If you accldentally
select a font you don't
wish to Include,
Deselect the font.

You will notice that when a
selected font (indicated by
the presence of an arrow to
the left of the fontname) is
highlighted in the scroll
window, the Select button
is automatically convened
to Desclect. This change
indicates that you can
Deselect the font, thereby
removing it from the new
font set.

RN m s e e e v~ o i e

« If you're using a mouse,
click on the fontname or
scroll the font list by
clicking the scroll arrows
untl the agpropriate
fontname is highlighted.
Click on the Deselect
button to deselect the

¢ If you're using keyboard
controls, use the the |

and T keys to scroll the
font list until the )
appropriate fontname is
highlighted. Press the
space bar.

sdiipgion A font is deselected when
the wrrow 1w its left
disappears.
Select New Fonls
[PATH /MILTISCRIBE/ |
-

ddemey 1 A hress

S B Drive 2 | Press 42

=) bdabSLARTH ]

-) KR TUAIN { Palh | Press P

=) HILTON i List Yol.) Press oV

=) DANTE ;

=) ASINOY

- (SPACE)

) CHAUCER VoL Press

Press (RETURK)

Press (FSC)
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4. When you've

finallzed your selectlon
of new fonts, click on OK

or press Relurn.

You're returned 1o
MuluScribe, with your

newly-selected fonts listed

On e Font Menu, Any
lestan your document
oucielly witien in a font
otconta d i your new
Temtset will be rewiiten
vl the owest numbwered

font from the new font set,
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Formatting Text

e e e v

"

You format text in MultiScribe using rulers, headers, and
footers. You use rulers to change margins and page
indentation, to create tabs, and 1o specify the spacing and
Justification of your text, Once you've adjusted the sertings
on a ruler, all the text following that ruler and up to the next
nuler in the document is formatted 1o your new
specifications, If a niler is the st or only rulerina
document, all texi 1o the end of the document is formated
according 1o its settings,

The first ruler at the toi) of a document has a preset format.
This ruler cannot be se ccted, copied, deleted, or replaced,
and is used 1o set the initial format for a document.

Headers let you create and edit header information (text,
page #, date, and time) which will appear in the wp margin
of a document when it is printed. Footers are essentially the
same as headers, but allow you to place footer information
in the bottom margin of every printed page. You can use
both headers and footers in the same document.

Two additional formattin £ commands let you change the
page makeup of a document; Insen Page Break, which ends
one page and begins another at the insertion point, and Set
Page #, which changes the pagination of a docuinent.
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Using Rulers

When you first start up
MuluSenbe, the document
window is empty. There is
nu lext, and no rulers are
displayed. To puttextin
the dovument window, you
fy e text or open i file; 1o
display mulers, you'll use
the Show Rulers conunand.

When you want 1o furmat
textin a particular section
of a document, you'll use

the Insent Ruler command.,

To Display Rulers

= Chooss Show
Rulers from the
Format Menu or
press CM.

Once rulers are displayed,
their settings can be
changed to format text in
the document,

When you're finished
formatting a docurnent and
witnt to conceal rulers in the
document window, choose
Hide Rulers from the
Format Menu or press OM

. again,

To Inser a Ruler

With the Insert Ruler
Command

= Sel tha Insertlon
point at the place In
the document where
you want to change
the format of
subsequent text.

= Choose Insert
Ruler from the
Format Menu or
press GY.

A ruler is placed in the text

following the insertion

int and the insertdon point
is moved 1o the left margin
of the line below the ruler.

The new ruler is a copy of
the preceding one, and it
will not change the format
of the text following it unil

you adjust its setlings.
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To Insert a Ruler

With the Paste
Command

= Cut or Copy the
ruler to be Inserted
to the Clipboard.
(Ses "To Dclete a
Ruler with the Cut
Command" and '"To
Copy a Ruler,"”
Immediately
following.)

= Sel the Insertlon

polnt at the place In
the document where
you want the ruler
Inserted.

= Choose Pasle

from the EdIt Menu or
press GV.

A copy of the ruler on the
Clipboard is placed in the
document following the
insertion point and the
insertion point is moved to
the left margin of the line
following the ruler,

&
oo, %,
f a @

¥
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3
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To Delete a Ruler

With the Cut Command

= Select the ruler
to be deleted.

= Choose Cut from
the Edit Menu or
press UX.

The selected ruler is cut
from the document and
stored on the Clipboard,
where it will remain until
another cut or cupy is
performed.

With the Delete Key

= Select the ruler
to be dcleted.

= Press Dclelo.

The selected ruler is

permanendy removed from
the document.
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To Copy a Ruler

= Select the ruler
to be copled.

= Choose Copy
from the Edit Menu
or press CC.

The sclected ruler is copied
to the Clipbourd.

It can now be insened into
the document or into other
documénts using the Paste
command.
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Changing the settings on a ruler changes the format of all
text following the ruler and up to the next ruler in the
document, or to the end of the text, if it is the last ruler in
the decument. No changes 1o the text are displayed in-
% the document window until you move the mouse (if

‘7;1 ou're using a mouse) or cursor (if you're using
Ckeybourd controls) out of the ruler,

The settings on a ruler are of two types:

¢ setings you move on the inch scale to set the
indentation marker, margin markers, and tabs;

* option settings located on the option line below the
inch scale -- line spacing and text justification.

If you're using a mouse, you'll change the ruler settings
by clicking on the desired option settings and moving the
settings on the inch scale to the appropriale positions,

If you're using keyboard controls, changing ruler
settings is slightly more complex. In place of the mouse
pointer, you'll use the arrow keys and cursor 1o select
options settings and the Return key (o choose the desired
setting.
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Using Rulers From the Keyboard

1. Use the arrow keys to move the cursor Into
the ruler.
The cursor selects and flashes the left margin marker.

2. Press the « and — keys to move the cursor from
marker lo marker on the Inch scale.
The cursor selects and flashes each marker.,

3. To ad|ust markers on the Inch scale:
+ select the marker you want to adjust;
* press and hold down the (3 or & key;
« mova the marker to the right In small

Increments using the — key and lo
the left In small Increments using the

+ kay;

 move the marker to the right In larger
steps using the T key, and 1o the left
In larger steps using the | key.

4. Press tho | key to move the cursor o the
option line below the Inch scale.

3. Press the « and — keys (or Tab and (3Tab) to

move the cursor from setting to selting on the
option line,

6. To choose settings on the option line,
select a selting and press the Space bar.

7. Press tha T key once or the | key twice to
leave the ruler.

To Change Margins

= If you're using a
mouse, drag the left or
rlght margin marker to
the deslred positlon
on the Inch scale.

= If you're using
keyboard conlrols,
selact the right or left
margin marker, and
use the G key ond
arrow keys to move
the margin marker to
the desired pocition
on the Inch scale.

The left and right murgin
nurkers can be set no closer
than within two inch marks of
each other on the inch scale,
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scttings vn the bottom ruler intact.
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1. Set the Insertlon polnt where you want

to start the sectlon of text with a new
format.

./"/'quose Insert Ruler from the Format

Mrehy.

A copy of the preceding ruler is insened at the
insertion point. The insertion point moves to the left
margin of the line below the inserted ruler,

. Sel the Insertlon polnt at the end of the

sectlon of text to be reformalted.

. Choose Insert Ruler from the Format

Menu.

. Adjust the seltings on the first ruler

you Inserted.

See "Changing the Settings on a Ruler to Format
Text" for instructions on changing margins, tabs, line
spacing, and text justification,

The inserted ruler changes the format of all text
between the first and second rulers you inserted.
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Inserting Page Breaks

When you want to start a
new page at some point in a
document, you'll insert a

age break. The page
Ercuk SIArts @ new page
following the insertion
point and renumbers
subsequent pages
accordingly.

1. Set the Insertlon
point at the place In the
document where you
wanl to begin a new

page.
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2. Choose Insert Page

Break from the Format

Menu or press C-.

The insertion point and the
text immediately following
it move 1o the first line of a
new page.
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Repaglnation

You can change the
imual page nember of
adocument,
sutomatically
renumtenng ol
\th'.L‘lille“ [ages.
This as a usetul
leature lor those
umes whien you've
prted several
nombered pages of a
dowament und need 1o
add vne docutnent
Worth ol ext o i,

For mlormanon on
ponting a lurge
Gdocutnent from
several dovument
liles, see "Prinung

L arge Documents
Lsing P'nnt Merge,”

1. Choose Set
Page # from the
Format Menu or
press O=,

A dialog box
appears. The Set
Pupe # dinlog box
contns an input bar
for the new page
number you want to
specify, us well as
buttons for
continning (OK) and
canceling (Cancel)
the operation,

The input bar
contuins the current
tniual page number,
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2. Enter a
number for the
first page In the
document In the
Input bar,

The page number of °
the first page of the
document is set to the
new value you

entered, All
subsequent pages are
renumbered
accordingly.

The page number
change is reflected in
the scroll bar thumb,
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Using Headers

You vse the Set Header
command to create and edit
the header information .
(title, page#, date, and
time) which you can place
inside the Top Murgin of
)Ifour printed document.

he Set Header command
lets you enter and edit
header text, specify its font,
size, and style, und place
time, dute, und puge
numbers within the header,
(You must have a ProDOS-
compatible clock card
installed in your Apple to
use tme and dine.) In
addition, Sct Header allows
you to position the header
on your page within the
boundaries set by the Top
Margin,

To Create a Header

= Choose Set Header
from the Format Menu.

When you choose the Set
Header command from the
Format Menu, a dialog box
appears, The 1op line of the
Set Header didog box
CONLINS page sctup
specilficationg fur page
length, top marging, and
bottom smargin, This
inforniinon is given unly
for reference purposes and
cannot be changed with the
Set Header commund. To
change the page length, top
margin, or botom margin,
choose Page Setup from the
File Menu, For
information on the Page
Setup comnuind, see
"Genting Keady to Pring,”
later in this chipter,

The Set Header dialog box
also contuing an input bir
for Header position on page
(measured in inches), icons
for page nubeer, date, und
time, aruler, and large
input bar for entering and
editing header wext. This
Set Header input bar
represents the top margin of
your pige.
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When you choose the Set
Header command, the left
half of the menu bar menu
choices are dimmed,
indicating that commands
from those menus cannot
be exceuted. The Fonr,
Size, und Style menus,
however, are still o uve,
These menus remain
acceanible while a puge
header is being ereated so
that you can edit header text
with the various fonts,
character sizes, and styles
olfered by MulliScribe.
Note, however, that header
text cun be of unly cne font
and one churacter size.

NOTE: Because the menu
bur 15 panially disabled
with the Set Header and Set
Footer commands, and
because the Eso key is used
to cancel these operations,
the Keyboard Mouse works
differently during these two
operations. ‘To activ.ate the
Keyboard Mouse dunng

the execution of enher of
these commands, you'll use
Ctsc and not Esc to
activare the menu bar.

Once the inenu bur is
activated, menus and
comnuinds can be chosen
as usual, with the ¢, =3,

4.7, and Retum keys.
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= Type In the desired
Header text aj the
Insention point.

When you choose the Set
Header command, (he
bsciion poing appeiry
inaide the Set Hewder dialo
b, under the inch scile uF
the Tewder ruler. “The text
Which you enter in the
Hesder will nog appeir as
POl your document unti
the document iy printed; it
APPEUs onsereen only
when you choose the Seq
Header command. Yoy iare
wloved a maximum of one
line of ext in any one font
«id size, but you can
chooe any style ur
conibiniuon of styles for
your fext,

The font, size, and style of ¥
the new Header text can b,
Changed with commands '@

selected from the Font,
Size, and Siyle menus, all
of which remain active
during the Set Header
operition, Your fony, size,
and style choices wil] affect
the number of churucters
youcan fitin one line of
text; if your editing choices
increase the size of the
header text, the 1ex; 1§
truncated 10 fit insjde the
bounds of tie header input
bar,

Once you enter header text,
itremains in (he header
until you choose 10 edit or
delete the hewder text by
again choosing (he Sey
Header commuand,

To Edit Header Text

= To edit header
text, use the Deleta

%key to delete any

'?('
o

-

nwanted
haracters and enter

“Bny-new header text,

(5} (ot

‘Jhe font, size, und style of

the new header text can be
changed with comimands
selected from (he Font,
Size, and Style menus, all
of which remain active
during the Set Header
operation, Aguin, it js
important 1o note that
changing the font, size, or
style of your header 1ext
may affect the number of
characters you can fit inio
the header,
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To Change Fonts

= If you're using a
Mmouss, choose the
deslred font from the
Font Menu.,

= If you're using
keyboard controls,
press GEsc to
acllvate the menu
bar and choosa the
desired font from
the Font Menu.

The header text appears in
the sclected font,

If you're using keyboard
controls, it is iimponant 1o
remember that Fressing
only Esc cancels (he Set
Header command.

f _.-q....——..__,___._——-__,__,__‘

o ——— g

To Change Character
Size

= If you're using a
mouse, choose the
desired toxt slze from
the Size Menu,

= If you're using
keyboard controls,
press CEsc to
actlvate the menu
bar and choosa the
desired text sizo
from tho Size Menu,

The header text appears in
the selected size,

If you're using keyboard
conurols, it is imponant 1o
remember that pressing
only Esc cancels the Sei
Header command,

123 USING HEADERS

To Change Stylas

= If you're using a
mouse, chooso the
deslred stylo changes
from the Style Meonu,

= If you'ro using '
keyboard controls,
press CEsc to

activate the menu

bar and choose the
deslred style

changes from the Style
Menu.

Style changes can be
combined. Selecting Plain
text deselects all other style
selections and retums your
header text 1o plain text,

If you're using keyboard
controls, it is important 1o
note that pressing only Esc
cancels the Set Header
commnd,

——— e
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Setting the Time, Date,
and Page Number

Tu the nght of the Header
posdion nput bar are three
sti.all suare pictures, or
icons One contains a
p\u:ml sign ("#7), this is the
P manher icon, Another
contns the characters
CIUL A and recenibles a
pac from a desk culendin
this iy the ddateacon The
i dcvn resenibles w clock
teadong nine o'cloxks this is
tie Lene doon. The icons
for page number, date, and
G can be amanged wathin
tire bewder et mnade the
wop e, displayang,
rescoctively thie page
nuitar, date, and e of
PR 0N YOur printouts,
The page number icon can
always e sel. Use of the
Gl and e icons requires
thiat you have a ProDOS-
conpanhle system ek

card msatled in a slot in
your Apple He or lle,

The page number, dute, and
fhne assoctated wath the
respective page number,
date, and nme icons will be
prosied in the selecied font,
size, and style of your
header ext.

An icon can be pliced on
top af lext ur overwnien
Wil Lext.

%
%

0}{., 4/4, O\P

To Setmama

Number o

77 ‘8
¥,

Za

= If you're usfﬁ’g a’
mouse, drag the baga
number lcon down Into
the desired locatlon In
the header text Input
bar.

= If you're using
keyboard controls, use
the T key to move the
cursor Into the optlion
line above the text
header Input bar and

thoe - key or Tab key to
move the cursor over to
the page number lcon.
When the poge numbar
lcon Is selected, press
the space bar to move It
Into the texl Input bar.

Once in the text input bar,
you can muove the page
umiu icon by drapging it
if you're using a mouse; if
you're using keyboard
controls, you can move the
icon in small increments

using the G and G-
keys, or use the 3T and

AL keys o move the icon
in greater increments.

To Set the Date

= If you're using a
mouse, drag the dale
lcon down Into the
desired location In the
header text Input bar.

= If you're using
keyboard conlrols, use
the T key to move the
cursor inlo the option
line above tho text
header Input bar and
the — key or Tab key to
move Lhe cursor over to
the date Icon. When the
date Icon Is flashing,
Indlcaling that It Is
selected, press the

space kar to move It Into

the text Input bar.

Once in the text input bar,
ou can move the date icon
y dragging iLif you're

using a mouse; if you're

using keyboard controls,
you can move the icon in

small increments using the
G4~ and G- keys, or

use the BT and G keys

1o move the icon in greater
increments,
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To Set the Time

You must have a
ProDOS-compatible
clock card to use the
time icon. The time
of printing (not the
time of document
creation) will appear,
along with any
header text, in the top
margin of each page.

= Il you'ra using a
mouse, drag the
time lcon down
Into the deslred
locatlon In tha
header text Input
bar.

=> If you're using
keyboard controls,

use the T key to
move the cursor
Into the option line
abovo the toxt
header Input bar

and tho — key or
Tab key to move
the cursor over to
the time Icon.
When the time
lcon |s selected,
press the space
bar to move It Into
the text Input bar.

Once in the text input
bar, you can move
the dite icon by
dragping itif you're
using a mouse; if
{ou'rc using

eyboard controls,

ou ¢in move the
lcon in snull steps

using the B and
G- keys, or use the
GTand G keys to

move the icon in
grealer increments,

To Set Page
Number, Date, and
Time
Simultaneously

If you have a
ProDOS-compatible
clock curd you can
make use of both the
time and date icons,
This mieins you can
create combinations
of ume, dute, and
pave number in the
lop margin,

= If you're using a
mouso, drag the
lcon you wish to
set down Into the
desired locatlon In
the header text
Input bar,
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= If you're using
keyboard conlrols,

tho T key will take
you from an Icon In
tha headcr text
Input bar back to
tho option line In
the dialog box so
you can sclecel
another lcon.
Move tho icen into
the text Input bar
by pressing the
space bar.

Once you have more
thin one icon in the
margin you will need
to move back and
fonh between iwons
to place them, This
can be done using the
& and = keys; you
can also use Tub o
move right and

(Tab to move back
1o the left. Again,
when an icon lishes
itis selected and can
be moved witlun the
text input bar,




—— - -

To Position a Header

The Set Header dialog box
contains an input bar lor
Header posinon on puge
(measured ininches).  This
opion allows you 1o place
the hesler anywhere
between the wp of the page
and de op muargin.

The T der position is

s averad by il
dinensions ol the wp
mapin, You must specify
d heador pasiuon which
allows your hieader

v whon (o fit inside the
boundanes of the op
nargin copecitied with the
Fage Scwp command). If
you enter a hieader position
greater than the wop nurgin

settang, i dialog box
apreats, telling you that the
hetader st (i within the

Top Nargin.

. %
= To sel the hefdty, %
posltion on the plige 7 ¢

f
place the Insertion Fginty, [,

In the Header position®, ]
Input bar by clicking on 44
the [nput bar If you're
using a mouse or by
using the T key It you're
using keyboard

controls.

= Enter the deslred
header poslition value In
the input bar.

If the value you specify for
heuder posinon is oo great
for the specified wxt to fit
inside the top mirgin,
MuluScribe will
automatically adjust the
header positon to fit within
the dimensions of the Top
Margin, and this change
will be reflected in the
Header position input bar
of the Sct Header dialog
box the next time you
choose the Set Header
commuind.

P

To Set the Header In
Your Document

‘9’% you've specified your

er text in the font, size,

antBryle of your choice,
ind set the page number,
date, and time, you are

ready 1o set the header.

= Set the header by
clicking on OK or
pressing Return.

The Set Header dialog box
disappears. Your header
information is not visible
on the computer screen, but
will appewr at the top of
euach page of your
document when the
document is printed, To
view the header prior to
printing, exceute the Print
comrnand from the File
Menu, choose the Preview
option on the Print dialog
box, and press Rewmn,

Clicking on the Cancel
bution or pressing Lisc
cancels the Set leader
command, and all new
header information is
ignored,
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To Change a Header

= Choose Set Header
from the Format Menu.

= EdIt header text by
deleting It with the
Delete key and entering
new text. Change the
text to suit your needs
by cheosling the
appropriate font,
character slze, and style
from the Font, Size, and
Style menus,

= Change the position
of the page number,
date, or time on your
printout by moving the
appropriate lcons.

———_e e o ————
s s g

To Delete a Headar

You may decide to remove
the header from a current or
existing document.

= Choose the Set
Header command from
the Format Menu.

= Dclete all text and
remove all Icons from
the header toxt Input
bar.

Otherwise, whatever text
and/or icons remain will
serve as a header and will
appear in the top margin of
your printed document,
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To Remove lcons from
the Header Input Bar

= If you're using a
Mmouse, drag the Icon
back up above the Inch
scale In the Sel Header
dlalog box.

= Il you're using
keyboard conlrols, use
the «, =, T, |, Tab
and 3Tab commands
lo sclect the lcon, and
press the space bar.

The information -- page
nuinber, date, or time

== represented by the icon is
removed (from :Kc header
and will not appear in the
header when the documnent
i1s printed. 1M there is no
textin the header and all
icons are removed, the
header will not be printed.
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SRy . ’ To Edit Footer Text
Using Footers & o s B ] To Create Footer Text

w-[ﬁ: Qfdate a Footer

€= Choose Set Footer

R
You use the Set Footer Q¥

= Type In the deslred
cominind 1o create and edit

= To edit footer text,
use the Delete key to -

Y
s 4
»' iy
a8

When you choose the Set

e e LR

the foorer informuition (tte
Pes oA date, and time)
Wit h you can place inside
the fottom murgin of your
priovad document, The Set
Loo e command lets you
enter and edit footer text,
specily ats tont, siee, and
sty ey and place time, date,
and 1o e numbaes within
Ui b ter oY ou must have
a e 008 conganible elock
card stalied mvour Apple
wu cume and dee) In
addiron, Set Footer allows
Yuu Lo postion the footer
on yonf page within the
buitaries set by the

DOl nLrein, specified
with the Page Sciup
conunand.,

from the Format Menu

When you choose the Set
Footer command from the
Format Menu, a dizlog box
appears, The (op line of the
Set Footer dialog box
contiins page setup
specitications for page
lengih, op margin, and
botom nuargin, ‘Ihis
infurmuiion is given only
for refeience purposes and
cannot be changed with the
Sct Footer command. To
change the puge length, top
margin, or boltom margin,
choase Page Setup from the
File Menu. For
information on the Page
Setup command, see
"Getung Rewdy to Print,”
later in this chapter,

The Set Footer dialog box
also containy an input bar
for Footer posinon on page
(measured in inches), icons
for puge number, date, and
time, a nuler, and a large
input bar for entering and
editing footer text. This Set
Fouter input bur represents
the boltom margin of your
page.

Footer command, the left
half of the menu bar meny
choices are dimmed,
indicating that commands
from those menus cannot
be executed. The Font,
Size, and Style menus,
however, are stll active,
These mienus remain
accessible while a page
footer is being created so
that you can edit footer text
with the varous fonts,
charucter sizes, and styles
offered by MuliiSeribe.
Note, however, that footer
text can be of only one font
and one charucter size,

NOTE: Because the menu
bar is partially disabled
with the Set Footer and Set
Header commands, and
because the Esc key is used
to cancel these operutions,
the Keybourd Mouse works
differently during these two
w:cr;nions. To nctivate the
eyboard Mouse during
the execution of either of
these commands, you'll use
UEse and not Esc 1o
activate the menu bar,
Once the menu bar is
activaled, menus and
commands can be chosen

as usual, with the «, -4,
4, T, and Retum keys.
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footer text at the
Insertion polnt.

When you choose the Set
Footer command, the
insertion point appears
inside the footer text input
bar in the Sct Fooler dialog
box, under the inch scale of
the footer ruler. The text
which you enter in the
footer will not appear as
purt of your document until
the document is printed; it
appears onscreen only
when you choose the Set
Footer command. You are
allowed a maximum of one
line of text in any one font
and size, but you can
choose any style or
combination of styles for
your text,

[}
The font, size, and style of
the new footer text can be
changed with commands
selected from the Font,
Size, and Style menus, all
of which remain active
during the Sct Footer
operation. Your font, size,
and style choices will atfect
the number of characters
you can fit in one line of
text; if your editing choices
increase the size of the
footer text, the text is
truncated to fitinside the
bounds of the footer input
bar,

Once you enter fooler text,
it remains in the footer undl
you choose to edit or delete
the footer text by aguin
choosing the Set Fooler
command.

delete any unwanted
characlers and enter
any now fooler text.

The font, size, and style of
the new footer text can be
changed with commands
selected from the Font,
Size, and Style menus, all
of which remiiin active
during the Sct Footer
operution. Again, it is
imporant to note that
changing the font, size, or
style of your footer text
muy affect the number of
charactens you can fit into
the footer.

e —— —— e e . e o e e e =
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To Changae Fonts & £Tq Change Character
: o| & Size
= lfyou'rs usings  &lv @
mouse, choose the v ¥ {b It you're using a
b & a
desired font from the < A Tmouse, choose the
Font Kenu, S ¢!~ desired text size from
S | the Size Monu.
=lfyoureusing ® &
k< beard controls, =t you're using
EiG5a Escilo c% keyboard controls,

activa:e tho menu
bir and choose the
dosited font from
the Fonl Menu.

Thie footer ext appears in
tie selected lont,

Ifyuu'ie using keyboard
cuntrols, wis imponant 1o
reccermber that In._-.ning
only Lse cancels the Set
Foaier command,

press (CEsc to
actlvate the menu
bar and choose the
dasired text slze
from the Size Menu.

The footer text appears in
the selected size,

If you're using keyboard
controls, it is imponant to
remember that pressing
only Esc cancels the Set
Footer command.

To Change Styles

= If you're using a
mouse, choose the
desired style changes
from the Style Menu.

= Il you're using
keyboard controls,
press (Esc to
activate the menu
bar and choose the

- deslred style

changes from the Style
Menu.

Style changes can be
combined. Selecting Plain
text deselects all other style
selections and returns your
footer text to plain text,

If you're using keyboard
controls, it is important to
note that pressing only Esc
cancels the Set Fooler
command.
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Setting the Time, Date,
and Page Number

To the right of the Footer
position Input bar are three
small square pictures, or
icons. One contains a
pound sign (“#"); this is the
page number icon. Another
contains the characters
"JUL 4," and rescmbles a
page from a desk calendar;
this is the date icon. The
third icon resembles a clock
reading nine o'clock; this is
the time icon. The icons
for page number, date, and
time can be arranged within
the footer text inside the
bottom murgin, displaying,
respectively, the page
number, date, and ume of
printing on your printouts.
The page number icon can
always be set. Use of the
date and time icons requires
that you have a ProDOS-
compatible system clock
card installed in a slot in
your Apple Ile or Ilc.

The page number, date, and
time associnted with the
respective page number,
date, and uine icons will be
prinied in the selected font,
size, and style of your
footer text.

An icon can be placed on
top of text or overwritien
with text.

To Set the Page
Number

= If you're using a
mouse, drag the page
number Icon down Into
the deslired location In
the fooler text Input bar.

= If you're using
keyboard controls, use

the T key to move the
cursor Into the opllion
line above the toxt
footer Input bar and the

— key or Tab key to
move tho cursor over to
the page number Icon,
When the page number
Icon s selecled, press

the space bar to move It

Into the text Input bar,

Once in the text input bar,
you can move the page
number icon by drapging it
if you're using s mouse; if
you're using keyboard
controls, you can move the
icon in small increments

using the B~ and B—
keys, or use the 3T and

G keys 1o move the icon
in greater increments,
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To Set the Date

= If you're using a
mouse, drag the date
Icon down Into the
deslred location In the
footer text Input bar.

= If you're using
keyboard controls, use
the T key to move the
cursor Into tho option
line above tha text
fooler Input bar and the

—+ key or Tab koy to
move lhe cursor over to
the date Icon. V/hen the
date Icon is sclectad,
press tho space bar'to
move [t Into the text
Input bar,

Once in the text input bar,
you can move the date icon
by dragging it if you re
using a mouse; if you're
using heyboard controls,
you can move the icon in

small increments using the
O« and G keys, or

use the OT and B! keys

10 move the icon in greater
increnents.




To Set the Time

You must have a
ProDOS-compatible
cleck card to use the
time icon, The time
of printing (not the
tine ol document
creation) will appear,
along with any footer
text, in the battom
maryin ol each page.

=» If you're using a-
mouse, drag tha
tiniy icon dowin
into the desired
location In th2
focler text input
bar.

dS  07nvd OYS -
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= If you're using
keyboard conlrols,
use the T key to
movo the cursor
Into the optlon line
ahove the text
footer Input bar
and the — key or
b key 1o move
e cursor over to
> time Icon.

= Whan tha time

S febn Is selected,

b press the space

i B to move It into
the text input bar,
rm

7

Once in the text input
par, you cian move
fle date icon by
auging itif you're
ging a mouse; if
you're using
keyboird controls,
you can move the
icon in small steps

using tne G+ and
(3— keys, or use the
AT and AL keys to

move the icon in
greater increments,
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To Set Page
Number, Date, and
Time
Simultaneously

If you have a
ProDOS-compatible
clock card you can
mitke use of both the
time and date icons.
This means you can
create combinations
of ume, dute, and
age number in the
tom Margin,

= If you're using a
mouse, drag the
Icon you wish to
set down Into the
desired location In

the footer text Input

bar.

= If you're using
keyboard controls,
the T key will take
you from an lcon In
the footer text Input
bar back to the
opllion llne in the
dialog box so you -
can select ancther
lcon. tAove the
Icon Into the text
Input bar by
pressing the space
bar.

Once you have more
than one icon in the
margin you will need
to move back and
forth between icons
to place them. This
can be done using the

« and = keys; you
can also use Tab to
move right and
(Tab to move back

1o the left. Again,
when an icon flashes
it is selected and can
be moved within'the
text input bar.
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To Positlon a Footer

The Set Footer dialog box
contains an input bar for
Fooler position on page
(measured in inches). This
option allows you 1o place
the footer anywhere
between the bottom of the
page and the bottom
margin.

The footer position is
governed by the
dimensions of the bottom
margin. You must specify
a footer position which
ullows your footer
information to fit inside the
boundaries of the bottom
margin (specified with the
Page Setup command). If
you enter a footer position

cater than the distance in
inches {rom the bottom
margin to the bottom of the
page, a dialog box appears,
telling you that the footer
must fit within the bottom
margin,

= To set the footer
position on the page,
place the Insertlon polnt
In the Footer position
Input bar by clicking on
tho Input bar If you're
using a mouse or by

using the T key If you're
using keyboard
controls.

= Enter the deslred
footer position value In
the Input bar.

If the value you specify for
fooler position is 100 great
for the specified text o fit
inside the bottom murgin,
MultiScribe will
automatically adjust the
footer position to it within
the dimensions of the
bouom margin, and this
change will be refected in
the Foolter position input
bar of the Sct Footer dialog
Box the next time you
choase the Set Footer
command.
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To Set the Footerin
Your Document

Once you've ified your
fooler text in the font, size,
and style of your choice,
and set the page number,
duate, and ume, you are
ready to set the footer,

= Sel the footer by
clicking on OK or
pressing Return.

The Set Footer di.log box
disappears. Your fuoter
informution is not visible
on the computer screen, but
will appear at the bottor of
each page of your
dovument when the
documient is prnted. To
view the footer prior
pnnung, ¢xecute the Print
comnund from the Lile
Menu, choose the Preview
opuon on the Print dilog
box, and press Retumn,

Clicking on the Cancel
button or pressing Esc

cancels the Set Footer

comnuind, and all new
footer information 1§

ignored.
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To Change a Footer

= Choose Set Footer
from the Format Menu.

=» Edit fooler text by
dclzling It with the
Dcite key and entering
new/ text. Change the
text to suit your needs
by choesing tha
arropriule font,
ch:racter size, and style
frcm the Fonlt, Size, and
Style mazaus.

= Changa the positlon
ol the p.ge number,
dai2, or tima on your
printout by moving the
appiropriate lcons.

To Delste a Footer

You may decide to remove
the footer from a current or
exisung document,

= Choose the Sat
Footer command from
the Format Menu.

= Deloto all text and
remove all lcons from
the footer text Input bar,

Otherwise, whatever text
and/or icons remain will
serve as a footer and will
appedr in the bottom margin
ol your printed document.

To Remove lcons from
the Footer Input Bar

= If you're using a
mouse, drag the Icon
back up above the Inch
scale In the Set Footer
dlalog box.

= If you're using
keyboard controls, use
the «, =, T, 1, Tab
and (Tab commands
lo sefect the lcon, and
press the space bar.

The infonmition -- page
number, date, or time

-- represented by the icon is
removed from the footer
and will not appear in the
footer when the document
is pninted. If there is no
text in the footer and all
icons are removed, the

footer will not be printed. é’
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Working With Documents

Most of the commands in MultiScribe are for editdng
and formatting text. The commands on the File Menu
let you work with entire documents -- naming and
saving documents as files on disk, opening and
deleting existing files, and printing document files.
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Saving
Documents

Saving a document
means wnling a copy
of the document
yod've created onto &
Nappy or hard disk.
You should save
yuur doctmnents
trequently as you
Work, O purantee
it you have a copy
al the most recent
Vet ol your
dorument on disk.
Poser surpes and
{.fures e rare, but
wlen they occur they
can destioy hours of
lrd work.

The File Menu
CONLANS WO
Contamands for saving
documents: Save and
Save As. You'll use
Save o save changes
1o a document that's
boen named, Use
Save As when you
want o osave the
cutrent docament
without replacing the
old version of the
document under a
dilferent filename or
pathname.

You'll also use Save
As when you want to
save a document with

a different file (o
format, such as, =

ASCII texe ﬁm_, :5;?
!
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ToSavea
Document

The Save command
lets you Ixriodjca.lly
save a file which has
already been named.
If you're saving a file
for the first time, the
Save As dialog box
appears (see the next
section, "Save As").
Otherwise, the only
dialog box 10 appear
when you choose
Save is a message
telling you the name
of the file being
saved to disk and the
file format
(MultiScribe file,
ASCII text file, Old
MultiScribe file) with
which that file is
being saved.

= Choose Save
from tho Flle
Menu or press
as.

A dialog box a

to remind you g, the
name and file format
under which your
document is being

saved 1o disk.

If MuliiScribe can't
find the disk or path
on which the
document was
originally saved, a
dialog box appears,
asking you to insert
the disk containing
the necessary path.

If you insent the
arproprialc disk and
click on OK or press
Retumn, the document
will be saved. If you
click on Cancel or
press Ese, the Save
operation is canceled.
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1. Choose Save
As from the Flle
Menu or press

To Save a Document on a Different
Disk or Under a Ditferent Filename or
Pathname

: GA.
The Save As command lets gou save &
document under a different filename or A dialog box appears.
athname, and so is especially useful for
Bncking up a document on i different disk or The Save As dialog

under a different name. Save As also lets you
back up a docurnent on a hard disk, or save a
document read from a hard disk onto a floppy
disk to back up a hard disk docunient file.

box contains input
bars for pathname and
filename, as well as
buttons for drive
{(Dnve 1, Drive 2),
Path, Save, and
Cancel, and option
scttings for file format
(MuluScnbe file,
ASCIl wext file, Old
MultiScnbe file).

For more infonnation on pathnames und
filenames, see Appendix E, "ProDOS
Pathnames and Filenames," as well as the
ProDOS User's Manual, published by
Apple Computer, Inc.

The input bars contain
the current pathname
and filename under
which your document
was last saved.
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If the document was
last saved under a
drive, that drive button
is highlighted and its
athname is in the
ATH input bar;
otherwise, the Path
button is highlighted
and the pathname is in
the PATH input bar.

If the document has

not been saved before,
the PATH and NAME
input bars are empty,
and neither the Path
bution nor a Drive
bution is selected.

o s il o S




2. Change the
name ol the
document, path
or drive, or both.

=3 If you're using a
moise, click onthe
l'.\.] ” ur N.\.\“:
input bars w eatera
New pathnutie or
Hlename, Towave
the dovcament toa
disk on adilrerent
drnve, elick on the
Liiive 1 or Drive 2
buuon,

= If you're using
keybourd contruls,
use the & and —
keys to move the
inserion paoint
Ivtween tie PATH
and NAMILE input
burs to ecater a new
pathname or
itenane, To choose
aditteient drive,
press the WV

ey in conjunction
with the hey
representing the drive
number (1 or 2).

The space remuining
on the specified
volume is displayed
in K (Kilubytes) in
the upper nght comer
of the dialog box.

4
e

S .

.

If no document has
been opened or
saved, you must
specify the current
pith by choosing a
diive or entering a
pathnane in the
PATH input bar.

To Save documents
with a single disk
drive, remove your
MultiScribe disk
from the drive and
insert i formutted
data disk. Click on
the Drive 1 buton or
press (1.

If you're using a

5 14" dnve,
MultSeribe can
autontically format
§ 1/ disks; see
"Saving o Document
with No Room on
Disk" lor instructions
on using MuliScribe
10 autonutically
format 5 1/4" disks.
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3. Click on the
Save button or

press Return.

If you've entered the
name of an existing
MultiScrilx
document, a dialog
box appears, asking
if you want to replace
the document file on
disk with the one
you're saving.

If you confirm the
command by clicking
on Yes or pressing
Y, the old version of
the document file on
disk is replaced with
the new document.

If you click on the
No button or press

N, you're retumed Lo
the Save As dialog
box to enler a
different pathname or
filename,

If you click on
Cancel or press Bsc,
the Save As operation
is canceled.

USING MULTISCRIBE

If MultiScribe can't
find the specified
athname, a dialog
x appears asking
you to insert the disk
contaihing the path in
the current drive.

If you insert the
urpruprimc disk and
click OK or press
Return, the document
will be saved under
the specificd
pathname and
filename. If you
click on Cancel or
press Esc, the Save
As operition is
canceled.
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To Save a
Document with a
Different File
Format -- Such as
ASCIl Text

The Save As
comunind also lets
you save a file with a
different file format
--as an ASCII text
file, as an "Old
MultiSeribe file" (a
file which will work
with pre-2.0 versions
of MuliiScribe), or,
of course, as a
MuliScribe file.

The ogtion you'll
probably use most
frequently is ASCIT
text, which lets you
save a MultiScnbe
file as an ASCII text
file so that it can be
used with other
softwire that reads
ASCII text files, such
as AppleWorks.™
(Fur more
information on using
MultiScribe files with
AppleWorks, sce
Appendix A, "Using
MultiScribe With
AppleWorks,")

When you save o
MultiScnbe file as an
ASCII text file, you
lose all the special
information -- about
fonts, sizes, styles,
formatting -- which
makes a MultiScribe
file unique, so you'll
want to be carcful
with this feature of
the Save As
command,

If for some reason
you wish to use an
old version of
MultiScribe

-- older than version
2.0 -- Suve As lets
you save your
documents as "Old
MultiScribe” files,
which will work with
your old version of
the program.,
MultiSeribe 2.0
documents have
speciul formaning
informution -- top
and borlom margin
and hedader/looler
informaton -- not
used by older
venions of the
program.

1. Choose Save
As from the Flle
Menu.

The Save As dialog
box appears. The
Save As dialog box
contains input bars
for pathnanie and
filename, buttons for
drive (Drive |,
Drive 2), Path, Save,
and Cancel, and
option serings for
file format
(MultiSenbe file,
ASCII text file, Old
MuliScribe file).

If a path has been
sclecied, the space
remaining on the
volumie on which that
path is locuted is
displayed in K
(kilubytes) in the
upper night comer of
the didlog box.
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2. Change the
name of the
document, path
or drive, or
bath.

format optlon t8s
the desired
sotting.

¢ If you're using a
mouse, click on the
setting in front of
the option you wish
Lo select,

3

If you're using
keyboard controls,
use the Tand 4

keys 1o move from
the input bars 1o the
file format option
line. To move back
and forth between
seiings, use the &

and = keys. To
choose a sciing,
press the space bar,

7]
('asCiick on the

Save button or
press Return.

If you try to save the
document under the
old pathname and
filenaine, a dialog
box will appear,
asking if you want to
replace the old file on
disk with a new file
with the same niume
but different file
formal

If you confirm the
operation by clicking
on Yes or pressing

Y, the old version of
the file is replaced
with a new version of
the document with
the file forinat you
specified,

If you choose No,
you're returned to the
Save As dialog box
to enter a dilferent
pathname or
filename.

If you choose
Cancel, the Save As
operation is canceled.

NOTE: Whenever
you chunge the file
format with which a
document is saved,
MultiScribe will
continue 1o save
documents with that
format unol you
change the format
specification. If you
changpe the format to
ASCII text file or Old
MuliiScribe file,
remember (o change
the format back to
MuliiScribe file
before aucmptin{r- o
save documents for
use with MulaScribe
2.0.
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To Save a
Document With No
Room On Disk

Sometimes when
you're saving a
document, you'll run
out of space on the
disk to which you're
saving and a dialog
box will appear to
alert you 1o this
problem,

When this occurs,
yeu should iry to
save to a different
drive or disk. If you
iry 1o save 1o a disk
on another drive or
path and that disk is
also full, you'll want
to format an
unformarted disk and
save to that disk.

= Use the Save
As command to
try to Save the
document to a
ditferent drive
or path.

= If the disk on
the new drive or
path Is also full,
or If you're
uslng a single
disk drlve
system, Insert a
different disk In
the drivo and
choose the
same drlve from
the Save As
dialog box.

= It you're saving
toadiskona

3 1/2" drlve, you'll
have to Insert a
pre-formatted disk
Into the drive.

While MuliiScribe
will automaticall
formae 5 174" da':t:.s.
the program cannot
forrnat 3 172" di~ks.
Use the Filer uiility
on the PruDOS
System Unilities disk
1o format 3 172" data
disks for use with
MultiScribe,
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= If you're using & )%L% u Opening Documents
5 1/4" drive and « 7 M : :
T . 00s¢e . Ye | F e '1 Opening a document means . If you've made changes to the current document which . _
YR EenL inho ::f yﬁlijckcc?ng onyo?%n ?,% g y:liijciliif?:’.) ?ﬂ thcs I?I? t":::]n::gf\c thc : reading a document file from disk you haven't saved, both the Open and New commands
furmatted disk to obuttonor o ¥ Vs bl or operation by cﬁcldxig ; - and displaying it in the document will display a dialog box askinLE if you want 10 save your
place in the drive, pressing N, you'réz |, f":,pﬂ:ssing Y,another | onthe Cancelbution s mme o w!ngow.for ﬂ)"“nn{i the d?‘:“m’:"' changes before proceeding with the operation.
Insert an retumned to the Savs [©. diglog box appears, | or pressing Esc, in ;"” I °‘",rh‘5 crca}(}mn (Bl '
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dizk In tha drive enter a new drive, 4% volmne name for retuned (o the Save B m 'y iiriﬁow'?i g:z:ud;cun[:z;n E pressing Y:
ond ¢ & path, or filename, the Y5k you want As diulog box. ; o -
St SaRg Y to format window =siom thit document, and If the current document is untitled, the
£.mo drive from ; LS - you can use al! the MultiScribe . ! A
Wic & g A « If you choose O‘h‘f‘}”“‘;i '_y(fi‘f.l'("_ :d B sem commands to modify it (o your Save As dialog box appears, to allow
e = Cancel by clicking name 1o tic Llska satisfuchion, you to save the document under the
a.alog box. SRR s gﬁ?tssb%l; Ri: o D pathname und filenume of your choice.
King P
T I ing s ‘ You use two different commands
A new dialog box - Dutten:or pressing button or pressing B — Y onE e e 4 ¢ If the current document has been saved
e AMing Esc, the Save Rewurn, Yet another p : pens b : 3
.;‘,p‘u,'u.;, telling yu;l operation is o b will file already saved on disk; New before, it is saved under its previous
lf 'L‘ s E”'bt::”m"(;l canceled and you're appear, waming you  Bm wees o opens a new, cmpy file, clearing pathname and filename.
;:i atilzll.jrling ,T;l / rewrned o your lh;ft all information . [ the document window.
forma it glﬁfnl:[:r::m on the disk to be - U = : ¢ If you choose No by clicking on the No button or
- formaited will be B o g R{mssmg N, the dialog box disappears and the
erased. If you = ew or Open operauon continues.
choose 1o proceed, ;
the disk will be = = ; : Ao
X : I ¢ If you click on Cancel or press Esc, the operation is
formatted so that you = — canceled and you're retuimed 1o your plac?cin the
can then save your D current document.
document on it ‘
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Opening a New
Document

You'll use New when you
want a "clean slate” on
which 1o create a brand new
document, g

= Choose New from
the Flle Menu or
press ON.

If the current document has
unsaved changes, a dialog
box appears to allow you 10
save your changes. Sece the
introduction 1o "Opening
Doc¢uments” for an
explunation of this dialog

When you open & hew
document, it has no name
and won't have one until
you save it with one of the
Save commands. The
word Untitled appears in
the File Menu as the name

box. of the document.
Once you've saved your
changes, or if the document
has no unsaved changes,
the current document 18
closed and a new, empty
document appears in the
document window.

S g el T e e 5 RS 8 RS SR ) S

i E
, . =
SAVE changes before opening A o &
1 ney file? %2 d
[Tes | Press ¥ Press %ﬁ}% s
Press N X |5
__ St .
e oo
° =
2
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Opening an Existing
Documant

You'll use Open when you
want to edit a document
already saved on disk.

1. Choose Open
from the File Menu
or press GJ.

If the current document has
unsaved changes, a dialog
box appears, asking if you
want 1o save the changes
you've made before
opening a new document,
See the introduction to

"Opening Documents” for
an explanation of this
dialog box.

Once you've saved your
changes, or if the current
document has no unsaved
changes, a dialog box
appeirs.

The Open dialog box
contains an input bar for
pathname, a scroll window
with a list of all MuluScribe
docufment files on the
current path, buttons for
changing path (Drive 1,
Drive 2, Puth, List Vol.),
und buttons for Open and
Cancel.

2. Choose the drlve
or path that conlalns
the document you
want to open.

If you've just started up
MultiScribe and haven't
opened a document or

saved one to disk, the scroll

window doesn't contain a
list of filenames. Rather, it
conlains & message asking

ou to select Drive 1, Dnve

, or Path.

If you have opened or
saved a file,
last pathname under which
a file was olxncd or saved
appeirs in the PATH input
bur. This is the pathname
of the current path, Also
displayed, in the upper
right comer of the Open
dialog box, is the anount
of space in K (for
kilobytes) left on the
volume on which the
current path is located.

If the document you want
to open is on the current
path and its Alename is
displayed in the scroll
window, youll want to
leave the Drive and Path
burtons alone.
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If the document you want
to open is not on the current
path, you'll select the drive
or path that contains the
docunient you want 1o open
by:

« clicking on the Drive |
Lutton or pressing O1 if
the document is on the disk
currently in drive 1;

o chicking on the Drive 2
buatton or pressing 32 if
the docuinent is on the disk
indrive 2;

« clicking on Path or
pressing SP and entering a
pathneme if the document is
on a directory or
subdirectory of a hard disk.

* clicking on List Vol. or
pressing BV o list all
volumes online. Volumes
are distinguished from
document files by being
preceded by a slash (/")
and followed by the
volume's slot and drive
number. Dircclories are
also preceded by a slash but
are not followed by slot and
drive numbers, To list all
the files on a volume or
dircctory, select the volume
or directory by scrolling the
file listin the seroll window
until the desired
subdircetory niume is
highlighted,

i

Open the volume or
directory by double clicking
on the sclected volume or
directory name or by
clicking on the Open button
if you're using a mouse, or
by pressing the Return key
if you're using keyboard
controls. All the
MuliScribe document files
on that volume or directory
are displayed in the scroll
window, and the total
amount of memory space
left on the volume on which
the current path is localed is
displuayed in K (for
kilobytes) in the upper right
comer of the Open dialog
box.
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3. Select the name
of the document you
want to open from
the list In the scroll
window,

* If you're using a mouse,
click on the filename of the
document you want to
open, or scroll the list by
clicking on the scroll
arrows until the desired
filename is highlighted.

o If you're using
keyboard controls, use
the L and T keys to scroll
the list until the filename of
the document you want to
open is highlighted.

4. Double click on the
filename of the flle you
wlish to open, or click on
the Opan button or
proess Return If you have
a filename selected.

A copy of the document is
read from disk and
displayed in the document
window,

Any changes you make to
the docunient won't affect
the voL}y ol the document
on disk until you save the
chunges back to disk.

Choosing Cancel by
clicking on the Cancel
button or pressing Esc
cancels the Open operation
and returns you 1o your
place in the current
document,
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Delaeting Flles

The Delete command
allows you 1o remove
unwanted files from
vour disk. With
Delete you can select

aoe file or a proup of

tiles 1o be (.IL'IL'W!}
Lot a particulur

Pathand you can
detcie all types of
Hles, notonly
MutuScribe

dovument files, The
only tiles the Delere
Cortand won't let
Yo temove are fles
necessary for the
smenoth execution of
MuiuSoenie iself;
PraDOS, font files
on the MultiSer. be
[, the MuliSceribe
and Fond ditor
prodram liles, and
the Clipbourd.,

1. Choosa Delete
from the Flle
Menu.

.When you choose

Delete a dinlog box
appeirs which
contains an input bar
for Puth, a scroll
window, butions for
Puath selection (Drive
1, Drive 2, Puth, List
Vol.), and a button
fur sclecting and
deselecung files for
deleion,

If a pathname has
been specified, the
name ol the last
pathname specified or
sived 1o appears in
the PATI input bar,
Also displayed, in the
upper nght comner of
the Open dialog box,
is the winount of
space in K (for
kilobytes) left on the
volume on which the
custent path is
located.

If no path has been
specitied yet, a
nrssage instruciing
you o select Drive |

" or Drive 2 or 10

specify a path
appeurs in the seroll
window,

2, Choose the
drlve or path that
contalns the flles
you want to delete.

If you select a path
conlaining no files, a
dialog box uppeurs,
telling you no files
were found on the
specified path.

If this message
should appear, click
on OK or press
Retum 1o retum to
the Delete dialog box,

You can't combine
selections of files
from different paths
for deledon. Each
separate path which
contains a group of
files you wish 1o
delete requires anew
application of the n
Delete conunm}g. ,%
m

&L
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Once you've chosen
a file or group of files
1o be deleted,
however, MultiScribe
returns you (o the
Delete dialog box so
that you can continue
lo delete files undl
you're linished
removing all
unwanted files from
each path from which
you wish 1o delete
files, ut which time
you click on Cancel
or press Esc (o exit
the Delete command,

The files displayed in
the scroll window of
the Delete command
diulog box have the
ProDOS file oype
(SYS, BIN, TXT,
WPF, ENT, etc.)
assigned 1o that file

ndisplayed to the right

=3

of the filenane. For
more about these file
types and what they
medan, consult your
ProD0S User's
Manual,

Some files appear
dimmed; these are the
files MuliiScribe
needs for program
operation ind they
can't be deleted.

Files that don't
appeur dimmed can
be deleted.
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3. Select the files,
one at a time, that
you want to delele.

To select files:

¢ If you're using a
mouse, double click
on the filename

== or scroll the list by
clicking the scroll
arrows until the
desired filename is
highlighted, then
click on the Select
button to select the

o If you're using
keyboard controls,
usc the the L and T
keys to scroll the file
list until the desired
filename is
highlighied. Press
the spice bar to select
the highlighted file
for deletion,

A file is selected for
deleton when an
ATOW APpears o its
left.

4. Deselect any
flles you want to
remove from the
group of flles to be
deloted.

When a selected file
(indicated by the
presence of an armow
1o the left of the
filename) is
highlighted in the
scroll window, the
Scleet bution is
automatically
converted 1o
Deselect, If you click
on the Deselect
bulton or press the
spice bar while a
selected file is
highlighted, the file is
desclected from the
group of files to be
deleted,

To deselect a selected

filename:

= If you're using

A mouse, double-
click on the filename
OR scroll the file list
by clicking the scroll
wrows until the
appropriate filename
is highlighted and
click on the Deselect
button.

s If you're using
keyboard

cuntrols, use the

the L and T keys 1o
scroll the file list until
the appropriate
filename is
highlighted and press
the space bar,

A file is deselected
when the arrow 1o its
left disappears,
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S. When you've
finalized your
selection of flles
for deletlon, click
on OK or press
Relurn,

“The selecied files are

deleted from the
specitied pathname.
You're returned 1o
the Delete dialog box
lo continue deletng
files from other
[\):ilhs. To exit the
clete command,
click on Cuncel or
press Esc to cancel
col
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s4  Getting Ready to 1. Choose Page 2. Set the Paper
Print Setup from the Flle | length.
Menu.

Piinting Documents MuliScribe gives you the option of printing in six different

print quality modes:

e
Ak

* NLQU is one of two Near Letier Quality print
mades offered by MultiScribe. These two NLQ
modes are the darkest and most detailed of the
six print modes, but they also take the most time
to print,

¢ NLQ2 is MuliScribe's second Near Lenter
Quality print mode,

¢ Migh quality is the most detailed non-NLQ
print mode.

* Standard is the second highest quality
non-NLQ print mode and the one you'll use
for most of your printing.

E[CRCHCnC e

,...._.
e

l :

P

| S

The Page Setup
command is designed
to let you make
formatting decisions
prior (o printing a
document. When
gou choose the Page
elup commind a
dialog box appeurs
allowing you 10
specify paper size,
the dimensions of the
Top and Botom
Margins, and the
depth of Page Indent

A dialog box
appears,

The Page Setup
dialog box contains
option settings for
four stundard paper
sizes, input bars for
Paper length, Top
Margin, Botlom
Margin, and Puge
indent,

The Page Setup
comunand contains
option sertings for 4
standard paper sizes:
US letter (11" high),
US legal (14" high),
Ad letter (the
European standard,
11 2/3" high), and
International Fanfold
(12" high).

o If you're using a
mouse, click on the
sctting in front of the
option you want (o
select.

o If you're using
keyboard controls,
use the the L and T
keys 1o move up and
down between option
lines. To move back
and forth berween
option scttings, use

toumy ¢ on your printed page. the ¢ and — keys.
¢ Draft is the lowest quality miode which o = (% To select a page size,
includes fonts, sizes, and Styles, but it L _] (2 press the space bar,
prints at a fuster speed than Standard, ity
High, or either of the NLQ modes, 3 %%%%5\ : Selecting a page size
i ol L J 1 % < other than JSﬁcncr
¢ Text uses your printer's built-in character S oo 5N will automatically
seL 10 print documents at maximum speed - '.3 o 9 Co. change the numilier in
but with no special MultSeribe fonts, [ J % the page length input
S i il I' i . § Y i a .
sizes, or styles % 7{9, % Page Selup b:r lol llll:l}llppropnalc
¢ Preview is tcchnically not a print mode; rather, H)‘ ‘-‘ﬁ‘ e
when you select Preview, your document is Pape 6 bipleller Ofd lelter

olS legal Olnternational Fanfold

Page IengtlvE] Top H1r9in= Bollon mrgin:m
Page indenl= |
Press (RETURK) Press (ESC)

displayed on the screen exactly as it will appear
when printed, s0 you can sce how your
document will look and make any necessary
modifications 1o it before printing,

lw a

The characters on your printed documents will appear
shorter and fuller than they appear on the screen; this is
because your printer has superior venical resolution 1o
the Apple double high-resolution screen, so charicters
on the screen look ller and thinner,

La

rrmmmmmmm'n
i

LI
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3. Specity the
desired Page
length, Top
Kargin, and
Bottom Kargin for
your document.

The Pape Sctup
dialop box contains
iyt bans for Page
Lo h, Top Margin,
prnd Rottom N ping
The detault settugs
fur thes 2 upuons e
spevificd respecuvely
ol 133, and 115
inches.

To enter new vilues
fur page length and
top and bottom
arpins:

« If you're using a
mouse, click on the
input bars w enter
new values,

o Il you're using
keaboard controls,
move Lo the ow of
input bars using the l

Ley. Move between
the input bars using

the & and — keys.

The new vilues you
enter in the Puge
Lenpth, Top Pjurgin.
and Botom Margin
input bars are
poverned by page
content, Your
document must

reserve between 3
and 14 inches for
actual text, which
limits your choice of
page length 1o from 3
1o 14 inchies, The top
and bottom margins
combined must
reserve 3 inches of
space in the
duocument for actual
lext

If you enter o new
vilue which exceeds
these page content
limits, a dislog box
appears, elling you
the resulting page
would be wo lurge or
oo small,

Click on OK or press
Return to retum to
the Page Serup dialog
box.
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4. Speclfy the
deslred Page
Indent for your
document.

The Page indent is set
at.25 inches. This
will position your
document in
approximately the
middle of a standard

(8 12" wide) printed
page. Youcan
chanpe the Page
indent to alter the
positioning of your
document on a

You can creatc a page
indent up to 12
inches o accomodate
wide carriape
printers, 1f you enter
a value greater than
12 inches, a dialog
box appears to
remind you that 12
inches is the
maximum pige
indent value

printed page; this is permtied.
most useful for s
centering MuluScribe Click on OK or press
documents on wide Return to retum to
camage printer the Page Setup dialog
paper. box.
« If you're using a
mouse, click on the
Page [ndent input bar
1o enler a new value.
o If you're using
keyboard controls,
use the 4 key 10
move the insertion -
int into the input e
and enter anew |55
page indent value. o [ ™
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5. Click on OK or
press Return.

Your page sctup
settings are stored on
disk and will remain
in effect until you
change them.

Clicking on Cancel or
pressing Esc cancels
the Page Setup
operation und your
old setdngs remain in
effect.
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Printer Setup

Before you can prin
a document, you
mut tell Mu]{lSL‘nbe
wWhat panter and
Pranceruerface cand
you'te uangy You
doth iy wath the
Irintoe Seup
conunand on the O
Mcenu,

1. Choose
Printer Setup
from the Q
Menu,

A dialog box
appeurs,

The Printer Scmp
dialog box containg
serull windows for
prinicr and interface
card selection, an
option line for
expansion slot
nunilwry, and bunons
for OK (1o store your
sctungs) and Cancel,

If you're using a
I’IIUIIH.', you cian
mewe Back and fonth
between the serul)
wiidows by simply
clicking inside (e
seroll window you
want to activare, The
nane of die siroll
winidaw is
highlighted when ir's
active, !

I you're using
keybourd
controls, you can
move berween the
scroll windows with

the & and — keys,
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2. Choose your
printer from the
list In the
Printer scroll
window.

« If you're using

& mouse, click on

the nume of your
printer or ¢lick on the
scroll arrows until the
name ol your printer
is highlighted,

* Ifyou're

using keyboard
conltruls, press the

L and T keys o
scroll the list uniil the
name of your
interface card is

"

wé?p o
2% o
3 Chooso?oiy, %
Interface caed, %

3

from the list Tn
the Interface "o

m n

V-

C7 R
O

Card scroll y 4 e

window. ‘5% 7 s
(e

¢ I you're using W,

a mouse, click on

the nume of your ()

interface card or click
on the scroll amows
until the name of
your interfuce card

is highlighted.

] { a0 1m0 [us] Jew] | att 1

nl

¢ If you're using
keyboard

conlrols, press the
Land T keysto
scroll the list until the
name of your
interface card is

-

fe

highlighted, highlighted,
[ Prister Salup

&) Inlerface tard

[psoa 11 eple 1 puraliel

[psaa Kt or RX Lrappler o -parallel

flar Keronles

Bhidaly 19219
Bridule 8 (It
Bhinah 42 (410

Erappler ¥ ~serinl or Mabterad
beroge inlerface, Erappler

0'd Crappler (before [314)
Fraclicu Peeistenals-parallel

-1

Pisler slot £12 04 860 bress dal wumerd

(0] tress ainio [Tl beess sy
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4. Chooss thes
number of the
expanslon slot
In which your
Interface card Is
Installed,

You'll only be

. allowed to choose

from those slots in
which printer
interface cards are
installed; otherwise,
the slot numbers will
be dimmed,

Choose a slot number
by clicking on the
number on the option
line if you're using a
mousc or by pressing
the O key and the
approprisle number
key simultancously if
iuu'rc using

cyboard controls,

This option allows

ou 10 use

ultiScribe with

more than one printer
and interface card
installed at the same
time. Foreximple,

ou could have a
rulu.-r quality printer
installed in one slot
and prin leiter quality
docunicis on it
using the lext orlim
on the Print dialo
box; ut the sumie ime,
you could print
ducuments with
fonts, sizes, and
styles using a dot-
matrix printer
installed in another
slot,

When you choose a
slot, you're assigning
to it the printer and
interfuce card selected
in the scroll

windows.

155 PRINTER SETUP

5. Click on
Store or press
Return.

Your settings are
stored on disk and
will remain in effect
until you change
them

Qlicking on Cancel or
pressing Esc cuncels
the Printer Seup
operabon and your
old setings remain in
ellect.
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Prnter Setup

Before you can print
a document, you
must tell MuluSonbe
what panter and
pranteranterface card
you'te uninge You
Jdo iy wath the
Iranioe Setup
cosunand on the @
NMenu,

1. Choose
Printer Satup
from the O
henu.

A dialog box
appears,

The Printer Setup
dialug box containg
scroll windows for
printer and interface
card selection, an
opuon line for
expansion slot
nuimtary, and buttons
for OK (10 store your
settings) and Cancel.

If you're using a
mutise, you can
move back and forth
between the sonoll
windows by simply
cliching inside the
scroll window you
w.nt (o activite. The
name of e seroll
window is
highlighted when ir's
acuve, h

IT you're using
keybourd
conlrols, you can
move between the
scroll windows with

the & and — keys.
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CLUBE

DOs Ap
CAXA s CMANIACO
 biogg sd AL 53434
2. Choose your 3. ChobdBliourse
printer from the Interface card
list In the from the list In
Printer scroll the Interface
window. Card scroll

o If you're using
2 mouse, click on
the numw of your

printer or click on the

scroll arrows until the
name of your printer
is highlighted.

o« [Ifyou're

using keyboard
conltrols, press the
Land T keysto
scroll the list undil the
name of your
interface card is
highlighted.

window.

« If you're using

a mouse, click on
the nume of your
interface card or click
on the scrull arrows
until the name of
your intertuce card

is highlighted.

o Il you're using
keyboard

conlrols, press the

L and T keysto
scroll the list until the
name of your
interface card is
highlighted,

Priater Selup

1=

[pson KX oe LX
fhr Keroles

thidate 132/191
Okidite 82 (L0
Ohinnty A1 L510)

a

e, kg

i oot | R ol
[psoa fX Rpple 11 purallel
Erappler ¢ -paraied

Eragpler § -serinl o bulfered
braage ielerfice, Crappler

01d Erappler (befora 1304)

| | Pracliead Pecigrenals-paratiel
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(I tress dilizo

Bt gt Q2148062
Pruss L5C)

Press O(slel ausber)
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4. Choose the
number of the
expanslon slot
In which your
Interface card I8
Installed.

You'll only be

allowed to choose

from those slots in
which printer
interface cards are
Installed; otherwise,
the slot numbers will
be dimmued.

Choose a slot number
by clicking on the
number on the option
line if you're using &
mouse or by pressing
the & key and the
appropriate number
key simultancously if
ou'Te using

Ecybuard controls.

This option allows

ou 10 use
KmlliScn'bc with
more than one printer
and interface card
installed at the same
time. For example,

ou could have a
elter (uality ponter
instulled 1n one slot
and print letter quality
docunients on it
using the text oplion
on the Print dialog
box; at the same ume,
you could print
ducuments with
fonts, sizes, and
slyles using a dot-
matrix printer
installed in another
slot,

When you choose a
slot, you're assigning
10 it the printer and
interfuce card selected
in the scroll

windows.

. 155 PRINTER SETUP

5. Click on
Store or press
Return.

Your seitings are
stored on disk

will remain in effect
until you change
them

Qlicking on Cancel or
pressing Esc cancels
the Printer Serup
opcration and your
old seitings remain in
elfect.
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2. Select the

files, one at a
time, that you
wint to print

together.

To select files:

o If you're using

u o, click on a
(ilenutie or soroll the
e 11,1 lw_\ chivking on
the saralh arraws until
the desiead Qlenarne
is Lty hied.

Click on the Select
betton or douhile click
i thie desired

L nwie,

¢ If sou're using
kub'- jrd controls,

u nd T keys
L N\l »H H.l(, Iile kur

untl e desired
filenane is
bl hied.

Preas the space bar,

The Select bution
changes to Deselect,
indicatng that the
currently selected
file will be
deselected if you
chck on the
SclecuDesclect
bution or press the
space bar, The
Selec/Deselect
button works as a
topple between
selecung and
deselecuny files.

As you select each
document, a number
appears to the left of
the filename. This
nuimbker represents
the arder i wiich
that document will
be ponied relative 1o
the other selected
files.
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To deselect files from
the print chain:

« If you're using
mouse, click on a
filename or scroll the
file list by clicking on
the scroll arrows until
the appropriate
filename 15
highlighted.

Click on the Deselect
button.

« If you're using

keyboard controls,
sc the L anl:! i
Lys 1o scrol

the file list until the

appropriate filename

is highlighted.

Press the space bar,

The filename is
deselected and the
remaining selected
files are renumbered
accordingly.

3. When you're
finished selecting
the files you want
to link for printing,
click on the OK
button or press
Return.

When you choose
OK, the Print Merge
operation continues
by displaying the
Print dialog box,
allowing you o
adjust the print
settings before
printing the
document. For
information on how
to select the seitings
on the Print dialog
box, see “Printing
The Current
Document."
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If you've not yet
specified your printer®
and interface card
with the Printer Setup
comrnand, the Printer
Setup dialog box will
appear before the
Print dialog box. For
an explinaton of
Printer Sewp, see
"Getting Ready To
Print."

Once you've selected
all the Print settings,
click on the Print
button or press
Retum,

A dialog box appears
to tell you that the
linked files are being
printed.

To cancel printing,
click on the Cancel
bution or press Esc.
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t Quitting MultiScribe — Choosa Quilt from , wefipfel
; : the Flle Menu. ' ___——J 2 |
When vou've finished . th Otherwise, & dialog box l
working on MuluSenbe, ggg&i:i:ﬁ;:ﬁm;gﬁl appears, asking if you want l ) !
youll u c(:jlht: Quit document, the screen clears 10 save your file before F — q %
Connend o exito d it I exits (o quitting. =
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o« If you choose Yes by F P 'q |
[} you want to enter clicking on Yes or pressing Tt |
L oot hitor, Chasose the Y, your changes are sav _J |
Lol itor command from amrmc program exits 10 F | 1
the = Menu. ProDOS. =y I
« If you choose No by o .l > - |
clicking on Noor pressing F: . | -
N, MultiScribe ex!1s 1o _J |
' ProDOS with your most . |
‘ recent changes unsaved. o= |
I « Ifyou chooséc Cancel ] Il
by clicking on Cancel of = e e o =
pressing Esc, the Quit r — TEml U | M 1 S b
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Bo you wish lo save your file hefore r] 1
: . fuilling? - E e I
. ‘
| [Ves_| press ¥ [Ganeel) ?ra%( ) D - }
\ Press | = T A
[ - B
i 55 - =
BP o fo=2 4 '
of = e |
| <" € |
q o & s :‘d |
_ s [ |
' 160 CHAPTER 3: USING MULTISCRIBE B oea |
r—1 - |
[

v ma——— & S e P15, T |} SO——-



TETR W e 4 e b e - Sl ted e $ 05 S n e o gy s o - s =

!
|

-
L ~
Contents 159, o T8 C Moy = <] The G Menu .|  The @ Menu contains miscellancous commands which perform
163  About MutiScriba u functions that don't fall under any of the other menu heading
163 Inven Screen L] 72 calegories.
164 Printer Setup...

Aboul MulliSeribe

]

166  Install Accessories..,
169  Run Accessories...
170  Font Editor

171 Tho Flle Manu

Mo oad

Invert Screen
Prinler Selup...
Install Accessories.. ; .

[N

171 Now Run Accessories...
172  Opon...
175 nge ; FonlEdilor l
147 '8 s .
180 Dirj:s | About MultlScribe When you select the About MultiScribe command, a dialog box |
i appears, telling you about the authors and revision number of the
183 Pa_ge Setup... — : M program, as well as the amount of unused memory available for the
186 Print... i AT ST current document. This amount is‘fn:scnlcd in K, which stands for
189 Prinl Merge... I l ! i kilobytes; it will decrease as your document grows.
1 Sale — :
1gg Oii?d L L 3 Inverl Sereen Click on OK or press Return to clear the dialog box from the screen. ‘
Prinler Selup... |
194, < Tha Ed“ Monu T Inslall fAccessories... For more information about memory and documents, see Appendix |
194 CUI = hm ﬂtt!isuril!... C. '.Mulﬁscn.bc FuleSk OTgﬂmmtan.“ v |
195 Pasta <2 FonlEdilor
196 Tha Saarch Menu T -
198. Find...
198  Replace l Invert Screen The Invert Screen command reverses the way things are displm t
5 Goto P " — __',‘., on the screen. When you sclect Invent Screen, what had been ‘
o GIETHEge # o [ A Fl on the screen appears light and what had been light appears dark, If
202 Tho Format hMonu ! fbout KulliSeribe your screen currently has dark characiers on a light back ground, it
202 Insort Ruler will be redrawn 1o show light charuciers on a dark background i
203 - Show Rulors/MHide Rulers o oy ——

203 Inson Pago Breaks restore the screen (o dark characters on a Light back ground.

204 Sat Page #...
205 Sot Hoader..,

TV

when you choose this conimund. Cliovsing lnven Sereen again will ‘

rinler Selup.., |_)
Install Accessories...,
Run Accessories... £
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This command lets you st up your MultiScribe disk to print
dﬁc:pmcms using the printer and printer interface card of your
choice.

When you choose the Printer Setup command, a dialog box appears
on the screen.

Printer Selup

[ 1 Interface Card
Lol e JRNE P o e

Epsen FY frole 1 parailel

Epscn IX or RX Grappler ¢ -parallel

Shar |oeronies Crapsler # -serial or buffered

Chifala 1927193 Granga inlerface, Grappler

LLEdzh 92 (I1Ti0 01 Grappler (hefore 1934)

Okidata 92 (S14) Practical Peripherals-paraltel i

Printer stob [ ]2 3 ¢ § 6 7 Press Aslol nucherd

Press (REWURD  [Tancel) Press (ESCH

T=
=

-1

The Printer Setup dialog box contiins scroll windows for choasing
printer and interface card, an option line for chuosing printer slot
number, and OK and Cancel buttons.

To move back and forth between scroll windows, use the & and

— keys or click on the scroll windows you want 1o activate. The
scroll window is activated when its name ("Printer” or "Interface
Cand") is highlighted. To scroll the lists in a scroll window, click

on the arrows on the scroll bar or press the T and L keys.

The Printer Slot option above the OK and Cance! buttons tells you
in which expansion slots of your App|czou have printer interface
cards installed and which slot is selected to print. The numbers of
slots in which printer cards are installed are displayed in nomal
video on your sereen; the numbers of slols without printee curds
gopear dimmed. 1f you have more than one expunsion slot
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with a printer card installed, you must select the slot from which
you want to print by clicking on the slot number or by pressing the
@ key simultancously with the slot number key. For example, if

you want to print using the card you have installed in slot 1, click on

the 1 on the option line or press G1L.

Once you've chosen the slot number for the interface card with

which you want Lo print, you'll assign a printer and interface card 1o
that slot number.

To choose a printer, click on the name of your_rrimcr on the listin
the Printer scrol! window, or scroll the list until the name of your
printer is highlighted.

To choose an interface card, click on the name of the interface card
in the scroll window or scroll the list until the name of the interface
card installed in the selected slot is highlighted.

Once you've selected a printer and interface card, press Reumn or

click on the OK button to slore your settings. When you choose the

Print command from the File Menu, MultiScribe will print your
document using the slot number and setup information you specify
with this command. The sctup values and slot number choice
remain in effect until you change them by selecting Printer Setup
again.

Clicking on the Cancel button or pressing Esc cancels the Printer
Setup command,
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The Install Accessories command allows you to install online
accessories which can be run directly from the MultiScribe O Menu,
thereby saving you the inconvenience of having to quit MultiScribe
and run un accessory program from ProDOS every time you want to
use an accessory. FontLditor is a pre-installed accessory, so you
don't need 1o install FontEditor with the Install Accessories command
(and you also can't use [nstall Accessories (o remove it ); FontEditor
always heads the accessory listing on the & Menu, You can install
an additional 15 accessories using the Install Accessories command.
There is only room for the first five instulled accessories o appear on
the O Menu below FontEditor, Additional installed accessorics can
1}:;: accessed by choosing the Run Accessory command from the G
cnu.

Insiall Accessories may be used at any time and is never dimmed.
When you choose Install Accessories a dialog box uppears.

lastall dceessories

[Fal /mLTIEGIREACOLS. 20IES ]
(brwe t ) ot [ caccomron P

T tLoce
[ T) et ] thiien punet

o
[N
COATROL PANEL

s

puaiLe [ ;or| uante
PCTULE MAREER mratl MCURE KENAGER
!nﬂ;ll l
1 ) h

Pross REMUEK)  [Cancel | Press 4650

The In:tall Accessories dinlog box contains an input bar for PATH,

scroll windows for file listings and for listing accessories, buttons for

gulh selection (Drive 1, Drive 2, Puih, List Vol.), and an Install
utton. 2

To move back and forth between the left and right scroll windows,
use thic & and — keys or click on the scroll window you want to
activate. A scroll window is activated when the first name in its list is
highlighted. To seroll the lists in the scroll windows, use the Tand d
keys or click on the scroll amows,
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The scroll window on the left contains a list of the accessory files
as well as any directorics found on the current path. If no path has
been selecled yet, a message instructing you to select Drive 1,
Drive 2, or another path appears in the scroll window. Click on
Drive 1 or Drive 2 or press Gl or (32 if the file from which you
want to install an accessory is contained in a disk in one of these
Arives: click on Path or press CP if you know the name of the
path on which the accessory is located or if the path isina volume
other than a disk in Drive 1 or Drive 2. When you click on the
Path bulton, ie insertion point appeirs in the PATH input bar,
allowing you 1o type in the desired pathname. Chicking on the OK
button or pressing Return creates a Lisung of files from the path

in the left scroll window.

If you don't know the name of the path on which the accessory
you want 1o use is Jocated, you can click on the List Vol. button
or press (3V to use the List Volumes commund to list all online
volumes in the left scroll window. You can then list all files and
directories on the appropriate volume (o find the pathname on
which the accessory you want [0 install is located. Volumes are
preceded by a slash (*7") and followed by the volume's slot and
drive number; directories are simply preceded by a slash .

If you type in the wrong pathname (oné¢ that does not exist or one
from a disk you are not currently using) a dialog box appears o
tell you the pathname can't bx found. A dialog box will also
appear if you select a drive that does not cuntain a disk.

Cannol find palhnamesfile name.

[COC) Press RETUEH

If either of these dialog boxes should appear, click on OK or press
Return 1o return 1o the Install Accessories dialog box.

When you select a path which contains no accessories, the message
"No accessories found, Try a different disk or path." appears in
the scroll window. Choose a different pathname or cancel the
Install Accessories operation.
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Once you've specified the pathname from which you wish to install an
accessory of accessorics, & listing of all the accessories contained on
that path appears in the right scroll window,

You sclect an accessory for installation br scrolling the left scroll
window until the desired accessory is highlighted. When the desired

accessory is highlighted, select that accessory for installadon:
« If you're using a mouse, click on the [nstall bunton.
« If you're using keyboard commands, press the space bar.

The first five accessories you install will appear below FontEditor
on the O Menu (for uccess w additional installed accessorics,
select Run Accessories from the G Menu).

To remove an accessory, scroll down the accessory listing in the right
seroll window untl the dccessory you want 1o reiiove appears
highliphted, I you're using a mouse you can also click on an
accessory's name (o seleet it for removal.

L]
When an accessory is selected for removal, the pathname of the
selected uscessory appears in the PATH input bar and the Install
bution is aulomatically converied lo Remove. Click on the
Remove button or press the space bar (0 remove an accessory.

An accessory which has been removed has not been deleted from its
path. Removing an accessory simply reverses the Install Accessories
command. This means you no longer have direct access to the
accessory from the & Menu; thus, when you choose the G Menu,

a removed accessory no longer appears in the accessory listing.
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The Run Accessorics command ives you access to all of the
accessories you have installed usﬁ\g the Install Accessoncs command.
While the Install Accessories command allows you to install up 1o } 5
accessories at one time, only the first {ive accessorics you install will
actually appear on the G Menu. You must choose Run Accessories 1o

get access Lo your addidonal installed accessories.

Run Accessorics is never dimmed and can be used at any time. When

i
you choose Run Accessories a dialog box appedrs. ‘I
s 1
Run Accessories o, 5

(? ]

CORTROL.PAIEL 1) [fun_| Pres ‘%ito“m l|

] 4',-1-. . ] @%4% \s\ | '

PULLLE ey ’% i
PICIURE.KARAGER %A@, (c",-,, !
SPELL.CHECKER 1 3 i

) Press (ESC) 5 ov{?,v% !

~ (g Ly

The Run Accessories dialog box contains a scroll window and Heuons OJ\

for Run and Cancel.

When you choose the Run Accessories command, a listing of installed
accessories appears in the scroll window. 1f you have not installed any
accessorics, the message 'No accessories installed. Use “Install
Accessories” before running.” appears in the scroll window,

To run an accessory:

o If you're using a8 mouse, double click on the desired accessory
OR scroll the accessory List by using the mouse Lo press the
scroll arrows until the desired accessory is highlighted and click
on the Run button,

e If you're using keyboard commands, scroil the accessory list
with the L and T keys until the desired accessory is highlighted
und press Reurn,

Click on Cancel or press Esc to cancel the Run Accessory command.
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Pl r File Menu contains commands for managing and maintaining
FontEditor FontEditor is an application which runs under MultiScribe that ;- Flla Menu grgun':ms.
allows you (o create new fonts and edit existing ones. Fora . . 4 | ; :
@) complete description of FontEditor and instructions on using it, see F =— 3 en The name of the document you're working on is displayed above ~
Aout MulliSeribe Chapter 5, "Learning FontEditor", Chapter 6, “Using FontEditor", the commands on the File Menu. If you haven't given your
and Chapter 7, "FontEditor Reference. : :;:n_ :: ; document a name, the word "Untitled" appears there insiead.
Invert Screen F ] 72 fin [}
Printer Selup .. I I :IH b ﬁ:
Install Recessorie =2l Be s
Run ccesscr.ss... (?“ B e o Prinl. o
% d o L] Rt o P
g Bcl Hew roals.
t BRI RS F =3 bl a |
‘U‘v'?) o 1 ] Neow The New command clears the document window and creates a new,
To U ; Y empty document. 3 y
% e % IR0 Unless you choose New immediately after starting up MultiScribe or
G 5 e — afier choosing New, a dialog box appears, asking if you want 1o save
P 7 2 ! & e g g
N o g R the changes you've made o your current document before creating a
% D i fin 08 new one,
iy :m 15.. 2:
= el .
- T SAYE changes before opening
Prinl. :
[ _] il . 1 neu file?
Stleel New Fouls
il i [Yes | Press ¥ Press (ESC)

Press

If you choose Yes by clicking on the Yes button or pressing Y, a
copy of the current document is saved, replacing the old copy of the
document on disk. If the document has not been saved before,
you'll be asked for the pathname and filename under which o save
it

I

If you choose No, the document is closed with your most recent
changes unsaved, the document window is clearcd, and a new,
empty document appeirs on the screen.

E

If you choose Cancel, the command is canceled and your old
document remains open. .
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Open The Open command reads a document from disk and displays it in ' & The buttons for sclecting path — the Drive 1, Drive 2, Path, and
the document window on the screen, List Vol. buttons - allow you to specify the path from which you
! v ; want to open documents. If you haven't specified a pathname since
N The Open command may be used at any time. If you're working & ~ starting up MultiScribe -- if you haven't performed any Save or
33 with a document with unsaved changes when you choose the Open n operations -- the Open button will be dimmed and the scroll
Fra command, a dialog box appears, asking if you want to save the . window will contain a message asking you o select a drive or
e chunges you've made to your current documnent before opening P specify a path name. Before you selecta document to open you'll
e 3. AABLICEONG: want (o be sure that you've chosen the correct path from which o
el ¢ A ; open your document files, :
Fiie Selupe. |k : S e
bl ar i A path is either a volume -- a disk drive like drive | or drive 2 ora
Pl & . ; ik iennes b”n?l I:PENHQ hupd disk -- or a volume and subdirectorics. Lf you want 1o apen a
boecl Kl HAEVETIRS ; 'q document file on the disk in drive 1 or drive 2, just click on the
) $] Yes | Press ¥ Cancel | Press (ESC) Drive 1 or Drive 2 button or press G1 or (2. If you want to open
2 Y, 9 e a file on a hard disk or on a subdirectory of a volume and you know
'/i; W L__iiu__ Press N & ':" the pathname for the path where the dgumcnt file is lo':alf:d,click
0B % ¢ on the PATH input bur or Path bution, or press OP, and enter the
k) 'J",V '?’((, = pathname from which you want toread a file. You can enter a
'270((@ %, lfrg:}cl)u cl'hoos:: Yes, lgf: s«:;x‘{mnt i? saved, replacing the last version L - pathiname with tlenzit of up a0 chariciers,
g ~ = . . .
@ () ¢;J’ ghﬂnf;éstrl::nt}fnns!aggd.“lf }ou zg;ucséogrng?&zuéxséoﬁcwm‘;m " When you've chosen a path, all the c{lmciqncs and MuluScribe
% TQ) canceled and you're returned 1o your old document; otherwise B, - document files on that path are displayed in the scroll window, and
. other dialog box appears ; ; o = the tott) amount of memory space left on the volume on which the
- : current path is located is displayed in K (for kilobytes) in the upper
— right comer of the Open dialog box. Directories are differentated
T AT B E from other types of files by beirg preceded by a slash,
[FRTH aLUTIECR 3E Y ] - . If you want to open a document but can't remember the path on
EE R Y s @ [ j which it's stored, click on List Vol. or press GV to list all online
“eounadFLA [t volumes in the scroll window. Volumes are distinguished from
_rlis_l__‘ Press dt

document files by being preceded by a slash (*/) and followed by
the volume's slot and dave number. Directoyies are also preceded
br a slash but are not followed by slot and drive numbers. To list
all the files on a volume or directory, select the volume or directo
by scmllin‘;l’i the scroll window until the desired subdirectory name 13
highlighte

(LI K £
£ Sty [Crn) press o
U T

1L, BATA ﬁ"l_l“_ll_'_ﬂ_“_'_
HELIY LD (Loven | Press (eTutn

lveriney 7] [Cancel | Prass (EscH

m
L)

re

The Open dialog box contains an input bar for path, a scroll
window, buttnns for selecting path (Drive 1, Drive 2, Path, List
Vol.), and buttons for Open and Cancel.
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Open the volume or directory by double clicking on the sclected
volume or directory name or clicking on the Open button if you're

using a mouse, or by pressing the the Retum key if you're using
keyboard controls, All the MuldScribe document files on that volume
or directory ure displayed in the scroll window, and the total amount

of rmemory space left on the volume on which the current path is located
is despluyed in K (for kiloby tes) in the upper right corner of the Open
dialog box, ‘The scroll window cun display the names of up 1o 8
documents. To seroll the list of documents:

« If you're using a mouse, position the pointer on either the
up or down arrows on the scroll bar, press the mouse button,
and hold it down. “The names of the documents on the current
path will be serolled either down or up until you release the .
mouse button or reach the bottem or top of the list.

« If you're using keyboard controls, press the T and

L Leys 1o seroll the document list, The names of the
documents on the current paths will be scrolled down or up
unnl you reach the bottom or top of the list.

To open a document:

« If you're using a mouse, double click on the document you

Wikl o open

- OR -~
first select the document you want to open by clicking on the
document filename or by scrolling the document list until the
document appears highlighted; then click on the Open button.

o If you're using heyboard controls, scroll the document list
untl the name of the document you want to open is hiphlighted.
Open the document by pressing Retum.

The document you selected will be read from disk into memory and
displayed in the document window on the screen,
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The Save command saves a copy of the current document 1o disk.

Save may be used at any time and never appears dimmed. 1f you're

saving an untitled document or a newly-opened ASCII text document, -

a dialog box appears, asking you 1o name the document. (See

"Save As" for an explanation of this dialog box.) If you give the
document the name of a document already stored on'the disk, a dialog
box appears, asking if you want the document you're saving to replace
the document of the same name on the disk,

Replace exisling “"Report.May.86"1

o
Yes | Press ¥ Press ¢ ﬁ?«

) q)
[ Ko Press 0;26;_,, o

hAK
If you choose Yes, the document is saved under the name you'g e ‘2’,
specify. If you choose No, you're returned 1o the previous dialo¢.. %

entire Save operation is canceled, (118

v, V7,
box to give the document another name. If you choose Cancel, he, & ¢-’¢
(3)
)

Once you've named and saved the document, it's saved on disk and

its name will appear in the scroll window when you sel
command. i en you select the Open

If you've just opened the file and it was last saved to disk as a
MuliiScribe file or Old MultiScribe file, it will be saved as a
MuliiScribe file. If you'vc|jus| opened the file and it was last saved
to disk as an ASCIltext file, the Save As dialog box appears, with
the pathname of the path from which the file was read in the PATH
input bar and no name in the NAME input bar. You can give the file
a rlu:w_ lll\):numc; and 's:wcl it as a MultiScribe file (the default

sclection) or give it its old name and save it apai is

P v nfc. L again to disk as an
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Once you've opened or created a file and saved it, the next time you
save that file it will be saved with the same name and file format, and
MuluScribe will display a dialog box telling you the name of the
document being saved as well as the file forma -- MultiSeribe file,
ASCIL text file, or Old MuliiScribe file (for users who created
MuluSenbe files with versions of MultiScribe prior (o version 2.0) --
under which the documicat is being saved. (For more information on

file formus used by MulnSeribe 10 save files and how you can specify
a tile forrmat other than MuhiScnbe file for your document, see the next

command discussed in this chapter, "Save As.")

Hou saving “JEH0"
s HulliSeribe file,

For ex.ample, if you opened a MultiSeribe file and saved it as an
ASClliext file and then saved the file again immediately afierward it
would be saved as an ASCII text file without the Save As dfglog box
appearing. ‘e

2

'J-ﬂ‘
Hou saving “I1Z10" 1%; T
as NSCIN fext file, e | I
'Véj'ﬂ

|

!

——g‘ :
WL
Use the Save commaund when you want 1o update an existing B
document on disk, o

Use Save As when you want (o:

*  save a changed document to a new file name while retaining
the old version of the document under its existing name;

* make a backup or copy of an existing document with a
ditferent path or document name from the original,

e save a document with a different file format.
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The Save As command allows you to save a document under a
different filename, and/or a different pathname, and/or a different
file format.

As with Save, the Save As command may be used at any ime and
never appears dimmed on the File Menu.

When you sclect the Save As command, a dialog box appears.

23X free on vol.
[PATIE ZLTISCRISEY |
{12 1o I Press 61
S| Press RETUZID [brive 2 | Press 2
[Cancel | press (escy [ _Palb_) Press 6P

O LulliSeribe file  ORSCIN Text oOCId MulliScribe file

Save fs

&

The Save As dialog box contains input bars tor PATH and
document NAME, buttons for path selection (Drive 1, Drive 2,
Path), butions for Save and Cancel, and file format option settings
for saving your document as o MultiScribe file, ASCIl text file, or
Old MulnScribe file.

The PATH input bar contains the name of the current path, the last
path from which a document was opened or 1o which a document
was saved. 10 no path has been specified, the PATH input bar is
empty and the Suve bullon is dimmed. To specify a disk in Drive 1
or Drive 2 as the path, chouse Drive 1 or Dnve 2. The name of the
Eath associated with the disk in the drive you specify appears in the

ATH input bar. To specify a path not on a disk in drives 1 or 2
(such as a hard drive volume or subdirectory) or a sutdirectory of a
volume on drives 1 or 2, choose Path, Thie wnsertion POINL moves
from the NAME input bar to the PATH input bar, where you ¢an
type in the nume ol the path of your choice. NOTLE: T/e pathname
you specify must already exvist; otherwise, MultiScribe will displuy a
dialog box telling you that the path could not be found.
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To create paths, volumes, and dimcwries.d\:ou must do so fron® Ty
BASIC, with the ProDOS Filer udlity on the ProDOS User's Digh;?,
or with some other disk utilities program, such as Copy Il Plus. % &
<
<

Once you've specified the path 1o which you want to save your
document, the amount of space left on the volume on which that pa
exsts appears in K (for kilobytes) in the upper right comer of the
Save As dialog box.

If you're saving an untitled document, the NAME input bar is cmpty.

If you re saving a document that has already been named and saved on

disk, the NAME input bar contains the current document name.
The cursor appears at the end of the document niime.

To move the cursor back and forth between the PATH and NAME
input bars und the line of option settings for file format:

o If you're using a mouse, click on the input bar you
wish to edil or on the option you wish Lo set.

« If you're using keyboard controls, usc the T and |

keys to move the cursor back and forth between input bars
and the line of file format options.

If you want to save the document under a different name, enter a
new document nime in the NAME input bar. See Appendix H,

“ProDOS Filenames and Puthnames," for informition regarding

rules for naming docurnents.

The Save As command lets you save documents under three
ditterent tile formats: MultSeribe file, ASCII Text, and Old
AMuluScribe lile. The format you'll use most ofien is MultiScribe
file, which is any tile you create with MuliScribe version 2.0 or
_preater. Old MuliSenbe file is a setting to allow you to save files 10
work with versions of MuluScribe prior (0 2.0; you'll probably use
this setting only on very rire occasions,

The other sctting, ASCH Text, allows you to save a MultiScribe
docunent as an ASCI ext [ile, which may then be used with other
ProDOS word processing propgrams, such as AppleWorks.™ When
you save a MultiScribe chunwnt as un ASCIlLiext file, you save the
text of your docunient only -- without MultiScribe fonts, styles,
sizcs, or speciul formatiing.
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Be careful not to save 8 document as an ASCII text file if you want
1o retain fonts, styles, or sizes of characters in the document.

To choose a different file format:
« If you're using a mouse, click on the circle in front of the
option you wish 1o set.
« I you're using keyboard controls, usc the | key to move the
cursor down to the line of file format options. Use the

and — keys 1o move the cursor from option 1o option; select
an option by pressing the space bar.

When the input bars contain the document name and pathname
under which you want the document saved and you've selected the
appropriate file fonmat, click on the Save button or press Retum,
The document is saved to disk with the specificd pathname,
filename, and file format.
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The Delete command allows you to remove unwanted files from
your disk. With Delete you can remove more than one file at a time,

and you can remove files of various file types, not just MuldScribe
document files.

The Delete command may be used at any time and is never dimmed.
When you choose Delete a dialog box appears,

Delele Files UL free an vol

[Fitd _nesteses ]
= s e ) s al
Lo coarlid WF R
LENER S f | | Bt ] peess ot
rirsy WF (R reess or
Eﬁl Vol.| Press &Y

HTE AN WPF
PRICL.CEATh WwF
PRRIY LELTEND  WPF

INVEAICEY Wi | Press (SHALE)
Prass (REIULN) Press (E50)

The Delete dialog box contains an input bar for PATH, a scroll
window, buttons for path selection (Drive 1, Drive 2, Path, List
Vol.), and a Select button.

IFa path has been selected, the amount of space (in K, for kilobytes)
lefton the current volume appears in the upper right comer of the
Delere dudog box and the seroll window containg a list of the files
found on the current path, If no path has been selected yet, a
messae inatructng you to select Drive 1, Drive 2, or another path
appears in the scroll window. Click on Drive 1 or Drive 2 or press
Lor G2 if the files you want to delete are contained in a disk in

one of these drives; click on Path or press OP if the files you want
to delete are on a volume other than a disk in drive 1 or drive 2 and
{uu know the pathname for that volume, When you click on the
“uth buton, the insertion point appewrs in the PATI input box,
allowang you o type i the desired pathiame, Clicking on the OK
buttan or pressing Returm creates a Iisllng of files from the path in
the seeoll window and displays the amount of space lefi on the
cument volume in the upper right corner of the dialog box,
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If you're not certain on which volume or path your files are located,
you can click on the List Vol. button or press GV 1o use the List
Volumes command to list all online volumes in the scroll window.,
You can then list all files and directories on the appropriate volume to
find the pathname on which the files you want to delete are Iocaicq.
Volumes are preceded by a slash (/") and followed by the volume's
slot and drive number; directories are simply preceded by a slash .

If you type in the wrong pathname (one that doesn't exist or one from
a disk you are not curreridly using), a dialog box appears 10 1¢ell you
the pal{mumc cant be found. A diwog box will also appear if you
celect a drive that does not contain a disk,

Cannol find pathnacesfile mace Q(’&@[
o, IS
[COK_) Press (RETURK) %2255 4 o B,
= =} %51, 8y,

se dialog i . 3.
If either of these dialog boxes should appear, click on OK or pmﬂq(/{ 4014’/‘4 :

Retum to return to the Delete dialog box.

Se
When you select a path which contains no files, the message "No files
found. Try a different disk or path." appears in the scroll window.
Choose a different pathname or cancel the Delete operation,

Once you've specificd the pathname from which you wish to delete
files, all the ﬁ{cs on that path == including fonts, program files, and
MultiScribe text files -- appear in the scroll window. Some files
== ProDOS and the font files and MultiScribe program files on your
rogram disk, for example - appear dunmed; these files are necessary
or nunning MuliSeribe and cunnot be deleted. ‘The files which do not
appear dimmed are those available for deletion, Directories, if any
exist, are preceded by a slash (/") and cannot be selected for deletion,
although they are not diimmed; rather, when you select a directory, all
the gulcs und subdirectories on that directory are listed in the scroll
window.

You select a fle for deletion by scrolling the seroll window list until
the desired filename is highlighted. If you have a mouse, you can Just
double click on the desired filename or scroll the file list by using the
mouse 1o press the the scroll arrows undil the desired filename is
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highlighted. If you're using keyboard controls, you can scroll the file
list with the L and T keys until the desired filename is highlighted.
When a file is highlighted, you can select that file for deletion by several
meins, If rou'n: using a mouse, you can click on the Select button
while the destred name is highlighted. If you're using keyboard
comnuinds, press the space bar while the desired filename is highlighted.
An wrrow appears 1o the left of a selected file,

i WY s a
e | | e
LETE 15 ol B TR T

Rafrsnar  wr | | [P0 press g
ST T T B

Blh i e adt [List Vol ] press v

BT

G0t () press st

Desclecting files is uccomplished in a manner very similar 1o selection,
If you're using a mouse, double-click on a selected filename to deselect
that file, or scroll down the list of filenames until the file you choose 1o
deselect is highlighted and then click on the Deselect bution. If you're
using keybuird controls, seroll the list of filenames to highlight the:
selected filename you wish w deselect and then press the space bar.
When the armow w the leftof the file name disappears, the file has been
deselected and is no longer included in the group 1o be deleted.

Ot e | rh-] Press Al
SRTOHTTT IV BT Wiy

(s [ (bt T press ot

wairgir e | [P ) press op
B N (i i | | — =

e pn o | |t e or
IUETREHC I

RO Press (SPACE)

You cannot combine selections of files from different paths for deleti
Each different puth requires a sepurate exceution of the Delete comma
ICyou atcnpt o delete files from more than one path simultancously,

the files chosen from the first pathy will automatically be deselected and

only those sclected from the second path will be deleted,
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The Page Setup command allows you to specify page formatting settings
prior to printing. With Page Setup you can choose four standard
paper lengths, specify your own nonstandard paper length, "

and specify top and bottom margins and the depth of page indentation
(for centering print on wide carmage prinier paper).

- Page Setup may be used at any time and is never dimmed on the File

Menu, which means you cian change the page format of a cuerlctqd
document or one in progress, or specify page fonmating specifications
before creating a document.

When you choose the Page Serup command, a dialog box appears.

Paaa Selup

Paper:  ©US leller ONd leller
OUS leqal olInternational Fanfold

Page |engih=[E| Top legim Bolton }‘hrginﬂg
Page imfenl=
Press (RETIRH)

Press (ESC)

The Page Scrup dialog box contains option settings for four standard
p:l.lacr sizes - US letter (8 12" x11"), US legal (8 172" x 14%),

Ad letter (8 172" x 11-2/3"), and Intermational Fanfold

(8 1/4" x 12"). There are also input burs for Page length, Top Margin,
Bottom Margin, and Page Indent, as well as butions for OK and Cancel.

. The Page Sctup dialog box initially appears with the US letter option
setting selected. Tn accordance, the Page Length is set at 11", the top
margin is set as .33", the bottom margin is set at 1.5%, and the Page
Indent as .25." 1If you desire a standand page formuat other than US
letter, you can select one of the other three options setungs:

o If you're using a mouse, click on the option setting in
front of the paper size you want.
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al

o ;
¢ 1f you're using keyboard controls, usc the T and | keys o 2 3
move from option line to option line and the  and — or Tab .
b iy iy p 3 The page wil be oo seall, Please relry.
and GTab to move between option settings. Press the space o ;
bar to select an option. o
=
Selecting a standard format option other than US leiter automatically e 3 ¥ ,&"\ Press (RETURHY
changes lth;uL;c lengih in the input bar to the length associated with ,‘g)ﬂ‘ o
hat standard, - AR
AL i | & b‘i}‘@ dialog box appears, click on the OK button or press Retum to
To specily a page length other than oue of the four standard options, v (R rétm to the Page Setp dialog box.
enter a page lenpth vidue in the Page length input bar. If you're using a ] A

A

S 4 F g e A ; :
mause, just click on the input bar and enter the desired page length G bhlf no other value is specificed, the Page Indent input bar automatically
value, Il you're using keyboard controls, press the 4 key twice 10

move the inseition point into the page length input bar and enter a new
page leigih vilue,

< s displays the default value, .25 inches, It is important to note that the
o &\ Page Indent does not create a margin. Changing the dimensions of the
&> Page Indent will not change the wiy your document is diS{ﬂuycd on
q‘h our screen, as changing the right and left margins does. This is because
%Q. Page Indent is used (Lur printing only and is used prinurily for centering

Y

Tospecify 1op and bonom margins, enter the desired values in the

Selgt : ; : - - MuliiScribe documents on wide cariage printzr puper. While the
appropote mput bars, 1f you e using a mouse, just click on the input o default 25 inchies centers your text for printing on 8 12" paper, you
barand enter the desired margin vadue. If you're using keyboard €an position your text in different plices on your printout by adjusting
contuls, press the 4 key twice 10 move the insertion point to the input & mﬁ ’a'gc '”(tI]C“L You “!U;l bclcarcg}llhno;éo SCII';"IJ;‘ 0o hlﬁh; number,

Al . ! o Ough, or the printer might print off the edge of the page. ou can
buar option line and the — key 10 move the Insertion point into the = R 2 B £ Rk

S . : : = : : select a Page Indent up 10 12 inches,
appropriate input bar; once the insertion point Is positioned in the input

bar, enter a new margin value at the insertion point.

L

The dimensions of the page length and the two margins are governed by
whatis called page content. The pn§c coritent length restrictions are a

] jun| |an) [us| [wn) |a) |os] [an) |se][ea] s

i of 14 and a minimum of 3" for actual text, so the page 3
length value you enter in the input bar can be no less than 3* and no

greater than 4% “Ihe sizes you specify for top and bottom margins

mustcombianed teserve at leist 3" for text on the page. For exanple, [
you could entera 14" page lenpith with a top margin of 7' and a bottom e

marn of 3" because three inclies would still be reserved for text, If
cither margin were increased, however, either e page length or one of
the margin values would be rejected, depending on which value exceeds
the page content limit,

ICyou auempt o specify a page content area less than 3" or greater than
LY adiadog box appears (o tell you that the page will content will be
100 sl w print.
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o

« If you're using a mouse, click on the setting in front of the
print mode you want.

o If you're using keyboard controls, use the —+ and
& keys or Tab and (3Tab to move 1o the print quality mode
you want. As you move the arrow keys, the sctting in front

of the currently selected option will flash. When the print
niwde you want is flashing, press the space bar.

¢ If you're using keyboard controls, use the T and |
keys 1o move from option line to option line and the = and ¢

keys or Tab and GTab to move among settings. When a setting E
is activated, it Mashes. Press the space bar to choose the setting,

won

When a setting is chosen, a “o" appears in the setting circle.

L
LSRR,
- . u Q .
Print The Print command prints a copy of the current document according L= The second line lets you choose the print quality you want for your
ey 1o your specifications. L] document. The NLQ! and NLQ2 settings will give your nglcd "
i i i i . : ocument maximum detail, For greatest resolution, use wi
i Print may be used at any time and is never dimmed on the File =1 ?hmu[oms such as Hemingway and Milton. Thicker fonts such as
iy ol Menu, D Chaucer or Shakespeare are best pn'r;lcd in NLQ2. Duc tollihc}::pcnl
tita 4) . ; A ’ ! ] . f detail, NLQ1 and NLQ?2 take the longest ime o print. High1s
o 08 You won't be allowed 1o print unul_tyou ve specified which printer o= ?hc rcxcl:ixt dcgr?c of quality and prints documents with high ‘
S ds. and interface card you're using, so if you've never used Printer resolution, 1t takes slightly less ime than NLQ1 or NLQ?2 to print.
AT ) Setup 1o 1ell MultiScribe which printer and interface card you have Srandard is the next highest quality prnt; itis a fine quality print
Pk Eo, installed, the Printer Setup box appears when you choose Print. Set F e q moxle for most of your printing needs and prints a page of textin
o . the Printer Setup specifications so thut MultiScribe will print ° about 273 the time of High quality. Druft is a lower quulity mode
;*_‘-r-fl-l":»-r-ml” gqrrcmlx with your hardware. For an“cxplananon of the Printer D whicl prints a light draft copy of your document; it prints slighily
L ol MiLdialop box, seeclrinicr Senup: o oma q faster than Standard.
When you choose the Print command, a dialog box appears. [—] Unlike the other five print modes, Text mode does not print
F : MultiSeribe docunents as they appear on the screen; rather, Text,
Prinl o prints docuinents with your printer's charcter set and does not print
Iersewifer Super serial or Apgle e port U different fonts, sizes, or styles. It is by Lur Uul: fnstfsl:)pnpr:[modn
stlily ' however, s it uses your printer's own character set 1o pnnt.
. ﬂu!nlr OHLLI OKHLE2 O High eﬂmda‘rd obrafl 0Text OPreviev = — 3 N atns o zccd P hatiSertbs dbdtment wilva
|| Co "SD Paper feed: @ CLonlinuus — OCul Sheel U Jetter quality printer or with a special print mode on your priner,
,Cﬁ:;r) Pés\ range oAl ofrox [ |To[] : e = select this print quality setting.
N @(y{ t""': ) press @enen  [funed ] ress @50 J £ The Sl tmrcn, Precev, Liswd i b visw v duieee o
A> P @ J it the screen as it wall acrually appear on a printed page without
0'\{\ av F sy '3 actually printing il This means you ean see featues aich as
I ,;)\b The Pantdialog box contains opuon lines with setings for print quality, headers and footers which are hidden frum view while a document
B, W PR number of copies, paper feed, and page range. To schicct sciings: ! is in progress.
» : ; 0l C__Tee ] X .
._)W\ ¢ Il you're using u mouse, click on the seting in front of each E i £ To choose print quality;
oy oplion you wunt. ; [ -]

The names of the Printer and Printer interface card you've chosen in the

t;Pg'mcr Setup command are displayed on the top line of the Print dialog When you choose o print quul{iﬁ modc, the setting in {ront of the
)9

print mode you select is mirked.

186 CHAPTER 4: MULTISCRIBE REFERENCE
187 PRINT

mowom
el

¥ L Ik wu W Ix

7




To choose the number of copies you want to print, click on the
Copies input bar or press the T and | keys until the insertion

point appears in the input bar. The preset value is |. To enter a new
value, use the Delete key 10 delete the old value and type in the
numbcr of copies you want (o print.

The Puper feed option allows you to print continuous copies, as
with iructor feed on your printer, or cut sheet copies, as with a sheet
feeder. I you choose Continuous, the entire document is printed at
One thine, with page feeds done amomatically. If you choose Cut
Sheet, one sheet is printed at a time; afier each page is printed, a
dialoy box appears, prompling you 1o insert the next sheet of paper.

The Pape Range option allows you 1o specify a range of pages 1o
{mm. I you choose ALL, all the pages in the document are printed.
L you choose specify a range of pages, choose the option setting
introntof From, “The input bars are activated. Enter numbers for

the firstand last pages.

Once you've specified the seitings you want, click on the Print
bulion or press Ketum,

Pressing the Cuncel bution or pressing Esc cancels the Pring
operation.
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Print Merge

m
4, )]
New on
Open... a)
Sive [}
Save ds.. [
Delele_, ap
Page Selup..
Pr‘ifl.‘_l QP
Seieel hew Foalis ]
fuil al
54
<
673 %
0,0‘ 044, 06‘
.47‘ q"b -
G
0.0

Print Karge
[PATH: /LILTISCRIGE? =
114 A : }Prl:i ol
2 BSEESSPUN  WF | | 1y 0] press a2
LETTERKS o | [ e 2] press
A5, EELsiy e | | [P ] press o
Q& llE. U [0StV ) press oy
“ .s;,% i i | LR
v/ TE
%o %3, AN PIINEEKED Wb
sgol| [y ur if (] press cnuee

The Print Merge command allows you 10 link MultiScribe document
files (WPF files) and print the files as one long document,

Print Merge may be used at any time and is never dimmed.

If you've made unsaved changes to your document, a dialog box
appears when you choose Print Merge, asking if you want (o save
the current version of your document before proceeding with the
Print Merge operation. Otherwise, when you sclect the Print Merge
commund, this dialog box appeurs.

[0 Press GeTuany Press (ESC)

The Print Merge dialog box contains an input bar for PATI, a scroll
window, buttons for path selection (Diive 1, Drive 2, Puth, List
Vol.), and a Selecy/Deselect button for selecting == and deselecting

== files to be linked for printing,

The scroll window contains a list of all files in the current path
(unless no path has been selected yet, in which case it contains a
m.:ssnlic instructing you to select a path). Select the files, one at a
time, that you want 1o link together for printing. To select a file,
first click on the filename or scroll the hist unal the name of the file
you want to select is highliphted: then click on the Seleet button or
rruss the spuce bar, As you select ench file, a numher ug\fw.lrs o the
cft of the file, telling you the order in which cach file will be printed
(the file with 1 beside it will be printed first, the file with 2 beside it
will be printed second, etc.).
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To desclect files from the print chain, first select the file you want to
remove from the print chain by clickin[; on it or scrolling the list
until it's highlighted. When a previously selected file is highlighted
the Select bution automatically switches to Deselect. Click on the
Desclect bution or press the space bar. The filename will be
desclected -- a file s deselected when the number o its left
disappears == and the remaining selected files will be renumbered
aovandingly. For example, if you had File.A selected as the first file
1o be printed, File.8 as the second, and File.C as the third and then
deselected Fife 8, File C would become the second file in the print
chuin and the number beside it would be changed from 3 1o 2.

The Select New Fonts command expands the selection of fonts
aviuluble for creating a document by letting you choose an allernative

‘2l

ii

7] jus| [am] | o jan] jan] {an] jon | e} | we | wai <

sclecuon of 1 1o 16 fonts from another path, -
The Select New Fonts command may be used at any time and is never
dimmed. When you choose Select New Fonts, a dialog box appears. =
Seleel New Fonls = =
o -
[FaTh: /1SLTISCRICES ] =
=) HELLTEM *!__‘J [ ] Press dl o = W
o || [Drive 2 | Press 42 ’494\
) bbb ] ==y ..
=) KERE TLIN { [_Falh_] Press 6P ¢, O . .
1 \ q 15 4/4, \s‘ w e
-) LT S| [List Vol ] press oy % W o I8,
) DLITE g = v oY
I A ‘5\4 y
=) ASIEY 1 0,‘% i/t ) 4
-) CHAUCER (. Press (SPACE) / O‘@, 400
Ay
o
[0 ) press REnuh)  [“Cancel | Press (ESC) = D 4
: ; E mve
The Select New Fonts dialog box contains an input bar for PATH, a “
scroll winduw, buttons for path selection (Drive |,Drive 2, path, List D
Vol.) and » SelecyDeselect button for selecting and deselecting fonts, E ..
.l
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The scroll window contains a list of the fonts, along with their font
numbers, as well as any directorics found on the current path. If no path
has been selected yet, a message instructing you to select Drive 1, Drive 2,
or another path appears in the scroll window. Click on Drive | or Drive 2
or press G1 or G2 if the fonts you want to install are contained on a disk
in one of these drives; click on Puth or press OP if you know the name of
the path on which the fonts you want 1o use are located or if the puth isin a
volume other than a disk in Drve 1 or Drve 2. When you click on the Path
button, the insention point appeurs in the PATH input bur, allowing you to
type in the desired pathname. Clicking on the OK bution or pressing
Return creates a list of fonts from the specified path in the scroll window.

If you don't know the name of the path on which the fonts you want o use
are located, you can click on the List Vol. button or press oV 1o use the
List Volumes command to list all online volunies in the scrull window:,
You can then Listall foms and dircctonies on the appropriate volume to find
the pathname on which the fonts you want 1o install wre lovated. Volumes
are preceded by a slash (*/*) and followed by the volume's slot and drive
nuimnber;, directories are simply preceded by a slash

Once you've sclected a path and a font list appears in the scroll window,
select fonts one at a time by scrolling the list until the desired fonuname is
hi;;hlightcd. When a fontname is highlighted, it can be selected. To select
a tont: g

o If you're using a mouse, double click on the highlighted fontname
OR click on the Select button while the desired name is highlighted.

o If you're using keyboard commands, press the space bar,
An arrow appears to the left of a selected font.

To deselect a font, scroll down the list of fontnames until the font you
choose to deselect is highlighted. When a previously selected font is
highlighted the Select button automatically switches 1o Deselect. Click on
the Deselect button or press the space bar. The font is deselected and the
arrow 10 the lefi of the fontname disappears,

You can create a new set of fonts containing up 1o 16 fonts from a sinple
ath. You cun't create a new set of fonts by cumbining selections of fonts
rom different paths. Selecting fonts from a path automatically deselects all

fonts chosen in a previous anE.
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The font number of a font is indicated 1o the right of the font when it
appears in the seroll window,

Those fonts which were selected when you chose Sclect New Fonts and
which also appear on the pew Path appear selected, with an arrow to the left
of the fontname,

If you're editing a document when you choose Select New Fonts, those
fonts you were using to create the document which are also on the new path
appear stalicized in the seroll window, so you can recreate your original
doswirent exuctly, |f youdo not select a font which his been used in
Greanng the document, it wil :mlom:uicnlly be repluced throughout the
docunicnt with the lowest numbered fom from the new seq of sclected fons,
Fonts are provided by StyleWure with a unique numbser from | o 200.

Asimnilar siwation arises if you open a document created with a different
font setand cloose the Seleet New Fons command. The fonts contained
in the cument font ser dppearon the list in the scroll window as selecied
[onts, an wrrow Appears w the left of each fon( o indicate that it jg selected.
Any fonts on e current path used in the creation of the document appear
aliciced, to lg You know which fons you'll need to select if you're 1o
reproduce the newly opened document exactly. Some commonly used
funts, of course, will #ppear both selected and jtalicized.

To cancel the Select New Fonts command, click on Cancel or press Esc,
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The Quit command Jets you quit MultiScribe and exit 1o ProDOS. .

If you've made un

saved changes (o the current document, a dialog

X appears, asking if you wan( 10 save the most recent version of
the current document before quitting,

L&}

es

b] Ko '

. u?)sh fo save your file before
y {L\ ittha?
g ng’

Press ¥ Press (ESC)

Press N

193 Qurr

Yes bunon or Press Y 1o choose Yes, the current
- replacing the old version of the document on
ed. If you click on No or press N 1o choose No,

‘ith your Nost recent changes unsaved. If you




Edit Menu On the Edit Menu zou'll find commands to help you delete, copy,
© move, and replace blocks of text. Each of the Edit Meny commands
™M makes use of a disk file called the Clipboard, where cut or copied

o er
Copy dt
Piste @V
Sslecl AN 42

text is stored. The Clijoard remains on the disk even afier you
shut off your Apple. The last selection cut or copied to the
Clipboard remains there until a new Cut or Copy is made.

%
(?0
Cut L The Cut command deletes selected text, rulers, and page breaks
2. ‘-g, 0 from a document and stores the deleted material on the Clipboard,
| %‘ 7 7 replacing the Clipboard's current contents,
= P
jos _j_‘@;p% 23

” This command may be used only when you have selected text,
tey ol fo % (<°¢ X dimmed.

rulers, or page breaks and otherwise remains di

Pisle  6v | e o,
Select 1 67 | o v",%
% D
(0
Co The Copy command copics selected text, rulers, and page breaks to
r.p.; the Clipboard, replacing the current contents of the Clipboard,
5 ol ot | This command may be used only when you have selected text,
4 e rulers, or page breaks and otherwise remains dimmed.
biste
Select All 42
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Search Menu

]

Rephee.. ok
Cola Page 0 &¢

u,l.irc...m L'LK—
Colo Page 0 4c

e
Find... oF

B
=
o

4
4

Bt Sl o T

The Search Menu contai i i
sheelheimin e |l:J‘Lmuuns commands for finding specific text or a

The Find command searches for all the occ i
urrences of

word, group of words, or pdrt of a word in a docun‘lcnt%rfnpnﬁcl;?:d

inseruon point (o the end of the document.

When you clinose Find, a dialog box appears,

res =
8 L =
o |l& ‘
S ol ™
& Q" Olhole Uord 8 Partial Uord
L83 F)D Olase 8 lgnore (ase
3 ?[Find ] Press enuany Press (ESt)
£
Iy

e Find dialog box contains an input bar for the text you want 1o

Qmuuc. sciings fur Whole Word / Panial Word and Case / Ignore

2 Cuse, ind butions for Iind and Cancel. If you're using a

‘IJD mause, click on the input bar (o enter text; click on the option

SEIings 1o select opions, If you're using keyboard controls, use
u_w Fand L keys 1o move among the input bar and option lines,
Enter textin the input bar by lyping, and sclect settings by pressing
the space bar when the option seiting is activaled by the cursor
(whenit's Nashing).

Enter in the input bar the sentence, phrase, word, or other text
which you want o locate. You can enter up to 43 characters of
(XL
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If you choose Whole Word, MultiScribe looks for every occurrence
of the specified text as a distinct word, MultiScribe considers a
distinct word to consist of a group of lerners separated from other
text by spaces, punctuation and other special characters, and
numbers. MuluScribe would consider the following italic text to be

distinct words:

e MuliScribe is a word processor.

o fword/
e (word)
o tword,
o lwordl

If you choose Partial Word, MultiScribe looks for every occurrence
of the specificd text, whether it's a distinct word or part of a larger
word or phruse. ;

If you choose Case, the search is case-sensitive, meaning that
MuliiSeribe is looking for text which matches the specified text
exactly -- including uppercase and lowercase letters. If you choose
lgnore Case, on the other hand, MultiScribe looks for text that
maltches except with regard to case,

When you've selected the settings you want, click the Find button
or press Retumn, If MultiScribe fuils to find text to match the
specified word or phrase, a diulog box uppears 10 tell you the
specified search text was not found.

Hone found,

Press (RETURK)
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X tli[;:l‘i;ilﬁinab;pg‘r? Fuaiching text, the textis highlightsd and o settings to select settings. If you're using keyboard controls, use
the T and 4 keys to move among the input bars and option lines.
Enter text in the input bars by typing, and select settings by pressing
the space bar when the optior sciting is activated by the cursor

(when it's flashing).

b u u

1

|
CLUBE DOS APPLEMAN|ACOY 7
- CAIXA POSIAL 54131 Press (RETURK) Press (ESC)

]
01206 - SAQ PAULO - &P

£

Enter in the Find input bar the sentence, phrase, yvorpi. or other text
which you want to locate. Enter in the Replace with input bar the
text with which you want 1o replace the found text. You cun enter
up to 43 characters of text in cach input bar,

The diulog box contains buttons for Find and Cancel. If you want

. 1o continue searching for occurrences of the specified text, click on
: Find or press GEF. I you want 1o stop the search, click on Cancel

| or press Ese. The specified search text remains in the input bar undl
{ you enter different text,

The settings apply to the search. If you choose Whole Word,
MultiScribe looks for every occurrence of the specified text as a
distinet word. MuliiScribe considers a distinct word to consist of
a group of leners separated from other text by spices, punctuation
and other special characters, and numbers. MultiScnbe would
consider the following italic text to be distinct words:

w B K Kk &l

| [ | (i | e | [ e | [ew] o] | =

WL W L, W) T WA mal il g

replaceinent text, setings for Whole Word / Partial Word and Case /
lgnore Case, and butons for Find and Cancel. I you're using a
mouse, click on the input bars to enter texg; click on the oplion

or press Retarm. If MaltiScribe tuils to find text 1o nutch the
specified word or phrase, a dialog box appears o tcll'gou that no
¢ ext from

!
: Heplace 111): !Rc‘pl:lcc command searches for all the occurrences of a specified « MuliScribe is a word processor.
| o word, group of words, or part of a word in a document from the
i | tnseriion point (o the end of the document and gives you the option o Jwordl
} [_'h:d_drl. of replucing each occurrence of matching text with different text. 3
| T When you choose Replace, a dialog box appears. [ « (word)
| l Lol0 FuG2 B G I E o word,
I [r— [
l ind: i 6%
| Find [dise | [ ] o lword?
’ Replace uilh: [d”kn“e ] far. e }3 If you choose Partial Word, MultiScribe looks for every occurrence
{ " i : . of the specified text, whether it's a distinct word or part of a larger
| Olale Uord eParlial Uord = word or phrase.
| - Olase 0 lgnore Case B e o i o " o
; ‘ you choose Case, the search is case-sensitive, meaning tha
! Press (RETURN) Press (ESC) I 1 MultiScribe is looking for text which matches the SPCCil&l‘l:d text
E — 5 exactly -- including uppercase and lowercase letters. If you choose
Ignore Case, on lh_c other hand, MultiScribe looks for text that
The Replace dialog box is much like the Find dialog box; it containg D matches except with regard 1 case.
! an input bar for the ext you wart 1o locie, an input bar for the E ey :j When you've sclected the settings you want, click the Find bution
P |

m

occurrences of the specified text have been found in
the insertion point to the end of the document.

199 REPLACE
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None found. =
' %fg,% OOL
[_OC] Press ceerumy e 123
- <

g
) : o
If MultiSeribe finds matching text, the texq is highlighted ando\ {;}
another dialog box appears, {1y

[Fnd 5T} Press dF Press 6p

lg,-ff{ﬁ;, ) Press oK Press dA
[ Carcel l Press (ESC)

This dialog box containg buttons for Find Next; Replace; Replace,
Find Neat; Replace All; and Cancel. If You want to replace the found,
highlighted text with \he specified replacement lext, click on Replace
or press IR, 1f you vant 1o replace the found text with

the speeified replacement textand find the next occurrence of the
specitied text, click on Repluce, Find Next or press ON, If you

Wit 1o reptee sl oceurrences of the specified text in the document
Wil the specifivd seplaceiment text, elick on Replace All or press

QA I you want 1o find the next oceurence of the specified 1ext

without replacing the currentiy highlighted text, click on Find Next
or press (I,

Whenever you want 10 end the search, click on Cancel or press Ese,
The specificd seareh and replacement text remains in the input bar
unal you enter differeny rext,
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Goto Page #

r""l"'wa’|h

-

Find... aF
Replice.. &R

\

The Goto Page # command moves the insertion point to the top of
the page you specify. :

The Goto Page # command may be used at any time and never
appears dimmed on the Search Menu.

When you choose the Goto Page # command, adialog box appears.

—

Golo page nusber: [T |
Press (RETURK) Press (ESC)

: age # dinlog box contains an input bar for the number
g}]:'hg;;%f;?cwhich gu wint to set the insertion point :mdhbuuons
for OK and Cancel, 2I('hc: input bar contains the number of 1 ¢ page
on which the insenion point is curiently located. To enter a nwl’xr
page number, use the Delete key to delele the current p.fgc num
and then enter a new page number. When you've entered the nc'.tr
page number, click on the OK button or press Return. The m.s“.‘r;.on
point is set at the beginning of the lop line of the page you specify.

Clicking on the Cancel button or pressing ESC cancels the Goto
Page # operation,

201 GOTO PAGE #
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Format Menu The commands on the Format Menu let you define the page format ™ © = :q Show Rulers/ . The Show Rulers command allows you to see all rulers in a -
- of your document -- ling spacing, margin and tab placement, how document. Hide Rulers makes all rulers invisible while preserving
_! 1 text is aligned, where pages begin, and with what number page » Hide Rulers their formatting effects on the text.
Insert Ruler ay - Mumbering begins. In addition, the Format Menu contains g |
Show Bulers o commands for creating headers and footers, which allow you to add D B Like the other commands on the Format Menu, the Show Rulers
Itsert Page Break 4- ttles, foomotes and other footer text, dating, dme-stamping, and - Incert Ruler ay and Hide Rulers commands may be used at any time and never
Sel Page o s numbering of pages to your document. R B ol appear dimmed. Choosing Show Rulers puts Hide Rulers on the
Sel Perder.. lasert Page breik 8 Formal Mcnu in its pluce, und vice versa. Choosing Insent Rulers
¢ f:,l e i Set Page I dr| | automatically perfonns the Show Rulers operation and repluces
el Foler.., - - q 8l Neader_ Show Rulers on the Format Menu with Hide Ru]:rs..
D Sel Fooler...
e o
—

Insert Ruler The Insent Ruler command places a ruler in your document atthe = Insert Page Break The Insert Page Break command stants a new page at the insertion
; Inscrtion point and moves the insertion point and the text follow'mg point, making the insenion point and the text E)I owing it appear at
R = it below the newly inserted ruler. If the insertion point is at the en . G, the top of the new page. Subsequent pages are renumbe
G of a sclection, the selection is replaced by the ruler, a = automatically, :
=z = | Inserl Ruler dy '
W Aulerg i When you choose Insen Ruler, the inserted ruler is a copy of the Show Rulers dan Insent Page Break may be used at any time and never appears
Irzerd Page Break o« ruler immediately preceding the insertion point in your document. = ] (s s dimmed on the Format Menu,
Sel Fage I..., 4z All format seuings on the new ruler will be set as they were on the  — LSE"-P‘E&_'.“ 07 ] :
$el Header. preceding ruler. Choosing Insert Ruler automatically performs the Sot Header.. The place where you insert a page break becomes the border
Sl fQ‘;"--- Show Rulers operation, and all hidden rulers are shown along with  — = e Eatlar between the old page - all the 1ext on the curren puage to the left of
4% the newly inseried one. e e the insertion point when you select Insent Page Break -- and the new
< OO ‘ ) - page - all the text to the right of the insertion point. You can still
a8 The Insent Ruler cominand may be used at any time and never add text to the old page, however, the remaining space on the old
0;9% &y po"gr,{ appears dimmed. B o
7 S
“fop 4 &g 44//4 ; You can sclect a page breuak by sclecting the blank space created by
a2 0 % 00& E :_3 the page break between the old and new pages. You can then cut,

Sw copy, paste, and delete the page break, or replace it with the

Clipboard contents,

L
*-j A MultiScribe document can have a maximum of 25 pages, 50 you
can’t insert more than 24 page breaks into a single document.’
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Set Page # The Set Page # command lets you set the number of the first page in Set Header... The Set Header command allows you to create headers
the document, renumbering all subsequent pages in the document L] -- information you want printed at the top of every page in a
Frn M‘Tf)rmng-]y' ‘thr} you pnl?(t the ﬁoécun;)cm, lilfm'F‘?lgc numbcnrllfz | RAU: | dqcul;ljmclr]u - &nd’to ;pccrnry u;‘hcn: ymi waﬁ: u:jcm 10 appear
- Insert Ruler ar ;vl:ur.l;z?c?itraclm“f;;ﬁo;armmuin»;lils rc;ldjlfs%:d 10 reﬁr:‘::‘:b:;hlgg i Insert Ruler oY ;?inlcndf Wﬁ g::.xlr llr‘t?lc.::‘(:)u%ig\cc:::ﬁg a lfucofgr?lﬂ:r“hcadu‘
Show Bolers an chunge as well, s Shou Rulers on information to be conveyed in no more than a single line of 1ext)
[neerd Pace Praak d- b= Insert Page Break ¢- and print the page number for each page, as well as the date and
i - The Set Page # command may be used at any time and is never Sel Page K. (ig time of printing (if you have a ProDos-compatible clock card).
el T dimmed on the Format Menu. ] R e The text you place 1n a header can be of any one funt and
Ve Loauslis SelFootern. character size, and any combination of charicter styles.
Sel Fealer.. s y )

When you select the Set Page # command, a dialog ?‘ox appears.

2, When you choose the Set Header command a dialog box
v% ; ﬂppcd-rs.
Hew page nuehers @:] o, Q,/OCL Page Deder
S '@' o ; Paga laaglv Il Top mrgn: 471 Bollsn mrpin L
"oy | Header posilon oa page G» [I ] B &8 0
Press (RETURMY | Cancel | Press {ESE) [|r.
‘ r s)o /4'7( (<°¢ 1.Il.n.|.;.l'“.1.. ll. 1 “L‘“h,.[LLL.JAu Lot l'n Lt
) ,5,
(7 ‘-{?, 2

N

[Tamn] [ (] [smes | |ms] [me] Jamn] (o] 200 | o) jaue] jme | um)] j0u] |

S
The Set Page # box contains an input bar for the new page numb&.

an OK button, and a Cancel button. The input bar contains the () =

curment number of the first page in the document; the preset value b

is |. To enter a new page number, use the Delete key to delete the :

current value and type in a new number. When you've entered the i

new number, click on the OK button or press the Return key. Lo DL.__‘ brass QEICID brets (80 OO I moe

Clicking on the Cancel button or pressing Esc cancels the Set Page # T

operation -
The firstline of the Set Header dialog box displays the page
length, top margin, and bottom margin of the current document.

= These specifications cannot be changed with the Set Header

command. To change these seuings, choose Page Setup from
the File Menu, ¢ ; .

0
(& ¥

The Set Header dialog box also contains an option line with an
input bar for Header position on page (10 be specified in
inches), icons for sewing page number, date, and time, an inch
scale for determining where on the puge to place these icons,
and a large input bar for entering and editing header text.

! .
[V ¥

I R I i (EL T R

s
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When you choose the Set Header command, the menu choices
on the left half of the menu bar are dimmed and the commands
on these menus cannot be exccuted. The Font, Size, and Style
Menus remain active, however, so that you can make stylistic
changes to your header text.

« If you're using a mouse, click on the menu bar 1o
dcuvate a menu.

* Il you're using keyboard commands, press OEsc 1o

activite the menu bar, Pressing only Esc will cancel the
Set Header operation, Once the menu bar has been

activated, you can move between menus using the
and = heys. Move from command to command on a

menu using the L and T keys. Press Retumn to make
font, size, and style sclections, (4)
| 7

The inserntion point appears in the input bar below the inch g@co
Q

This input bar represents the top margin of the primcdlp??c.
You can l)]]\c in 4 maximum of one line of text in any fohitp
and style. This text will uppeur at the top of every page wh

you pantyour document. Header text is not displayed on the ‘5\4‘00\5‘/ A &
i P AN

screen as you edit your document. Prior to printing, the only
way to see how headers will look on the printed page is 1o
cheose the Preview opuon from the Print command in the File
Mcenu,

You may also want to include the page number, date, and time
on your dacument. leons for this purpose are situated on the
opton line above the inch seale. “The date and time will be
prnted only if you have a ProDOS-compatible clock installed in
your Apple computer, '

+ If you're using a mouse, drag the icon you wish to place in
your header into position in the input bar.
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if you're using keyboard controls, you can move within
the option line using the + and — keys or the GTab and
Tab keys. An icon will flash when it is selected. To
move the icon into the header, press the space bar. You
can move the icon within the header in small increments
by pressing G «—and @ —. Gl and 3T can be used

to mave the icon in greater increments.

You can overwrite icons with text or place icons on top of text.

The size of the top margin is especially relevant to the creation
of headers. The top margin is the designated area in which the
components of the hewder (title, paged,date, time) can be
amanged. When you first start up MultiScribe, the top margin is
automaticully setat .33 . “To increase or decreuse the top
margin, choose the Page Setup command from the File Menu.

In addition to letting you create headers, the Set Header
command also gives you flexibility in positioning the header
within the boundaries set by the top margin, The Heuder
position on page input bar lets you specify where in the lop
margin you wish to place the header, To enter header position
in this input bar;

¢ If you're using a mouse, click on the input bar and
enter the number of inches into the top margin you
want to position your header.

« If you're using keyboard controls, use the T key 10
move the insertion point into the header position input
bar, and enter the number of inches into the 1op
margin you want (o position your header,

A header positon which fails to reserve enough room for the

actual header will be rejected and a dialog box will appear 1o
alert you to the lack of space for the header.

207 'SET HEADER..,
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The header MUST fit inside the top nrgit:c!1

%
Press (RETURH) 3

e

.

Ix:simm, click on OK or press Return to retum to the Set
leader dinlog box. MultiScribe will automatically make the
hewder posinon wdjustment necessary to fit your header within
the top margin.

A header can be set at any time, even when you also have a
footer, “Ihis means the placement, font, size, and style
specilivauons can be changed while a document is being created
or edited. Funhenmore, heuders can be added 1o existing
docunients. MaliiSeribe will automatically repaginate 1o make
the necessary space available for the incorporition of headers
into an existing document.

Headers can be deleted completely. To delete a header, display
the existing header with the Set Header command, remove the
time, date, and page number icons from the margin and delete
the header texe.
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The Set Footer command allows you to create footers i
= information you want printed at the bottom of every page in a
document -- and to specify where you want them to appear )
within the bortom margin of each page when the document IS
printed. With Set Fooler you can enter a footnote or chapter title
(or other footer information to be conveyed in no more than a
single line of text at the bottom of a page) and print the page
number for each puge, as well as the date and ume of pnnting (if
ou hive a ProDOS-compatible clock card). The text you place
in a footer can be of any one font and character size, and any
combination of character styles,

When you choose the Set Footer command a dialog box
appears.

Pige Foaler
Page lengle Ll Top margine .33 otton margio L3

Fosler position an page oy [A__] QA 8 0
1 §

abadod lu.l...l.ul.nl.ul.hl’. Lol

YU AT IO AT DT |

Prass (RETVRN) Press (ES0)  OCESO) for mena

The first line of the Set Footer dialog box displays the page
length, top margin, and bottom margin of the current document.
These specifications cannot be changed with the Set Footer
command. To change these seutings, choose Page Sctup from
the File Menu.

The Set Footer dialog box also contains an option line with an
input bar for Footer position on page (1o be specificd in inches),
icons for seuing page number, date, and time, an inch scale for
determining where on the page 1o place these icons, and a large
input bar for entering and editing footer text. This input bar

represents the bottom margin of each document page.
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When you choose the Set Footer command, the menu choices
on the left half of the menu bar are dimmed and the commands
on these menus cannot be executed. The Fonr, Size, and Style
Menus remain active, however, so that you can make stylistic
changes to your fooler 1ext. o

%
¢« Ifyou're using a mouse, click on the menu bar 10 ncu'val%g\

a menu,

%, %,
L] | | P +
¢ Il you're using keyboard commands, press GEscto b Ty

activate the menu bar, Pressing only Esc will cancel the
Set Footer operation, Once the menu bar has been

activitted, you can move between menus using the ¢
and = keys. Meve from command (o command on a

menu using the L and T keys. Press Return to make
fony, size, and style selections,

The insertion point appers in the input bar below the inch scale.
This input bar represcnts the bottom margin of the printed page.
You can enter a maximum of one line of text in any font, size,
and style. “This text will appear at the bottom of cvery page
when you prnt your document. Footer text is not displayed on
the screen as you edit your document. Prior to printing, the
only way 1o see how footers will look on the printed page is to
chioose the Preview opuon from the Print commuand in the File
Menu,

You may also want 10 include tie page number, date, and time
on your document. leons for this purpose dre situated on the
aption line above the inch scale. The date and time will be
printed only if you have a ProDOS -compatible clock installed in
your Apple computer,

¢ If you're using a mouse, drag the icon you wish to

place in your footer into the desired position in the
input bar.
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» If you are using keyboard controls, you can move
within the option line using the ¢ and — keys or the

OTab and Tab keys. An icon will flash when it is
sclected. To move the icon into the footer, press the
spuce bar. You can move the icon to the desired place
within the footer in small increments by pressing

BeandS =, Gland GT canbe
used 1o mave the icon in greater increments,

You can overwrite icons with text or place icons on top of text.

The size of the bottom margin is especially relevant 1o the
creation of footers. The bottom margin is the designated area in
which the components of the footer (title, paged.date, time) can
be arrunged. When you first sturt up MuluScribe, the bottom -
margin is automatically setat 1.5 *, To increase or decrease the
bottom margin, choose the Puge Setup command from the File
Menu.

In addition to letting you create footers, the Set Footer command
also gives you flexibility in positioning the fouter within the
boundaries st by the bottom margin. The Footer position on
page input bar lets you specify where in the bottom margin you
wish to place the footer. To enter fooler position in this Input
bar:

e If you're using a mouse, click on the input bar and
enter the number of inches into the bottom margin
YOou want to position your [ooler,

¢ I you're using keyboard controls, use the T key 1o
move the insertion point into the footer position input
bar, and enter the number of inches into the bottom
nurgin you want (o position your fooler,

A footer position which fuils to reserve enough room for the

acrual fgoter will be rejecied and a dialog box will appear 1o alen
you to the lack of space for the fuoter,
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ke The Font Menu displays the names of the first 16 fonts on your
__J Font Wenu MultiScribe disk (orp :hyc current set oﬁ fomsrchos?n Wil[h tth:lcct
TR . : [y New Fonts command) and lets you choose fonts for selected text or "
The footer Hyst fit inside the botlon Rargin! F = = = for text 10 be typed in at the insertion point. The preset font is 3
] HEHINCLAY Hemingway, if you're using a production copy of MultiScribe, or
CZ(/ - STAEDARD.BM the Iowcsl-numg\:rcd font of the current set If you've chosen a new
Press (RETURN) O = — LIRDSUIRTH , setof fonts with Select New Fons,
ARK, TR
$ 45 : ] E‘][R[[;L : The fonts are displayed on the Font Menu in the order in which they
% A, f"(é.. = g DANIE were cr\fu'tcct and saved o disk, When you choose a font, 1 check
If thi i T8y ‘9"4» -’ff.f ' 1819y mark (V) appears beside thar font on the Font Menu, If you
this message should dppear when you're specifying footer € p, ¢ I, YA I move the insention point o a different fon in text, the font where the
pesition, click on OK or press Return 1o Tetum 1o the Set Foorer 40-‘:0 B 9 i ) CHAUCER insertion point is positioned is e chosen font and is checked on the
dialog tm.‘ MultiScribe wij) automatically make (he fooler So ' e SHZXESPEARE Font Menu, If selected text is all of one font, that font is checked on
{:::['l“;’.“u‘]‘ﬂ“;:'““”' flecessiny 1o it your footer within the J HICRELAXGELO the Font Menu; otherwise the first font jn the sclection is checked.
A Lin. o f—
A fooier can be = T N If you use the mouse to position the insention point between text of
cm‘bc‘:c‘l-*:!‘nny*;lnmh{?_hy:%ﬁﬁshivcrn hcadcr.. Also, a fooler J two different fonts, the chosen font is the first of the two fonts. [f
sice, and siyle specifications can be Cﬁmgﬁrﬂ(‘)jﬂlﬂiﬁgcm E e S you use the = key 1o position the insention point b_clwccfl text of
15 being L;rt;n::d or edited. _ Fﬂﬂhrﬂmrc. footens can be added 1o r two different fonts, the font 1o the left of the insertion point Ls‘:hc
EXLUNY documents. MulnScnI»; will dutomatically repaginge chosen font. On the other hand, if you use the ¢ key 1o position
Lo ke the necey MY Spuce aviiluble for the inuurpur;ujon of F i ;. E the insertion point between (wo different fonts, the font 1o the right

PUIED N0 an existing document, of the insertion point is the chosen fonr.

L

Foutery cin be delered completely. To delete a fooler, display
the existing foorer with the Set Foorer tommand, remove the
ume, dute, and page number icons from the margin and delete
the fouter ear,

When you cut or copy text, the text retains jts font along with its
style and size,

[
Lk

You can change the fonts which appear on the Font Menu with the
Install New Fonts command. Fonts can be removed as well as
installed with this command. You can also delete fonts with the

elete command, which Jets you delete fonts of all file types. Fonts
can be created and edited wilﬁ the Fomlidlitor, For more information
on the Install New Fons and Delete commands, see (he explanations
of these commands in the discussion of File Menus commands earlier
in this chapter. For more information on FontEditor, see the three
chapters on FontEditor in this manual,
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Slze Menu

Lo

The Size Menu contains font scaling options for enlarging the size
of characters from 1 10 3 times the base size of the font,

When you choose a font size, selected text or text typed in art the
insertion point is automatically enlarged to the base P;nt size of the
characiers umes the specified size. The sjze you choose is checked
on the Size¢ Menu, To retum the selected lext to the base size of its
Charuciers, choose 1.0 from the Size Menu,

The maximum size for any character in MultiScribe is 77 points, If
youtry 1o scale a font 1o a size greater than 77 points - if you try 1o
resize 28-point chinacters with size 3.0, for example -- MultiScribe
will automatically scale down the characiers 1o the next allowable
size, leaving the chosen size checked on the Size Menu,

If you move the insertion point to a place in text with a different
size, the size where the insention point is placed is the chosen size
and is checked on the Size Menu. If selected ext is all of one size,
that size is the chosen size and is checked on the Size Menu,
Otherwise, the size of the first character in the selection is the
chosen size,

If you use the mouse to position the insertion point between text of
two different sizes, the chosen size is the size of the characer
preceding the insertion point. If you use the — key to position the
inscnion point between text of two different sizes, the size of the
characier preceding the insertion point is the chosen size and
appears checked on the Size Menu, If you use the « key o
position the insertion point between fext of different sizes, the
chosen size is the size of the character to the right of the insertion
point,

PNM" you cut or copy text, it retains its size as well as its style and
onl.
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The Style Menu contains options for changing the style of text,
letting you choose a style or combination of styles for selected text
or for text to be typed in at the insertion point.” The preset style is
Plain. .

When you choose a style, a check mark (V) appears beside the style
on the Style Menu. You can mix styles in any combination you
wish; as each new style is chosen, it appeurs checked on the Style
Menu, The only styles which cannot be used in combination with
other styles are Pluin, which removes all other styles, and
Uppercase/Lowercase and Subscripy/Superscript, which are

mutually exclusive and never appear checked at the same time on the
Style Menu,

You cun deselect a style if that style alone has been chosen -- by
choosing the checked style apain, Once you've combined styles,
however, the only way to remove a style is o choose Plain, thereby
removing all styles,

If you move the insertion point 1o a place in text with a different
style, the style where the insertion point is positioned is the chosen
style and is checked on the Style Menu. If selected text is all of one
style, that style is the chosen style and is checked on the Style
Menu; otherwise the style or combination of styles of the first
charucter in the selection is the chosen style or style combination,

If you use the mouse 1o place the insention point between text of two
different siyles, the chosen style is the style of the characier

preceding the insention point. If you use the — key 10 position the
insertion point between text of two different styles, the style of the
character preceding the insertion point is the chosen style and

appears checked on the Style Menu, Il you use the + key 1o

position the insertion [x)inl between text of two different styles, the
chosen style is the style of the text 10 the rightof the insenion point.

Tall and Wide are unique styles because they greatly affect the size of
characters us well as the style and therefore deserve special
consideration here. Tall allows you to increase the vertical scaling of
characters by a factor of 2 while leaving the horizontd scaling
unchanged. You can use Tall with any character size (1.0 through
3.0) from the Size Menu and with all styles and fonts. The only
restriction is that the twofold increase cannot result in charucters
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exceeding 77 points in height. If you apply Tall 1o a size/font
combinaton which would result in a character taller than 77
points, no change will be made 1o the selected text. You must
then make the appropriate adjustments in your choice of font or
size so that when you use Tall the character wil] be within the 77
point runge.

The Wide command is similar 1o Tall in that you can increase the
widih of characters without alfecting their height, Again the
chiange in size is twofold, Wide, however, difTers from Tall in
its imittions. You cun always apply wide 10 any font or style
and o any size up 1o 1.5, If you sclect a size 2.0 or greater,

Wide will produce no effect on the selected text.,

When you cut or copy text, it rewains its style as well as its font
and size.
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Introductlion The easiest way to leam something is by doing it. In this chapter
you'llslearn how to create and edit fonts by creating your own
new font, which you'll be able to use with MultiScribe, First -~
there's a discussion of MultScribe fonts -- what they are and
how they let you stylize word processing documents. This is

* followed by a section on Gerting Started, which will explain, step
by step, how to start up FontEditor and create a new font. The
next sections, Cloosing A Character To Edit, E dinng Characters,
and Chlunging The Dimensions Of A Characier will show you the
basics of editing individual characters. Saving Yowr Font, Opening
A Fomt For Editing, and Closing Fonts, discuss procedures for
m;magini and mainuaining entire fonts. The final section,
Leaving FontEditor, discusses how 1o quit FontEditor and retum to
MultiScribe,
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About The word fons was originally a

Hary type of one style and size. MuluScribe fonts are
’P;AUIEISCrIbB == stored as files on a floppy disk. Unlike old-fas
onls fonts, however, MulliScr‘iEc fo

your needs -- with Fon(Edior.

correspondence beiween the characiers
keys and e churacters in a fonr: whe

Before you begin 1o Jeam FontEdito
{uu should know. These temms desc
MultiScribe fonts, Thege churucten
I categories: those which apply 1o the

apply to individual characters,

Characteristics which apply to the entire font are:

* the fontname;

¢ the funt number;

¢ the point size and height of the font;

¢ the font's ascent;

¢ the font's descent.
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A MultiScribe fontmame may be any unique name which follows the
ProDOS conventions for filenames:

¢ fontnames can consist of no more than 15
characters; i

¢ the first character of a fontname must be a
lenter;

¢ all other characters must be leners, _
numbers, or periods (no other punctuation
murks or spaces).

A MultiScribe font is usually named after a writer who calls to mind
the unique characteristics of that font. The Medieval English-style
font is called Chaucer, for example. This is a handy device for
remembering the differences berween fonts -- and appropriate for a
program culled MultiScribe -- but don't feel bound by it. You can
Bive your fonts any name which follows the ProDOS rules outlined
above. Be carelul when naming fonts, however, that you don't

give a font the same name as another font or file on e disk. (See
Appendix C: "MultiScribe File/Disk Organization” for a list of the,
files that corme on your MultiScribe disk.)

In addition to its fontname, each MultiScribe font also has a unique
font number, Font numbers 1 through 200 are reserved for fonts
provided by SiyleWare. If you create your own font, assign ita
number from 201 through 254, but be careful not 1o give il a
number already assigned 1o another font on your MuliiScribe disk,

MuliiScribe fonts are numbered to nuke MultiScribe more flexible
in its treatment of fony information in wond Processing files. On
versions of MultiSeribe before verion 1,10, (he preset funt -- the
font which you'll be typing if you don't choase another font -- wag
the first font placed on the disi. This font was usually Hemingway,
unless you changed the order of the fonts on disk or removed
Hemingway. To chanpe the preset font, you had 10 remove all the
fonts from your Myl cribe disk and then save them hack 1o your
disk in the desired onler. More impartant, if you used two different
MuliiScribe disks with fonts saved on them in a different order, files
created using one disk appeared different when used wigh the other,
because MulliScribe identified 1ext fony information by the order of
the font on disk,
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MultiScribe now helps you avoid this son of confusion by
roviding each font wid)w’ 8 unique number by which it identifies the
ont type of text rather than bqucmil’ying the font type of text b

the number signifying the order in which a font was saved to dis

Fonts supplied by StyleWare are all provided with unique font
numbers; a list of MultiScribe fonts and their font numbers is
provided in Appendix 1 of this manual, When you create a font
using the MuluScribe FonEditor's New commind, you're allowed
(o assign it a number in the range 1 1o 254 only, so you normally
won't have any rouble with the "unnumbered font” dialog box with
any fonls you create, This dialog box appears if you have an
unnumbered font on your MuluSeribe boot disk; Tonts released on
versions of MultiSeribe prior to version 1.10 contain fonts with no
numbers and will gencrate this dialog box if you move them to your
boot disk,

Font MILTON has not been numbere:ff‘?&&
Use the FonlEditor fo nunmber it

you use a font file from a version 1,00 MultiSeribe with
version 1,10 or greater, in which case you should simply use the
Fonu:ditor 1o assien it a font number (which is why MuliScribe
pemiils you to assign to fonts numbers in the StyleWare-reserved |
10 200 runye). If a font has no number, MultiScribe temporarily
assiuns it the number of its place on disk (if it was saved seventh,
for example, itis assigned l[lc font number 7).

If you lave two or more fonts with the same funt number on the
same MulnScribe disk, a dialog box will appear when you Stant up
Muluscnbe 1o wirn you of the contlicting font numbers,

Font HY.FONT his the same number as
another fonl, Use the FonlEditor (o renunber IN,

| 0x ]Press (RETURMY
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To avoid having two or more fonts with the same font number,
simply record any fonts you create, along with their font numbers
and point sizes, in the chant provided in Appendix H, and refer 1o
this chart when creating fonts and changing font numbers,

On previous versions of MultiScribe, the preset font was the first
font saved 1o the MultiScribe disk in use; in most cases this was
Hemingway, although instructions were provided for changing the
preset font by changing the order of fonts on the MuliiScribe
program disk. Versions 1.10 and greater of MultiScribe recognize
the font assigned the font number 1 (usually Hemingway) as the
preset font; if no font on the MultiScribe disk has the number 1, the
preset font is the font on the disk with the low est font number.

MuliiScribe fonts are still listed on both the MultiScribe and
FontEditor Font Menus in the order in which tiey are saved to the
path from which they are read. The FontEditor Font Menu differs
from the MultiScribe Font Menu in one important respect: the
FontEditor Font Menu Lists a font's font number (o the left of the
font on the menu, while the MultiScribe Font Menu contains just the
names of the fonts.

Font size is usually measured in points. A point is a typographic
term for 1772 of an inch. Not coincidentally, this is the approximate
size of a dot produced by a dot-matrix printer, If you own a dot-
matrix prinier, such as an Apple Imagewriter or Epson FX-£0, you
probably know that dot-matrix printers form characters as grids of
1712 inch printed dots (hence tie name dot-matrix). To produce the
letter “E," for cxam(rlc. a dot matrix printer might printa 9 x 6 grid
with the following dot pattern:
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MultiScribe fonts are formed in a similar way. Each character in a
font is a matrix of 1/72" dots. On the screen these dots are called

pELeLY, total wid|
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descent
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character width

If a font contains alphanumeric characters, all the uppercase
charicters in that font rest on the same imaginary line, called the
hase line of the font, The distance from the base line to the top of
the tallest character in a font is called the ascent of that font. Certain
lowerease leters, such as jand y, hang below the base line and are
called descenders. The distance from the base line to the bottom of
the lowestdescender in a font is called the descent of that font. The
height of 4 font s the swim of the font's ascent and descent, or the
disLaice from the top of the tallest character in the font 1o the bottom
of the Towest descender. The font height determines the point size
of the Tont:a font with a beight of 10 pixels is called a 1( point font,
a fontwith a 12 pixel height s a 12 point font, etc.

Bise line, ascent, descent, and height are all font atributes which
apply e every character inoa font, There are three font
Chatacteristics which apply w individual charicters in a font. These
arg: :

¢ character width, the number of rows of filled pixels
used 1o form a character;

¢ character spacing, or the number of rows of blank
pixels used w separate a character from other characlers in a
font;

s total width, the sum, in rows of pixels, of a
character's spacing and charncter width,

224 CHAPTER 5: LEARNING FONTEDITOR

m

r I mm m m m

7

11111111111111“

I OICiaicc

e il By
L-—— f r——)

{

2 X
Al

-

Fooy
-

(N

q: '

1
i

S

e bow W oW o oM i i " i H W

CURNE U S S 1

-]
@

[ 11

[H2593320

Teolews @
5]

%)
L4}

B 0O 00| @

&
I

| ~1=%

Most word processors use character sets in which characters are all
based on the sume matrix. To a large extent, the shapes of
individual characters are determined by the dinensions el' this
matrix. If, for example, a wide charicter, such as a \'{. and a thin
character, such as an “i," are both based on the fixed dimensions of
the same matrix, the "W" will appear compressed while the "i" will
contin excessive blunk space.
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MuliScribe fonts, on the other hand, use proportional spadng.
which means that churicter width and spacing ure detenmined by the
shape of a paniculir churacter. In MuluScribe's Dante font, for
example, the exclatution point has a wtal width of 5 pixels, while
the "M" has a towal width of 14 pixels.

There are many advantages to proportional spacing. First, with

roportional spacing, you can create more detailed characters,

scause you're not confined tw dimensions designed to accomodate
the average shape of characters in a font. You can space churacters
preciscly uvccmlin%; to their shapes. ‘This means that thin characters,
such as "I" and "i,” aren't sumounded by a disproportionate amount
of blank space. Furthermore, proportional spacing can save you
room on disk and in memory, since you're not having to save
excess spuce between thin and wider chanicters,
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Getting Started
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Now that you know all about MultiScribe fonts, let's do
some experimenting,

First, you'll enter FontEditor from MultiScribe,

= Choose FonlEdltor from the MulliScribe
3 Menu.

e

e
T -
]

If you've made unsaved changes to your current document, a ;

dialog box dppears, asking you if you want (o save your
changes before leaving MufvliScribc. Click on the Yes button
or press Y if you want 1o save your changes; Click on the
No bution or press N if you don't want your changes saved;
Click on Cancel or press Esc 1o cancel the FontEdjor
command and remuin in MultiScribe,

If you're using a § 174" drive, a dialog box appears, asking
You 10 insert side one of your MultiScribe disk, %m your
MuluScribe disk over so that side 1 is facing upward. Inser
the disk in your disk drive and close the drive door. Click

on the OK bution or press the Retum key.

A dialog box dppears bricfly, telling you FonlEditor is being
loaded and asking you lo please stand by while it loads,

When loading is finished, the FontEditor menu bar and a blank
screen dppear,
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Next, you're going to create your very own font.
= Choose New from the Fila Menu.

A dialog box appears.

Y=w Fent

Font mses [ | Fonl nucher:[ ]
Press (RETURID Press (ESC)

Before you can create a font, you must name it and give it a
unique font number. The reason for this is hat Fontliditor
allows you to have many fonts open at once, and things can

et confusing if some of the open fonts don't have names or
if some fonts share the same font number,

= Enler My.Font as the name for the font you are
about to create. Enter 201 as the font number for
your new font,

Kew Fonl

Font me: [FyFonl | fonl nueber: [20]]
[L0C] press qenen [ Tanea | Press (£0)

The font numbers 1-200 are reserved for fonts provided
by StyleWare, When you create fonts, use the font numbers
25|-2y54. to avoid confusion with other MultiScribe fonts,
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= Click on the OK button or press Return,

A menu bar and four windows appear. This is the FontEditor
screen,
i The font window contains F
The menu bar containg the all the characiers in a font, The
names of the menus from Mashing character is the last
which you choose commands, characier sclecied on the F
The edit window allyws you it R, goln dlia
L edit charsciens, The individual poc e fonk wilidow like e l
dotsrepresent the pisels which Keyboard map, o select F
Mmuhe up a charikter, The fhiclg [ox t:diting.
claracier being edied
it - 0 Flle Edit  Design “Fonl  Size
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The style window shows you what a character
will look ke when it is plain iext, bold, julic, The keyboard map allows you 10
urdlzrhing, ocline, and shadaw. select a charucwer for editing,

228 CHAPTER 5; LEARNING FONTEDITOR

FTE TR 75

al il

IC

[
il

I

| ;O

L

—
ey

!
—

The first thing you probably notice as you look over the
FontEditor screen is that the letter "A*'is the letter in the edit
and style windows as well as the lener highlighted in the font
window, and -- along with both Shifi keys -- on the keyboard
map. Whenever you stan up FontEditor, "A" is the default
character in each of the windows.

The font which appears in the font window when you select
the New commund is called the base font, because you'll build
upon itin creating your new font, It is put there simply to
remind you which chariciers usually appear in which positions
in a raditional microcomputer characler set,
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Choosing a
Character to Edit

1. Selecting a
Character on
the Keyboard
Map

To begin editing a character, you must do two things;

¢ first, you must select the character you wish to edit on the
keyboard map or in the font window;

®  second, you must place that character in the edit window,

You'll begin by selecting the character "B* on the keyboard map,

= Illyou're using a mouse, click on the “B" key on
\he keyboard map OR click on the "B" character

Q\\“>c' In the tont window.

S you're using keyboard controls, simultaneously

press the “B" key and the Shift key on your
keyboard OR press the Tab key to move the cursor
forward to the "B" character In the font window.

The "B key on the keyboard mn[) is highlighted, and a
blinking box highlights the "B" character in the font window,

Notice, however, that the character in the edit and style
windows is still "A," You'll soon see why when wz discuss
placing a churacter in the edit window below. Before you
move on 1o the edit window, however, you'll want (o see how
the keyboard map handles lowercase letters and special
charucters generated by the Shify key.

= It you're using a mouse, click on the Shikt key
on the keykoard map.

= Il'you're using keyboard controls, make sure

_that the “Caps Lock" key I3 In Its released, Inactlve
position, and press the "B" key only.

Thie "B" key on the keyboard map is still highlighted, but the
blinking cursor in the font window is now on the lowercase
"p
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= If you'rs using a mouse, click on the "1~ key on
the keyboard map.

= If you'rs using keyboard controls, press the “1*
key on your keyboard.

The blinking box in the font window now highlights the
character™']."

= If you're using a mousae, click on the Shift key
on the keyboard map.

= If you'ra using keyboard conlrols, hold down
the Shift key on your keyboard and press the
u1u koy.

The blinking cursor is now positioned over the ** character in
the font window.

As you may have noticed, selecting a character on the keyboard map
works differently depending on whether you're using 2 mouse or
not.

If you're using a mouse, the Shift key on the keyboard map works
like an on/off switch, When you click the Shift "switch" on;

¢ The Shift key symbol on the keyboard map appears
highlighted,

¢ The currently selecied key or any key you click on will
select the characier which is the u}qivalcnl of that key -
pressed simultancously with the Shift key.

Of course, you can also just use the mouse 1o click on the desired

character in the font window, and ignore the Shift key symbol
altogether.
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If you click on the Shift key and then click on an alphabetic
character, the character selected will be the uppercase character. 1f
you click on the Shift key and then any other key, such as a number
or punctuation mark, the charcier selected will be the character
represerted on the top of the key. The opposite is also true, When
you click the Shift “switch" off, the Shift key on the keyboard map
retims 1o its nomal, unhighlighted stare and the selected character
in the font window is a lowercise characier or the character
fepresented by the botom character of the currently selected key,

If you're wsing keyboard controls, the character you select will be
the charucier represenied by the keyboard key you press. If the
“Caps Lock” key isin it depressed, active positon (or if you're
holding down the "Shift key") and you press the "A" key, the "A"
charicter in the font window will be hi -?1IiEI|rcd. indicating that "A*
is the selected churctes. If, however, the Cups Lock key is pressed
down, and you press the “7" key on your keybourd, the “7" and nop
the “&" will be the highlighted characier in the font window. O
the ather hand, if you hold down the Shift key and press the *7"
key, the "&" charicier becomes the highlighted character in the font
window,

= Ifyou're using a mouse, ry clicking on each
key on the keyboard map with the Shift key
both on and of. Qr

. : L
Notice what happens when you click on special characters, like <
the "Delt” or "Contr" keys, =

= Il you're using keyboard conltrols, press each of
the keys on your keyboard with and wlithout the
Shift key and with and without the Caps Lock
. key pressed down.

Notice the effects of each keypress on the character highlighted
in the font window,

When you feel comfonable selecting characters, go on to the next

section (o learn how to plice your selected characler into the edit
winduw,
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2. Placing the
Selected
Character In
the Edit
Window

)

When you first selected the “B" key a few pages back, you may
have been surprised (o see that your selection did not change I.hE
character in the edit and style windows, which remained an A’
That's because you must place the selected character in the edit
window with the Get Character command. :

There are three ways 1o place a character in the edit window with the

Get character command:

* choosing Get Character from the Design Menu with the
mouse,; o

¢ choosirg the Get Character command with the Esc and
arrow keys;

 pressing OG.

= Select the character *B" by clicking on the Shift
and "B" keys on the keyboard map, or press
Shift-B on your keyboard.

“B"is the selected character in the font window.

= Choose Get Character from the Deslgn Menu or
press GG on your keyboard,

“B" becomes the character in the edit and style windows.

Congrawlations! Now you know how to s¢lect a character
from the font window and plice it in the edit window for
modifications.

You'll probably want 1o practice selecting characters and
placing them into the edit window before you go on to the
next section, where gou'll learn how 10 edit characters and
put your modified charucters back into the font.
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Editin When newspaper editors edit copy, they change letters, words, q

Chara?:ters sentences, paragruphs; they throw out some pans of a story and 2. Edlting = Use the mousc to gulde the polnter Into the edit
rearrunpe others parts; they decide which stories go where on the Characters with window.
page. When you use a word processor )ike MultiScribe to edit a fq ia Motise

document, you do much the same thing: you cut, copy, and paste
sentences and paragraphs; you change the style of certain charicters
and words; you use rulers, headers, and footers to format the layout
ola puge. [ both cases 1ext is modified, fashioned (o the user's
needs,
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The arrow pointer changes o a cross.

al

FontlEditor alse edits text, but on what you might call a microscopic
level: you're acuually modifying and rearranging the way individual
characters look. With Fontlditor you can be the typographer as
well as the printer.

1. Getling Started You'll begin editing with the letter "A",

14
il

= Select the lettor “A” by clicking on the “A" keyboard
map, by clicking on the “A" character In the font window,
or by pressing Shift-A on your keyboard.

(1

L
U

Use the mousa to move the cross polinter Into
the matrix of dots In the upper left hand corner
of the edit window.

= Place "A” Into the edit window by choosing Get X )
Character from the Deslgn Menu or pressing OG. Notice how the cross pointer becomes inverted when you place

iton adot. The dots in the character grid represent blank

pixels. For the purposes of this manual, blank pixels will be

called dots; filled pixels will be called pixels.

el

I

"A"is now in the edit window.

Editing characters with FontEditor can be done two ways: with
the mouse and with the apple and arrow keys. You can also
combine the two methods, so if you're using a mouse, you'll
probubly want to read both of the following sections, 2 and 3.
1 not, you'll probubly only want to read section 3 .

m

T 1
L

8 ¥
i

With the mouse, move the cross polnter to the
far right dot on tho top row.

= Mova the polntor so that the Intersection of the
vertical and horlzontal lines of the cross rests
on top of the dot. :

ih e
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The dot appears as an invened dot in the center of the cross,

= Click the mouse button once. Try not to move
the mouse as you click,

= After you click, move the polnter.

A durk squure aprcm in place of the dot. This dark square
represents u pixel. A dark spot now appears in the
upper nght comer of the six characters in the style window.

= Usae the mouse to posltion the polnter on top of
the plxel you Just created,

= Click tho mouse button once,
The pixel disappears. In its place is the dot.

= Move the cross polnter to other dots and
praclice creating and removing plxels.

Notice buw the charucters in the style window change each
Lme you click the mouse bution.

= Paositlon the polnter on the upper right corner
dot agaln.

= Press the mouse button and hold It down ag
you drag the mouse In a stralght line down the
far right row of dots. Relcase the mouse button.

As you drag the mouse, the column of dots is replaced by a
column of pixels. As you press down the mouse button and
drag the mouse, euch dot the pointer crosses becomes a

ixcl. When you release the mouse bution, the changes you
H;wc made in the edit window are displayed in the style
window,
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= Poslition the polnter In the far right column of
the bottom row.

= Press the mouse button and hold It down as'
you drag the mouse In a stralght line up the far
right row of pixels. Release the mouse buttan.

The column of'pixcls is restored 1o a column of dots and the
“A" is restored to normal. |

&y,

w,
S, 74
o‘:’!@, , C'o&

e
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3. Edilng So far, no mention has been made of the blinking dot in the :3 ove the blinking dot
Characters wlth far left column of the top row, This dot bocomcgimponam = Use the armvr km‘;;;c:om gl | lon%s Fa
tho Apple and only when you want 1o use the keyboard 1o edit characters, over the pl.)'te “on p
Arrow Koys top of the “A.

= Press the — key.

ol al

A = Press the O key.
The blinking dot moves one dot 1o the right.

‘ The pixel disappears and is replaced by a dot.
= Press the « key.

e B - AR
S | ias)] jes] s ]l ]|=e:]]=

il

The "A" characters in the style window are alicred.
The blinking dot moves back into the far left columa,

Press the ¢ key.

al
]

Ld

= Press the | key. ..
y The pixel is restored. The "A" characters in the style window

The blinking dot moves down one row of dots. Q(/&é\ p = are restored (o normal, :

F..

N |

Pressing the # key places a pixel on the point occupied by the
flashing dot. Pressing the O key removes a pixel on the point
marked by the flashing dot. :

= Press the T key.

al

The blinking dot moves up one dot into the top row.,

Cq,. Cs
%, g
%4 /) [
&

A :
. 6\40?/4( . [4)’ "l use the FontEditor to change the "A" character.
= Press the — key and hold It down. 4(4?@,—793 gk s
i 9

far right column of a row, It then "wraps around” by dropping
down u line and starting at the far left dot on the next row,
moving to the right again. When you reach the far right dot on
the botton row, the dot wraps around 1o the far lefi dot on the
10p row.

I
L)

The blinking cursor moves from left o right until it reaches the ‘9'{
=

-
e

I
Ty

e
I

= Now press the « key and hold It down.

"l

The blinking cursor moves from far right to left until it reaches
the fur left column, at which point it moves up one line and
starts moving to the left from the dot in the far right column,

e ix

= Try pressing and holding the T and | keys.

ia

Unlike the ¢ and— keys, the T and | arrow keys
don’t wrup around to the right and left.

i
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4. Changling a
Character

= Using elther the mouse or the apple and arrow
keys, remove the two pixels on the second row
of dols from the top of the edit window.

-------

= Add one plxel to the top of each of the véties) 7,
lines that make up the sides of the “A." % &2
7 <,

Gasasna

= Now place one plxel on each side of the lone
plxel on the top row.

Congratulations - you've used FontEditor 1o change an old
character into a new one.
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5. Putting a
Character Back
Into the font

So far, you've learned how to:

Vv select a character for editing;

J place a selected character into the edit windows;

¥ use the mouse or keyboard o edit a character,

Now that you've edited a character, it's time to learn how to put

your modified character back into the font.

= Choose Put Character from the Deslgn Menu or
press GP on your keyboard.

As you can see in the font window, the "A" character which

you've just created replaces the old "A* in the font.
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6. The Edit Menu
Commands:
Undo and Clear
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‘on your keyboard.

L]

(o)
. ’, Qf N
There will be times when you don't like the changes you\lg%: %6;4
made w a character. When you want to restore a characterto* o %
the way it was before your last modification, you'll use the = |
Undo command. -
Select the number "7" on the keyboard map and place [ #

It In the edlt window with Get Charactler.

al

Usling the mousae or the apple and arrow keys,draw a F
row ol plxels through the center of the "7."

(4
" -
If you're using a mouse, press down the button and hold it ; —_— a
down as you draw, releasing it when the line is drawn, U
F. i :;
el
firaes = ommm
_1 T
e =i
sdsisns Lt FJ m—
==

On second thought, maybe the “7" looked better without the
dash through it.

id.

Choose Undo from the Edit Menu or press GZ

bs

If you're editing with a mouse, the Undo command will
undo any changes you make 1o a character from the fime you
press the mouse button down to stant editing to the time you
release the mouse button,

9

m m mmm |
L

Junifos|luulfon] |} lun]

v

g

f"od,

If you're editing with the arrow and apple keys, the
Undo command will undo any changes you have made to a
character since the last time you performed any action besides
character editing. oo

Now that the "7" is returned to normal, you may decide that it
looked better with the dash, '

b

= Agaln, choose the Undo command or press CZ.
The "7" appears in the edit window,

The Undo Command always restores the character in the
window to the way it wus before the last command you chose.
If the last command you chose was Undo, a second Undo will
restore the character to the way it was before you performed the
first Undo.

There will be times when, even after using the Undo
commuand, you are still dissatisfied with the changes you've
made o a chiructer and you just want 1o start all over with the
character. If you're editing an existing font, you'll want to usé
the Get Character command to place the unchanged character
into the edit window and begin again. If you're creating a
font, however, you may want to clear the edit window of
pixels completely, by using the Clear command.

= Choose the Clear command from the Edit Menu
or press (4C on your keyboard.

The edit window Is cleared of pixels and a blank character
appears in cach of the windows in the style window,
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(3 i Wi

(9)
0,{-, 044.0\9 "
. iti o ol P = mand or press O; on
7. Commands ; So far, all the editing you've done 1o characters has been b%%/ {4y, =» Choosae the Shift Laft com i
that Modity by pixel. FontEditor also has commands which allow you B ) your keyboard.
an Entire modify an entire character at once, These commands are on !hc‘l(g?v 7
Character Design Menu. § '!)d‘

You've already used two of the commands on the Design Menu
== Get Characier, which places a selected character in the edit : e q
window, and Put Character, which places a character in the

edit window back into the font. The remaining commands on

the Design Menu are of 1wo types: shift commands and flip
commands,

L
!

{mlmie

= Salect the character "R" and place It In the edit
window with'the Get Character command,

M

"R" is shified one column of pixels to the left. The two
'I?f\lirml characters of the "R* are now in the far left column of
the matrix,

T

i

= Choose Shift Up from the Deslgn Menu or

Pross Gf on your keyboard, = Choose the Shift Left command or press O;

n
!

W boa

= agaln,
g - L
S = ) :

The entire "R" character is shified up one row of pixels. The

The far left column of pixels forming the "R* wraps around o
1op row of pixels forming the "R" wraps around (o the bottom s k

the far right column,
row,

I [ 1

2 W b b W e

Notice how the characters in the style window are affected,

L

= Choose Shift Down from the Deslgn Menu or
press G/ on your keyboard,

m m m m

The entire "R" characier is shifted down one row of pixels, The
"R is restored 1o normal,
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|

= Chooss the Shift Right command or press Q'
on your keyboard.

The far right column of pixels wraps around 1o the lefi
column as the rest of the "R" shiflsponc column ot?piex:m::mc

righl. 0
‘%
= Choosa the Shift Aight command o ;ﬁre&s a
agaln, P Q.
*’%"f-?,o 4,9_%

The entire "R" is shified (o the right one column of pixels,
leaving the "R" as it was when you started,

——

You may have noticed that the & key Shift commands are
located in a directional diamond on the kcybo:trd. This makes

it c;m}y bath 1o remember the keyboard Shift commands and to
use them.
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The remaining commands on the Design Menu are the two flip
commands.

= Choose Flip Verilcal from the Deslgn Menu or
press GV on your keyboard.

The "R" in the edit window is tumed upside down, as are all
the "R" characters in the style window.

= Choosa the Fllp Vertlcal command or press GV
agaln.

The "R" is again flipped venically and is retumed to normal,

= Choose the Flip Horlzontal command or press
CH on your keyboard.

ssdvass
Bsnnase

A reverse-horizontal, mirror image of the “R" character appears
in the edit window.

= Choose the Fllp Horlzontal command or press
OH agaln. *

The "ai}" is again flipped horizontally and appears restored to
normal, ‘
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Changing the
Dimensions of a
Character

1. Changling a
Character's
Width
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MuliiScribe allows you to adjust the hc}'gh: and width of Vg od‘,%’._ =
charicters with the com s Change Font Height, Charac(g,a % "'Q

il

Wider, and Character Narrower. These commands are o b Vg uv, N4y,
found on the Size Menu, &%—@
Ay

v
In the section "About MuliiScribe Fonts" we mentioned that one :
of the great advantages of MultiScribe's treatment of characters B
and fonts is its use of proportional spacing, Propaortional
Spacing, you may recall, lets you create charucters of different
widihs and adjust the spacing between characters accordingly,

a  ad

Most word processors simply output to printers which use

chiructer sets in which each charucter is built on 3 grid or matrix

of the sume dimensions. An “I" and a "W" must occupy the :
Saime space, so the "W" appears somewhat crushed when

printed, whereas too much blank space surrounds the

al

8] |} { e {aw| 1 me

v ; — o=,
exclunation point, = Y
MultiSeribe, on the other hand, prints fonts using your printer's
graphics mode, so each MultiScribe characier can have its own ; -
uniyue width and spacing, i
| =
To change the width of a character you'll use the Character q —
Wider and Character Narrower commands, [ ]
Choose the Character Wider Command from - =

the Slize Menu or press 0= on your keyboard.

An extra column of dols is added 1o the far right side of the
character prid in the edit window, DBecause each of these dots
can be edited 1o become pixels, you've just increased the
charucier widih by one pixel,

H [ 1 |
B

Using the Charicter Wider Command, you can increase the
width of a chiaracter up 1o 28 pixels,

m T mm m m
u'l..la-.u-l‘d

L3

eSS

I7i

= Choose the Character Narrower command from
the Size Menu or press G- on your keyboard.

The exma column ofdolsdyou just added has been removed,
reducing the character widih by one pixel.

The keys used in conjunction with the O key to produce
Character Narrower (G3-) and Character Wider (3=) are log:au-.d
next to one another on the keyboard. Character N:lrmwc'r is
associated with the minus sign, whereas the Character Wider
Commund is associated with the “=" key, which has the plus
sign ("+") as its Shift character.,
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2. Changlng the While the characters in a fon can have their own unique width, . —

Helgh? o?a Font b st all share t?crfmc height. fT 0 change the height of a D 5 = Click on the Font base line Input bar or press
character or group of characters in a ont, you must change the base
height of the entire font. " ; i 3 the — key 1o move the cursor to the Font

Ty line Input bar.
= Choose Change Font Helght from the Size L]
Monu. - = = Change the Font base llne value to 10. Click
‘ (a) ' on the OK button or press the Return key.
A dialog box appears, ; (0 l
‘ 08\ T > The Font base line n}aﬂkcr is changed and appears closer to the
r o Q bottom of the edit window.
Change Font Reight *?q,,'kf;,ml‘_ D 3
1l BT 3 A MultiScribe fonts and
S T e When it cones 1o saving your work, treat Mu :
iaht: e o o P Saving Your it ith the“sante -- save 1o disk often. Savin
Font height: Fonl base fine: O’i"( ‘s Font ﬂﬁ'm;sﬁﬂ l::*)rsr;uclr‘l{l'sca::nrfi can often save you hours of”
. 1ally in the event of a power failure or interruption.
. Press (RETURN) bress 650 || ol A
5 _j (R = Choosa Save from the File Manu or press ¢S.
The dialog box contains input bars for fon height and base line, A dialog box appears because the Sa'w.? 0F FAlt b
The input bars contain the current font height and base Jins o completed without additional information.
vialues. -
- L_] Save fs
i = Change the Font Helght value to 12. Click on
i the OK button or Press the Return key. [ } mtn: _l
’ Two additional rows of dots appear undemeath the character in B — [REE: Ky Font |[brie 1] press o1
the Edit Window, and Lhcl charicters in the font window have A

—
e i

‘ increased in height. You've Justincreased the vertical size of
! your font. ;

[ Save ] Peess REu [trize 2] Press 62

Caneel | Press (ESCH Palh Press AP

r-.—_..
g

Notice, however, that (he base line marker in the edit window
has not been changed,

[

Thie Save button on the dialog box is disabled because you must

l Choose Change Font Helght from the S| specify the path 1o which the font is to be saved.
= Choose Change ze

B
=
| iont saiin B
k
.

r
?

I

"
b Lok Wk ow w w gl

= Click on tho Drive 1 button or pross (1,

Once again, u dialog box Bppears on the screen, The disk drive whirs and the pathname of the disk in drive 1

appears in the PATH input bar,

el
+

7z,
i
t




= Click on the Save button or press Return.

Your font is stored on disk and the dialog box disappears.

Now you've given your font a name and saved it on disk. The
next ime you save your font, FontEditor will automatically save
this font under the nume “"My.Font" and on the path you
specified.

= Choose Save irom the File Menu or press (S.

A message box appears, telling you that FontEditor is saving
your font, and the name under which it is being saved.

It you want 10 save your font on a different path or under a
difrerent nwme, use the Save As command and input the new
pathname and fontname for your font.

(4

),
RN

How saving “SIAKESPEARE"
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Opening a Font
for Editing

The FontEditor Open command is very flexible. It allows you
to open several fonts at one time. In fact, you can open as many
fonts as you have room for in memory. What's more, you can
open a single font several times, thereby creating duplicates of
that font in memory.

Let's use the FontEditor Open Command to look at some other
fonts.

If you're using a 5 1/4" drive, the fonts which come with
MaltiScribe are ull located on Side 2 of your disk. The only
font on Side 1, the FontEditor side of your disk, is the font
you just created and saved, "My.Font,” which is still open
and displayed on the Fonuiditwr screen. Remove the disk
from your disk drive, tum it over, and insen Side 2

into the drive. Close the drive door.

= Choosa the Open command from the Flle Menu.

A dialog box appears.

£;en Fonl 700 frea an wol
[Pin AT RiaEs |
i S | hress ol
et = 1 Ry
e | | CaDa U
TR { Palh | Prass 6P
mLien 5 il e
BRATE ( -[.L”-ﬂ—-———"" il
[HIA] 1| Lrn ] peess caenuan
(e g vz ) peass st

Because you last saved to the drive 1 path, FontEditor reads the
disk in dnive 1 and displays the fonts it finds there in the scroll
window of the dialog box,

= Scroll the llst In the scroll window by clicking
on the scroll arrows or using the | and T keys.
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The highlighted bar scrolls down through the list of fontnames
until it reaches the bottom of the list. As each fontname is
highlighted, that font is fticcted. You can also select fonts by
ulk'mk” the mouse 10 place the pointer on the fontname and
clicking.

Select the font "Shakespeare” and click on the
Open button or press Return,

(=

The dinlog box disappears and the Shakespeare font is now’{?%"f%’

displayed in the font window.

Note, however, that ihe leter in the edit window is the "R"

character from “My.Font." Until you choose the Get Characler

command, the lust churacier you selected and placed in the edit
window stays there, even wien you open a new font. This
F“U“ s you o mnove characlers from one font into a different
Ont.

If you're using a mouse, you can also open a font by double-
clicking on the name of the desired font.

Choose the Put Character command or press
P,

‘The "R* from "My.Font" is placed in the Shakespeare font.

Don’t worry -- you haven't ruined your Shakepeare font, Your

© fonts remain unchanped on disk as fong as you don't modify

them and save your chunges.

You may be wondering what's happened to "My.Font."

Pull down the Font Manu.

The Font Menu contains two items: "My Font" and
"Shakespeare.”  There is a check mark ()‘(J) beside Shakespeare,
which micans that it's the font currently selected, the font which
appears in the font window, The font last opened remains the
sclected font until you choose a different font on the Font
Menu,
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Closing Fonts

= Pull down the Font Menu and chooss

"My.Font.”

“My.Font" is now the font in the Font Window and a check
mark (V) appears beside "My .Font" on the Font Menu,

As you've chosen the Save and Open commands from the
File Menu, you've probably noticed that the Quit 10 MultiScribe
command is disabled and appeurs dimmed. Before you can
quit FontEditor and neturn to MultiScribe, you must close all
open fonts.

Choose the Close command from the Flle
Menu or press CK.
Because you've made changes to My.Font - you put a

charucter back into the font and changed the font's height — &
dialog box appears, asking if you want to save your font.

You have mada2 eliinges lo your fonl.
Do you wish to SAVE it before closing?

[Yes | Press ¥ Press (ESC)
[lt] Press

= Slnce you've already saved "“My.Font" on the

other sldo of the disk, click the No button or
press M.

"I'a{y.Fonl" disappears from the font window and the Font
enu.

Before you can quit, however, you must still close the
Shakespeare font.
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= Choose Close from the File Menu or press GK. l _ ‘o
» b)) :vi by
You're again asked if you'd like to save the changes you've : — il
made to the Shakespeare font 6 :
: |
= Click the No button or press N. F m— ] |
The FoniEditor screen is cleared, leaving only the Menu Bar, D : .L __________
F ] q I ———————————
[] |
Quitting To quit FontEditor you'll use the Quit to MultiScribe comppand. g I
FonlEditor (%’ D }
= Choose Quit to MulliScribe from the File Menu.(«o - -y |
%%, U '
The MultiScribe tile screen appears, followed by the mepisbar < - |
and document window of the MuliScribe screen. %O&/'ﬁ F" = :
. 2 co,
If you're using a 5 1/4" drive, a dialog box appears, '%0(‘_ ; |
asking you 1o insert side 2 of the disk into the drive and press "< i, m |

Return. Remove your disk from the drive, turn it over, insert
side 2 into the drive, and press Retum.

Using
FontEditor
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Contents 199 Introductlon ; If you' : i
you've read Chapter §, you've used each of FontEditor’s
200 Starting Up Font Editor [] . gl Gali commands. This chapter provides step-by-step instructions for
201 Choosing A Font To Edit : 2 using each of the commands you experimenied with in the

201 Crealing A New Font previous chapter.

202 Opening An Existing Font
203 Choosing & Character To Edit
204 Selecting a Character on the Keyboard Map
204 Placing a Selacted Character Into the Edit
Window Q
205 Editing A Character %
206 Editing a Character With a Mouse <
208 Editing a Character With Keyboar\t‘{;@
210 Undoing Changes to a Character %
211 Cleanng the Edit Window )
212 To Shift a Character Up o 9,
213 Flipping a Character '%,/
214 Changing The Dimenslons Of A Character <o
215 Changing The Wiath Of A Character 3
216 Changing The Height Of A Font
217 Managlng Fonls
219 Saving Fonls
221 Closing Fonls
222 Quitling Font Editor
222 To Relurn To MutiScribe
222 To Quit To ProDOS

1

v ¥

Tusks you perform with FontEditor fall into four major categories:
choosing a chamcter to edit, editing charucters, changing the
dimensions of characters, aund managing fonts. This chapter is
divided in1o sections which deal with each of these categories. It
beyins with instructions for stating up FontEditor and choosing a
font lo edit.
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Starting Up

FontEditor

=Choosa
FontEdItor from
the MultlScribe
& Monu.

If you've made any
unsaved changes to
your current
document, a dialog
box appears, asking
if you wunt 1o save
your chunpes. If you
wint your chanpes
saved, click on the
Yes button or press
Y: if not, click on the
No button, or press
N. Clicking un
Cancel or pressing
Esc cancels the
operation,

(&)
<,

If you're cuging a

5 14" driw& iglog
box ap casking
you 1o insefpside of7
the Mulu’Scribq? ]
Remove the o Q(
MultiScribe disk %
from the drive, um i{/Q
over, and insen side
1 into the drive,
Click on the OK
button or press
Retum, Hlyuu click
on Cuncel or press
Esc, the operition
will be cunceled and

ou'll remain in
fultiSenbe.

s o

“memory.
e

'fucmu

titles.
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A dialog box
appears, telling you
that FontEditor l};o
being loaded into

itor is loaded

isk into
the

m®hu titlePon the
menu bar change 1o
the FontEditor menu
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Choosing a Font to
Edit

Before you can begin 1o

edit characters, you must
select a font to work with,
This section explains how >
to use the New command 1§
create a new font and how

10 use the Open command

10 edit an existing one,

Creating a New Font

You can create a new font
with the New command.

26! CHOOSING A FONT TO EDIT

1. Choose New from the -
Flle Menu or press CN.

A dialog box containing
empty input bars for Font
name and Font number and
buttons for OK and Cancel
appeurs,

You can move between the
fontname and font number
input bars by chivking on
the desired input bar or
using the « and — keys or
OGTab and Tab,

e ———————— . e —
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2. Enter the name of
your new font In the
Fonl name Input bar.

FFontnames can contain
frum 1 1o 15 characters, but
the first character must be
alphabetic. All other
characters must be leuers,
nutilers, or perieds; you
wol't be allowed 1o enter

! siety O punciuation

Charie ters other than

periods,

If you enter an illegal

fonmame and choose OK,
your Apple will beep and
your fontname will not be
accepted. You must then
delete your old fonmname
i enter a new one,

3. Enter a number from
201 to 254 as the Font
number for your new
fonl.

You can enter font numbers
in the range | 1o 254 only;
if you enter a number
greater than 254 or less
than 1, the menu bar will
flush, your Apple will
beep, and the input bar will
be cleared.

4. Click on the OK
button or press Return
()
%
<<~

IE W

TE

?

Your new font appca:f@ Ty
the Font Menu, with its  *
font number 1o the left of 4
the fontname; it won'l
appear on the Open
command scroll window
until you save the font with
either the Save or Save As
command.,

If you choose to click on
the Cancel button or press
Esc, the New operation is
canceled.
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Openling an
Exlsting Font

You can open an
existing font using
the Open command.

i e i s 3

1. Choosa Open
from the Fila Menu
or press GJ.

A dialog box
appears.

The dialog box
contiins an input bar
for PATII, a scroll
window, bultons for
Bﬂh (Drive 1,

rive 2, Path,
List Vol.), and
buttons for Open and
Cuncel. The scroll
window contains a
list of fonts on the
current path,

If you've not yet
sclected a path, the
scroll wmcrow
contains a message
instructing you to
specify the drive or
path from which 1o
read the font you
wish to open,
Choose Drive | or
Drive 2, or choose
Path and type a
Balhn ame in the

ATI input bar, If
you're not sure of the

name of the path
which contains the
fonts you want to
edit, click on List
Vol. or press AV 1o
list all online

volumes,

2. Select the
name of the font
you want to open.

o 0r you're
using a
mouse, click on
the font name or
scrull the list by
clicking on the
scroll arrows.

¢ If you're

using
keyboard
cunlruols, scroll
the list using the

Tand ! keys.

263 OPENING AN EXISTING FONT

d. Click on the
Open bution or
press Return,

A copy of the font
you choose 1o open is
read from the disk
il memory. Any
changes you make to
the lunt won 1 be
pernuinent until you
save them back 1o the
disk.

You can also open a
font by double-
clicking on the
fontname.

Clicking on the
Cancel button or
pressing Esc cancels
the Open operation.

- SRty

PP



i

19

i

When you use the New or Open command to create or open &
font for editing, the FontEditor screen appears. The
FoniEditor screen contains a menu bar and four windows.

Choosing a
Character to Edit
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| When you edit a font, you change it character by character, To B
edit a font, you'll begin by editing a single character,

b e lal
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This section explains how to choose a character for editing
- how to select a character on the chboard map and then
plauc that character into the edit windo
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Selecting a
Charuacter on the
Keyboard Map

= Click on the
key on the
keyboard map
which represents
the character you
want to edit, or
click on the
character In the
font window you
want to edit, or
press the
corresponding key
on your keyboard.

The character you
selected is
highlighted in the
font window,

If you're using a
mouse, clicking on
the Shift key toggles
between uppercase
and lowercase for
alphabetic characiers
and between the
u;mpcr and lower
churcters on each
key for numbers and
special chiructers.
You can also
disregurd the Shift
key altogether and
just click on the
character in the font
window, if you like,

If you're using
keyboard
contruls, the
charicter you select
corresponds direcdy
to the churacler you

ress, If the Cups

:k key i1s down,

pressing an
alphubelic key selects
the uppercise
Churacter, while
pressing a numeric or
special character key
selects the lower
charucter on the key.

Placing a Selected
Character Into the
Edit Window

= Choose Get
Character from
the Deslgn
Menu or press
4aG.

The selected character
is pluced in the cdit
window,

265 SELECTING A CHARACTER ON THE KEYBOARD MAP
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Editing a Character This section begins with instructions for cd:o a character = o
with both mouse and keyboard controls. The®it Menu Editing a 1. Use the 2. Place the 3. Click the
commands, Undo and Clear, are cxptaincg nex ,gBIIowed i Character with mouse to move center of the mouse button.
by the Shift and Flip commands, @ % > {: '§ & Mouse the polnter Into cross on the dot
%70 the edlt window. | or pixel where
e % - you Intend to
% &, o E I begin editing.
m e
% 9 ”’3'7 - : The pointer changes The dot or pixel Qlicking the mouse
e % 7,?’ [ J shape from an arrow | becomes inverted. inside the character
i (0 a CTOSS. id;
B . I gri
UF q The dols in the edit ¢ changes dots
window character ) to pixels;
grid become invernted
; : when the cross ¢ changes
passes over them. pixels 1o
dots.
E q The dots in the edit
= & window represent The characters in the
blank or "off" pixels; style window reflect
the dark squares - the changes you've
E i which form made to the character
characters are filled ; you're editing.

or "on" pixels. For
the sake of clarity,
we'll call blank pixels
dols and filled pixels
pixels, :

¥
L

¥ ¥
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4. To draw or o Edlting & 1. Use any of 2. Press the @
remove a line, [} Character with the arrow keys key to place n'
place the cross o =) Keyboard to move the plxel on a dot;
pointer on the ' Controls blinking dot In press the C key
dot or pixel - the edit window to remove a i
where you want s m _; character gr]d pl!ﬂl.
1o bqgln D fo the dol or
editing, press - pixel you wish
down the o to change.
mousa bulton, D a
and hold It as - If S If you press the — If you press the
you press the youp g
you drag the | e :] key while the key while the key while on a dot,
mouse over the D blinking dot is on the blinking dot is in the lhc’ ?lt'm r:(nlnams
line. B . = 1op row, the blinking | rightmost column, HREIECled,
o - dot wraps around 10 the blinking dot Diessing the'd ke
If you press the If you press the D the bottom row. drops down a row Ik ¥ b | y
" : : and wraps around to while on a pixe
miase button with mouse button with = q G vl l likewise has no effect
the <1088 pointer on & the cross pointer on a ; i The GOt also EdEAE R ERIET: on the pixel
dot, pinels will be pixel, the cross D mue: if you press the :
pliced on every dot pointer will emove = =3 1 key while the If you press the &
over which you drag cvery plxcl over lpgd el blinking dot is on the key while the
the cross pointer, which it passes. U botiom row, the blinking dot is in the
Pixcls remain Dots will remain — blinking dot wraps lefunost column, the
unallected, unafrected, B mmom E ) around to the top blinking dot moves
; row. up one row and
Blotu"c the effects of E [__] WI’::I'])S around to the
¢ chinges you ey far right col )
muake on the i 3 L
characters in the style [ _J
window, i
% t
2..& A
‘3%‘1;% KP E r----] 5
S ,
"!VO Od\‘ ’90, t weeyen j
L 7. S =
sy
% %%,
%% E=4
%o O, £
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3. To draw &
\ine, hold down
the & key whlile
pressing an
arrow key.

To create vertical
lines, use the T and
 keys.

To create hon’zonuqué

lines, use the «— and
— keys,

4. To remove a
line, hold down
the O key wiille
pressing an
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Undolng
Changes to a
Character

There will be times
when you don't like
the changes you've
made 1o a character.
The Undo command
lets you retract the
most recent chunges
you've niade to a
characier.

= Choose
Undo from the
EdIt Menu or
press OZ.

The most recent
changes to the
character in the edit
window are undone
and the character is
restored 1o the way it
was before you last
stanted editing it

The most recent
changes you've made
1o the charucter in the
edit window are
undone und the
character is restored
to the way it was
before you started
editing it.

If you're using a
mouse, the Undo
command will undo
all changes you make
10 a character from
the time you press
down the mouse
button to start editing
to the time you
release the mouse
button.

If you're using
keyboard

controls, the Undo
command will undo
all changes you make
1o a characier from
the time you last
performed some
action besides
character ediung.

211 UNDOING CHANGES TO A CHARACTER




Clearing the EdIt
Window

Whenever you want &
"clean slute™ in the
cdit window, you'll
use the Clear
command.

= Choose
Clear trom the
Edit Menu or
press GC.

The edit window is
cleared.

Shifting a
Character
<
Y
%
o9 :
You can move f,? 44{» ’th!kcyboard
character around h’?é‘ ( mmands for
the character Igrld quﬁifw\g forma
using the Shift dio nlrﬁmmond

comminds on the
Design Menu, When
you choose a Shift
command, the
churacter in the
churucter grid is
shifted one row or
column in the
direction specificd by
the command.

::’{?x?ydo n. ] igd%.

the left, and * is to
the nghl..
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To Shift a
Character Up

= Choose the
Shift Up
command from
the Design
Menu or press
al.

The character is
shifted up one row in
the characier grid.
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To Shifta
Character Down

= Choose the
Shift Down
command from
the Deslgn
Menu or press
&3l

The character is
shified down one
row in the character
grid.

To Shifta
Charactertothe
Leh

= Choose the
Shift Left
command from
the Deslgn
Mianu or press
(&)

The characteris
shifted one column to
the leftin the
churacter gnd.
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To Shifta
Charactaerto the
Right

= Choose the
Shift Right
command from
the Design
Menu or press
5

The churicter is
shifted one column 0
the right in the
character grid.
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Flipping a
Character

You can reverse the
way i character is
displayed on the
soreen bath

honzontally and
verieally using the
[lip conunands on the

Design Menu,

To Flip a
Character
Vertlcally

= Choosa the
Flip Vertical
command from
the Design

Menu or press
av.

The character appears
upside down.

If you choose the
Flip Venicul
command aguin, the
chiracter will appear
nghtside up.
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= Choose (ﬁ'o f{?/ @40

Fllp Horlzontal " §a
command from

the Deslgn

Menu or press

GH.

The character appears
facing buckward.

If you choose the
Flip Horizontal
command again, the
character will appear
facing forward.

Changing the
Dimensions of a
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MultiScribe allows you to use characters of different widths
and heights in the same document. FontEditor provides
commands for modifying the widths of individual characters

as well as the height of an entire font.
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3. Enter a new
font base lina
value.

To enter a new base
line:

=5 Use the Delete

keys 10 delete the
current value.

= Lintcr a new font
base line value,

If you wish to go
back 1o the Font
height input bar 1o
make further
changes, use the
mouse (o click on the
Font height input bar
or press the & key.

(&
4 0‘5’6‘

)
%% 04/_{_06'
4. When yotkre? 4, N
satisfled with * Sy 5, “Zo.
the font helght <, % %,

and base line (’(o :"{;», @406

values, click on
the OK button
or press Relurn.

The changes you
make are reflected in
the edit, style, and
font windows,
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279 MANAGING FONTS

In addition to the New and Open commands already
discussed, the FoniEditor File Menu provides commands
that allow you to change font numbers, save and close
fonts, and retum to MultiScribe.
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Gy, Y& : u're
Changing the Fopy 1. Choose Change | 2. Epger 8 nu Uty 5 4/%( _ F — o Saving Fonts '1 Chlohosznsaavo :’.a Lflnzoa o
Number ota Font | pory # from the from 201 to 254 Sp S, Sy d it the first time
Filo Menu, the Font Number S Svs, M, o £~ g th
o Y hg - type the pa
Input bar, o, &5 = ‘:] Unless you're saving and fontname c',-’r’;";’m'{‘;‘,,;“;,;‘ﬂ”

s | £y i, | |
E\'c?' MultiScripe A dialog box Like the New The fony number jg Fontditor. 3 dialog you'd like your is displayed whhen
font has » unique font appears. Tle Change commung dialog box, [ not assigned o the ] onu pears [cljjng font saved, ou click on the Save
number, Fonpg Font # dialog poy the Change Fong g VErsion of the fong on e 5 ,rf.pn-“n}; of the Click on the E“”"“ OEPress
flinters | through l0oks similar 1q the input bar checks o isk unrit yoy save F i q F( - bL.L' : aved on bullon or Retum,
200 re reserved for lew dialog box, and verify that (he the fonr wish irg anl s Savo bu il
font, Provided by functions i much the | pumber You input s changed fop number . : i Press Return, The dialog box asks
Sty leWare, |y You S4me manper., in the funpe | 10 254, back 1o djgp with the F o ; If you're saving a if you want 1o replace
CTEA y our own foqy, ccuuse the fon ave commang, If y f YO'.'Zm:h' l'rf} ime | Fonthames can be the font on disk wih
4L b Because the Change nunbers from | 1o You chinge 3 fony's J ot . from 11015 the one you're
Liom 201 If\.fl.lll_l:_h Fong u Commung jg AIC reservey, you | number and choose F : ; ;"”—‘I_‘”;.‘“’""B&' alo charactery long, but saving,
254, but b carefy) used with g, shouldn't enger 5 ¢ Open commyng Sl ™ i the lirst character jn
DOLLO pive i g existing, open font, Number Jess thap from the Fije Meny X dppears wg't the fontname must be |
NUIT alrefy the Fong Nonje input | 201, for qs input bars alphabetic. All other
e 0 another bar uf (e Change

for the puthname and

fontname of 1he font

you're saving, This

1510 allow yay o

specify a path 1o )

which your fopys will
saved,

characters in the
fontname mys be

leners, numbers, or

periods. Spaces or

Punctuation markg

other than periogs are l
not allowed.

funt on your

Font # dialog boy
MuluScnbe disk.

already coniging the
mme of ()e curren)
selected fong and (he
inseron point is in
the Fony Number
input bar,

Funthermore, you're
ot allowed 10 myye
fiom the Fopy
Nutber input bar 1o
the Fung Nume input
bar, as under the

‘Cw commany,
Which plices the
Insertion poing jn an
empty Font Naine
input bar, ang ullows
YOu 1o moye among
the inpur bary with

the « and — keys.
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To allow ater
ﬂexibiUry In the
hnndling of fons,
FoniCyjior does not
check 1o verify that
youdon't give the
font a numper alread
used by ano)er font
on the MuliiScribe
disk, so be careful
when yoy Assipn fong
numbers with (he
unpe Fong #
Comnying,

disk, the o number
displayed begjge the -
oninume of 4 -
Fam'culgr font is the
ont numper assigned s
o it whep j; was last By

L P
saved,

before suaving (he ; 'J
changed font back 1o o .‘:Jf' =3
sy
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If you click on the
Yes bunton or press
Y, the font you're
saving replaces the
font on disk with the
same rame. 1 you
chick on the No
Button ur press N,
sou'te retumed o the
Nt it bar of the
previcads diadog box.
Choneang Cancel on
thu Yok nl\.] \Il.lh Y ll)!
by Clic kg on the
Cancel button or
presane Ese cancels
the enure Save
uperat.on.

The Drive 1, Drive 2,
and Path buttons let
you save your font
on a dillerent disk or
ath. Clicking on the
Jrive | button or
pressing (I selects
the disk volume in
drive 1 as the path
under which your
font will be suved.
Clicking on the
Diive 2 button or
pressing U2 selects
the disk volume in
dnve 2 as the puth
under which the font
will be saved.
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Clicking on
button or pressing

GP lets you specifydp S
A

the pathname under

which you want your

font saved. If you
need 1o know more
about ProDOS pitths,
see Appendix D
"ProDOS Pathnames
and Filenames."

Clicking on the
Cancel button or
pressing sc cancels
the Save operation.
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Closing Fonts

Before you can quit
FontEditor, all fonts
must be closed.
There will also be
times when you need
to close fonts to free
up space for other
fonts you wish to
open. You'll use the
Close commind 10
close open [onts.

=» Choose
Close from the
Flle Menu or
press CK.

If you haven't used
the Put Character
comimand to replace a
character in the font
you're closing, no
dialog box appears
and the font is

closed.

When the last open
font is closed, the
Fomliditor screen is
cleared except for the
menu bar and the
Quit command may
be used.

If you've used the
Put Character
command with the
font you're closing, a
dialog box appears,
asking if you want 1o
save the changes
made to the font
before closing it.

If you click on the
Yes button or press
Y, your most recent
changes to the font
are saved on disk and
a box appears telling
you the name of the
font being saved.
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If you click on the
No burton or press

N, the font is closed
with your most recent
changes 10 the font
unsaved.

If you click on the
Cancel button or
ress Esc, the dialog
x disappears and
the font remains
open.




Quitting
FontEditor

You can quit
Fanttador and retum
to Mulisenbe with
the Qo
MadtiSonbe

cortintd.

= Choose Quilt to
MultlScribe from
the File Menu or
press C'Q.

The MultiScribe
commund remaing
dimnied und con't be
used untld all open
funts are closed.
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When you choosc the
Quit to MuhiScribe
command, the
MultiScribe title
sCreen appears
bricfly, [ollowed by
the menu bar and
docunient window of
the MuliiScribe
sereen,

'ﬁ"o&ﬂ 1 § S ) S 3

|
L
If you're using a '
5 1/4" drive, a dialog |
box appears, asking ‘
you 1o insert side 2 of & :

the MultiScribe disk
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The O Menu contains miscellancous commands which perform
functions that don't fall under any of the other menu categories.

This command provides you with information about the author of the
program and the version number of FontEditor on your diskette.

The Invert Screen command reverses the way things appear on the
screen. When you choose nvert Screen, what had been dark on the
screen appears light and what had been light appeurs durk. For
example, if your screen currently has dark characters on a light
background, it will be redrawn 10 show light characters on a dark
background when you choose this command. Choosing lnvert
Screen again would restore the screen to dark characters on a light
back ground,
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J‘ .
Flle Menu 00‘5_ :8' e O,J The File Menu contains commands for creating new fonts and for
".4/‘5 d}A\p %y modifying and maintaining old ones.
1 AP NCS
] o‘é,

Kew ol %, 0 o

Dpen. 6) {V4 0"5. N

Closa ot Ay "'7;::) <

Chinge fonl & A

Sive s : \%;.

Sive fs... &h O)O

Ll lo fuliSeribe 60
Hew This command lets you create a new font.
=y The New command may be used any time that FontEditor is in use.
t You can create as many new fonts as you like. The only limitadon
( ) placed on the creation of new fonts is lack of memory. Ifyou

e s o anempt 1o create a new font for which there is not enough room in

Hace ot memory, a dialog box will appear to alert you to the lack of memory

Chinge font 0 8 space for the new font.

Save (i

Gaunre (op]

L il ¢ " ;

BRI Alnost out of memory. Closing files

will free up space.

[ 0K IPress (RETURN)

for the new font.
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This message suggests that you close some open fonts to make room
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When you select the New command, a dialog box appears at the
top of the screen.

Kew Fon!

Font mases [ |Font nucbers[ |
Press (RETURK) [ Cancel | Press (ESC)

The New dialog box contains an input bar for the new fontname, an
input bar for font number, an OK bution, and a Capccl button. You
can move between the fontname and font number input bars with the

& and — keys or Tab and GTab. '

The input bar prompls you for the name you wish to assign 1o your

new font. The rules for naming MaltiScnbe fonts are the same as

those for ProDOS filenames: fontnames can contain no more than

15 characters; the first character of a fontname must be a lener; all other
characters must be lenters, numbers, or periodds (no spaces or
punctuation marks other than periods are accepied).

You can enter font numbers in the range 110 254 only; if you enter a
number greater than 254 or less than 1, the Menu Bar will flash, your
Apple will beep, and the input bar will be cleared.

When you've typed in the name you wish to assign to your new
font, click on the OK button, or press the Retum key if you aren't
using a mouse. If you enter an illepal fontname and choose OK,
§0ur Apple will beep and your foatname will not be aceepted.

ou must then delete your old fontmne and enter a new one,
Clicking on the Cancel button or pressing the Lsc key cancels the
operation,
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Once you have created a font, its name and font number appear on
the Font Menu. The font will not appear in the scroll window of the
Open command dialog box until the font has been saved to disk.

]

HERILCUAY
STRIDARD.08
LORDSLORTH
LA TEAIY
HILTOH
DANTE
ASHY
CIIAUCER
SHAXESPEARE
18 HICHELANGELO
/281 Hy.Font

The new font remains the cuntml;@lccwd font until you open or
create another font. =

D CD = O L1 o Cad PN e
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The Open command reads a font from disk and displays it for editing
on the FontEditor screen.

The Open command may be used at any time under FontEditor. You
can open as many fonts as you like, and you can open the same font
as many times as you like. The only limitation placed on the number

" of fonts you have open is lack of memory. If you attempt 1o open

more fonts than you have room for in memory, a dialog box will
appeir on the screen 1o alert you 1o the Lk of memory for the font
you're rying 1o open.

flrost out of wencry. Closing files
will free up space.

| 0xX |Press (RETURHY

This message suggests that you close some open fonls to make room
for the font you wish to open, :

When you choose the Open command, a dialog box appears on the
screen,

Open Fonl 17K free on vol,
[PATH:_/L1ISCRIEE/ ]
LAl | beess 61
Sifa bl ] e
oo 5| [ [ite 2] beess 02

e 4 | [ [Pan ] press o
KLTON 5 il Vol ]

DAE ; “_ln;Lgil; Press &Y
ASIray : Oren | Press (RETURID

CHAUCER

(] l{llnul Press (ESCY

The Wtf(ii;llog—’lﬂx contains an |n|1:!h_1} with the current
athname, a scroll window, buttons for selecting path (Drive 1,
ve 2, Path, List Vol.), and butions for Open and Cancel,

291 OPEN

e g ity e e Y S s S S e




C

L

|
aou

To list the files and subdirectories on a directory, selzct the directory
by scrolling the scroll window until the desired subdirectory name is
highlighted. Open the subdirectory b{ double clicking on the

If you haven't already selected a path by saving or opening a font, a
message appears in the scroll window asking you to please select
drive |, drive'2, or path. MuliiScribe is asking you to specify a

e

pathname from which 1o read fonts. A path is either a volume - a
disk drive like drive 1 or a hard drive -- or a volume and
subdireciorics.

If you want 10 open a font on the disk in drive 1 or drive 2, just click
on the Drive | or Drive 2 bution or press 31 or 32, If you want to
open a font on a hard drive or on a subdirectory of a volume, click
on the PATIH input bar or Path button, or press GP, and enter the
pithname from which 1o read a font. A pathname can be up to 40
chariciers long, but each direetory in a pathname must be separated
from the other directories by a slash (/), and miust follow the
conventions for ProDOS filenames.

1

AL
H |

highlighted subdirectory name or clicking on the Open blunon_il'
you're using a mouse, or by pressing the space bar if you're using
keybourd controls,

Once you've sclecied a path by specifying the pathname or by listing
the volumies and directories 1o find the desired path, the scroll window
contains a list of all MultiScnbe fonts on the sclected path, displayed
from top to botlom in the order in which they were created. The first
font on the list appears highlighted, meaning ivis the sclected font, the
font which will be openced if you muke no other selection.

The file window can display up to 8 fonmames. To scroll the font

istin the scroll window:

¢ I you're using a mouse, position the
pointer on either the up or down seroll arrow
on the scroll bir and press the mouse button,
The narnes of the fonts on the current path
will be scrolled either up or down until you

If you don't know the name of the puth on which the fonts you want
t editare lovated, click on the List Vol. button or press GV 1o list all
online volumes in the scroll window. Volumes are distinguished from

files by being preceded by a slash and followed by the volume's slot
and drive numbers.

m /M T M M M WA

O T (.
T

— release the mouse button or reach the bottom
boon tanl et i or lop of the list.
(7T ] B ¢ If you're using keyboard contruls, use the
== o o T and 1 keys 1o scroll the list. The names
/M ;; A [orive 1] Press dl J of the fonts on the current path will be scrolled
. AT - up or down until you reach the bottom or top
e e Wi [!Tr_wg 2] Press 42 E e 3 o?lhc list.
HiRC ‘ | Press ap [ J
99\_‘5-‘\““ [i-iEII'Y:I-] beesy To open a font, double-click on the fontname or select the font by
{)03 A L 5 ;\sf fibinast], E — 5 clicking on the fontname if you're using a mouse; if you're using
e A Hgg oot [ Open | Press (RETURE) U keyboard controls, use the T and L keys to scroll through the fontname
i & list until the name of the font you want to open is highlighted. n the
1298 i] [Cancel] press (esoy e | font by clicking on the Open button or pressing the Retumn key.
selected font will be loaded into memory and displayed in the Font
To liseall the files on a volume, seleet the volunie by scrolling the Window. '
scroll window undl the destred name is highlighted. Open the t Gotesel :}
volume by double-clicking on the highlighted volume name or
clicking the Open button or pressing the space bar, Al directories
and files on the volume are listed in the scroll window. Direclories t = a
arc differentiated from files by being preceded by a slash (/7). D ‘
A 293 OPEN
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(pen.. -(.J;_d.!
Lhange font W T
Sive i}
Save As... ]}

fob Lo MaltiSeribe 40

The Close command closes the font currently in the Font Window and
selected on the Font Menu.

This command is usable only when at least one font is open and will
otherwise remain dimmed.

If you atiempt to close a font that has been changed since it was last
saved, a dialog box will appear, asking if you want to save the changed
font before closing it

You have wmade changes to your fnr_ﬂ.
Do you wish to SAYE it before closing?

[Tes | Press ¥ Press (ESC)
HE ] Press N

If you sclect Yes, the changed font is saved o disk and then closed. If
you chioose No, the font is closed with your most recent changes
unssved. If you choose Cancel, the Close command is canceled and the
font remains open.
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Change Font #

New &
0pen... dJ
(lose 1] 4
r:" e 4 s
yave ds
Save fs... o
fuit o taltiSeribe d0

|

As its name implics, Change Font ¥ allows you to change the
font number assigned to a given font. When you choose the
Change Font # command from the File Menu, the same dialog
box as that displayed by the New commuind appears:

Change Font Height

Fontheight: Font base line:
Press (RETURS Press (ES0)

and b

Because the Change Font # command is used with an existing,
open font, the Font Nume input bar of the Chunge Font #
dialog box already contains the name of the currendy selected
font and the insertion point is in the Font Nurniber input bar.
Furthermore, you're not allowed to move from the Font

Name input bar to the Font Nutnber input bar, as under the
New command, which places the insertion point in an cmpty
Font Name input bar, and allows you 1o move anong the
input bars with the & and — keys or Tab and OTab. Like

the New command dialog box, the Change Font # input bar

grjuicks 10 verify that the number you input is in the range 1 to

To allow greater flexibility in the handling of fonts,
FontEditor does not check 1o verify that you don't rive the
font 2 number already used by another font on the {uluiScribe
disk, so be careful when you assign font numbers with the
Change Font # command. Furthermore, the font number is
not assigned to the vension of the font on disk unnl you save
the font with its changed font number bac k 1o disk with the
Save command, 1f you chanye a font's font numiber and
choose the Open cummiand 1rom the File Menu before saving
the changed [ont back 1o disk, the font number displayed
beside the fontname of a particular font is the font number
assigned 1o it when it was last saved.
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Save

b
New (il |
Open.. dJ
(lace ar
(e fonl A al

Fintn lees T
fioit 1o fultScribe 60

The Save command saves the currently selected font on disk.

This command may be used when at least one font is open; otherwise,
it will appear dimmed.

i the
When you choose the Save cgmm.nnd, & dialog box appears on
scm:n’(o tell you which font is being saved on disk.

How saving “SHAKESPEARE"
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Save As
Fm
New
Dpen... 8J
Close (1] 4
Change font 4 4k
Save 45
e
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The Save As command allows you to save a font under a new path,
or a new fontname, or both.

As with Save, the Save As command remains dimmed and may not
be used unless there is at least one font open.

When you select the Save As command, a dialog box appears on the
screen.

Save As
[PaTi |
[144Z: My Fon | [Drive 1) Press 61
[Save ] press GErunn) [orive 2 | press 2
Cancel | Press (ESC) Press 4P

The Save As dialog box contiins ifl[l)llj-: bars for path and fontname,
ve 1, Dri

buttons for path selection (Dri ve 2, Puth), and butons for
Save and Cancel,

When the dialog box appears, the PATH input bar contains the name
of the current path, the last path from which a font was opened or 1o
which a font was saved. The NAME input bar contains the current
fontname, the last name under w hich the font was saved or the name

you gave it when you created it with the New command. The cursor
appears at the end of the current fontname.,

To move the cursor back and forth between the PATH and NAME
input bars:

¢ Il you're using a mouse, place the pointer inside the input
bar you wish to edit and click the mouse butlon,

1 you're not using a mouse, use the T and ! keys to move
the cursor,
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=l
:_ ; = Quit To MultiScribe ']'l;{hcl %uit_g': MultiScribe command quits FontEditor and retums 10
If you want 1o save the font under a different path, enter B new = e | uluscnbe.
athname in the PATH input bar or choose the Drive 1 o Drive 2 ' This command remains dimmed on the File Menu and may not be
Eunon. If you want to save the font under & name other than the current B = |t gl used until all open fonts are closed.
fontname, enter @ new fontname in the NAME input bar. When the = Open... 8l
input burs contain the fontname and pathname gndcr which you want J Llosk oK When you choose the Quit To MultiScribe command, the MultiScribe
e font saved, click on the Save button or‘frcsa the Rewrm key. Your™x % ; = 23 | thange font b 41 logo séreen appears, followed by the MulaScribe scréen. If you'e
font will be saved to disk, replacing the old font wilh the sume name. 2 g« e i & using a 3 172" irive. RAM drive, or hard drive, you've Mt o
% T % J ST da MuluScribe.
i 'é = E =13 r | If you're using a § 1/4" drive, a dialog box appears, asking you to
[FT) e G insert side 2 of the disk and press Retum; urm the disk over and
a4 O A Re
0 : press Retum.
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1 Tulear el any changes you make 10 a character from the time you
! ‘ | press down the mouse button to start editing to the ume
you release the mouse bution, ‘

w W i & &

o If you're using keyboard controls, the Undo command
will undo any changes you've made 1o a character since

| 3 )
S

The Edit Menu The Edit Menu contains commands to aid you in the pixel by pixel ) L
editing of characters. : - 4—.} The Deslgn Menu While the edit window allows you to change a character by editing it
o pixel by pixel, the Design Menu contains commands whic affect an
£ . Desian entire character at once. Design Menu commands allow you to:
Uada —_— P
(laap 2% = = Gel Character 66 « Getany character in a font and place
= __] Pul Charaeter 4P it in the edit window as well as Put any
dS  07INvd oys |- 86210 F prgeeanmy a ] character in the edit window anywhere
1€113 1V1S0d YXIVO j g g;:ln léi' gE in a font;
SOOVINVINATddY §0d RO F : Sh%l‘l Lz}? & « Shift en entire character one pixel at a
— Shifl Rishl &’ time in any direction,
Undo The Undo command allows you to undo changes you've made to __I Flip Verlical &Y ' . )
ey a character and restores the character to the way it was before you - Fiie Borizontal oK * Flip a character vertically or horizontally.
l'_— ' staned editing it. Hhiin P 1
i g « If you're using a mouse, the Undo command will undo F i.__]

the last time you performed any action besides character

| e ey

! editing. i 1
The Undo command cannot be used uniil at least one font has been = h —
opened and will otherwise remain dimmed. b -

=
-

Clear This command clears the edit window. mma
e ‘Mhe Clear command may be used only when there is at least one [ 1
Gl font open; otherwise it remains dimmed, .
lindo 42
i b v =
i

2]

W W kw W W
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Gel Character

A

PR o ——
(: a . g

Luut‘tr‘iracler'm"
Shift Up ol
Shift Down &/
Ehen et di
Ert Risht 4’
flip Yerlical &Y
Flip torizonlal 6H

B ——

Put Characler

2
(el [hmtle%@ﬁ I f‘h
ol =l b g
- —— s b - - 3;’ \O
T %
Cllbea 021 %6
L Ledt b
Shafl Risht &
fap Verlical &Y
Flip Harizontal GH

This command places the character curently selected on the ieyboard
map into the edit window.

The Get Character command is usable only when at least one font is
open, It otherwise remains dimmed.

The Put Character command places the character currently in the Edit
Window buck into the font at the position of the character selected on
the Keyboard Map.

This command muy be used only when there is at least one font open;
otherwise it appears dimmed.
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Shift Up
fesian.

fel Characler 46
Put Character AP

Stift Down Y
Shift Left i
Shift Right 4’
Flip Yerlical  dY

e

Flip Horizontal K

Shift Down

Cel Characler 46
Pul Characler &P

Eﬁ.’f‘.f.‘ Y

Stk Letldi |
Shift Right &'
Flip Yertieal Y

Flip Horizontal dH

e PSS SR |

The Shift Up command shifts the character in the edit window up
one pixel. The top row of pixels wraps around to the bortom row.

This command remains dimmed and may not be used until at le2st
one font is open.

The Shift Down command shifts the character in the edit window '
down one pixel. The bottom row of pixels wraps around to the top
row.

This command remains dimmed and may not be used until at least one
font is open.
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rﬁst thiracler 43
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The Shift Left comrand shifts the character in the edit window to
the left one pixel. The leftmost column of pixels wraps around to the
far right column,

This command remains dimmed and may not be used until at least
one font is open.

The Shift Right command shifis the character in the edit window to
the right one pixel. The rightmost column of pixels wraps around to
the far left column,

This command remains dimmed and may not be used until at least
one font is open,
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Flip Vertical

Desian: _
, Gel Characler 46
i Pul Character &P

_'_'“-—-—_1

. Shift Up 6l

v Shift Down ds
Shifl Left i

Shift Right @
A e mmeatgge

I Flig Lorizondal 6l

Flip Horlzontal

S
Cet Character 46
¢ Pul Characler 4p

-_—_.--"—'-—_-q
i Shift Up &L

. Shitl Down 47
| Sift Left &
Shifl Right &
Flip Yerlical 4y

B T

0
[

The Flip Vertical command reverses the way a character is .

displayed vertically on the screen. If a character is right-side up,

it will appear upside-down afier this command is selected, and
vice-versa. c

This command may be used only when there is at least one font
open; it will otherwise remain dimmed,

The Flip Horizontal command reverses the way a character is
displayed horizontally on the screen.

This command may be used only when there is at least one font
open; it will otherwise remain dimmed.
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The Font Menu displays the names of the fonts currently open and
allows you to select the font you wish to edit.

If you have not opened a font with the New or Open commands,
you'll sce the dimmed message

Jao fonts in merory

when you pull down the Font Menu,

When you have one or more fonts open, the names of all open fonts

-appear on the Font Menu in the order in which they were opened.

‘e first fon opencd appears at the top, the second font opened
appears next, eic. To the leftof every fontname 13 the font's unique
font number.

The font currently being edited is indicated by a check mark (\f)

immediately o the lefuof the fontname, Unless you choose a
dilferent font, the last font opened is the font currently being edited.
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The Slze Menu

Size

Characler Wder 42
Characler Narrover d-

Change Fonl Height...

73

\

The Size Menu provides you with commands to increase and decrease
the width and height of characters in a font. The imponant difference
between the commands which affect character width -- Character
Wider and Character Narrower -- and the Change Font Height
command is this: the commands affecting character widih only change
the widih of the character in the edit window; the Change Font
Ieight command changes the height and base line of the ¢ntire font.




Character Wider

The Character Wider command increases the width of the character

e

-
I=

Change Font

The Change Font Height command allows you to change the height

L LR AT

- in the Edit Window.
currently in the Edit window by one pixel. Helght... and base line of lh; character currently in the
‘ i is at least one font open;
ol | This command may be uscd only when there is at least one font open; i m:ncftgcu?ia'rﬁn"a?nysbc Uscgd?“ly wh.cn there is at leas pe
I AR e otherwise it appears dimmed on the Size Menu. e dimm

Characler Wder  ds
Characler Narrower 4-

Fo

I LATAC.r halfQual d-

Er;n;e Font HHQM._

When you selecy the Change Font Height command, a dialog box

Churacters can have a maximum width of 28 pixels. If you try to sppoars;

widen a charicter beyond 28 pixels, your Aﬁp!c will beep and the
menu bar will fash 1o remind you that you have reached the maximum

N lanlals ohiiny

SN LI I G T )

% /J‘ widih for the current character. q
|0 ;
K 2 | Change Font Heighl
@0’% )“’/ Vo
Y "po 'AJ\ 5 i " :
e PR Fonl height: Font base line
e A Press (RETURH) Press CESC)
% . =
O) T
¥ = o)
Charactaer Narrower The Character Narrower command decreases the width of the character @ iy

currcntly in the Edit window by one pixel.

Lo

- ; The Change Font Height dialog box c?nméns inf(;lutcgm {or:om
e This command may be used only when there is at least one font open; B : height and Font base line and buttons for OK and Cancel.
' y be used only when there Is at leas pen; - it . , - Bt T ’
[ Charielir e 40 otherwise it will remain dimmed on the Size Menu. blinking insertion point appears in the Font height input bar.
ey Characters can have a minimum width of 1 pixel. If youtry to makea  p. i The Font height input bar contains the font height of the ehinrsctor
R R S ‘_.hjl‘rru:;‘_.trrnmuwcr than 1 pixel, your Apple will beep and the menu = 3 currcr_nly in '-Flc Edit Window, while the Font buse line input bar
Chinak Fanl Hughl. bur will flash to remind you that the character being edited is at the contains the base line of the current Edit Window character. You
minttnunm ullowable widih and cannot be edited funher. b can enter new height and base line specifications in the input bars

by deleting the curmrent values and entering new ones. You will
only be ullowed to enter numeric values.

h e

Characters in the same font can have different widths; when you
change the font height, however, all characters in the font wnﬁ
share the same new height. Characters can have a maximum height
of 28 pixels and a minimum height of 7 pixels. The base line value
cannot exceed the font heipht, 1f you try to enter an illegal value,
your Apple will beep and the menu bur will flash, and the value
you entered will be replaced with the previous value,
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To move the insertion ml back and forth between the Font height
input bar and the Font line input bar:

« If you're using a mouse, F\Im:e the pointce inside the input bar
you wish 10 edit and click the mouse bution.

« If you're using keyboard controls, use the ¢ and — keys
or Tab and CTab 1o move the insertion point.

When you're satisfied with the specifications in the input bars, click

on the OK button, or press the Return key if you're not using a mouse.

Clicking on the Cancel bution or pressing the Esc key cancels the
openition,
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arrow

Il you're using & mouse, the arrow is one of the three types of pointers used in
MuluScabe. You use the aow 1o choose commands from the menu bar, specify
opuons, and activate the scroll bar,

ascent
The distance from the base line of a font 10 the 1op of the tallest character is called the
ascent of thar font

basa lont
In ForEdiwr, the font which appears in the font window when you select the New
command 1s called the base font, because you build upon it in creating new fonts.

buttans

Butions are boxes which appear within a dialog box. When you "press” a button by
chicking on it or pressing the designated keyboard equivalent, the action associated with
the word wluch appeass on the button is performed,

chooslng
Conlisinung the currently selecied command by clicking or pressing Retum,

clicking

Inpressing and then rapidly releasing the mouse button is referred 1o as clicking. You
click 1 order W chowse an opuon, place an nsertion point in lext, or W confirm an
Opefation,

command

A MuliScnbe command is any instruction you give MulliScribe to perform an operation -

OrF Lk,

current setting
e carrent setung is ahe the opton currrently chosen,

currontly selected command
A command which appears highlighied on & menu.

cursor

The Hashing verucal bar which marks the inscriion point st which you can enter (ext.
e cursor abo marks the inscrtion point within a dialog box by appearing in sclected
nput hass il causing selected opuon seltngs 1o Nash,
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descender W
CcrtainIowacaselcum,wchujmdy.hangbebwﬂubaxlwmdmulhd
descenders,

descent
maismﬁmmmmmu\emmmmmmm.hﬂm
called the descent of that fonL

dialog box
Dialog boxes appear inside the document window whenever you're performing an
operation with MultiScribe which requires additional information, a choice of several
opuons, or your approval before procecding.

distinct word

In MuluScribe, a distinct word is any group of alphubetic characiers separated from
other alplabetic text by spaces, numbers, puncuation characters, or other special
characters,

documeant

A MuliScribe document is any text and formatting you create at onc time in
MultiScribe. When you save a document, it becomes a file on disk and has a
ProDOS filcname,

document window
The "window” through which you view and cdit your word processing documents.

dol malrlx printer
A dot mawrix printer forms characiers by creating grids of 1/72 inch printed dots.

dols '

FomEditor's edit window contains a character grid which consists of a mauix of
filled and blank pixels. The filled pixels represent parts of the actul characwer being
edited or creawd. For the purposcs of this manuwal, the blank puxels which sumound
the font characier will be referred 1o as dots, The editing process used in FonlCuiwoe
involves changing dots into filled pixels and filled pixels into dots using the mouse
or keyboard commands,

doubleclicking
Quickly clicking the mouse butwn wice is a procedure used o selact filcs and fonts

from the file lisls which appear in the scroll windows of some commands’ dulog
boxes.
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dragging
Simultancously pressing and moving the mouse In order select
7 10 continuous)
sumcmmg(hicm.u}alochooscnmnw\d&mam g
llle
Any information - word processing documen, data, i
_ application -
tn one place under one name on a volume (disk, hard disk, RAM?;?:)m e

font
A characler set.

font helght

The height of a font is the sum of the font's ascent and descen i

or the dis
the wp of the wllest character in the font 1o the bottom of the ll:;rwest dcscmdam s
The font height detennines the point size of the font. i

font number

The unique number assigned 1o a MultiScribe foat. Numbers 1 through 200 are
fecoved fur foots created by Styleware, If you create your own fonls with
Fontfdiwr you can give them numbers 201 through 254,

lontnamao
A name given 1o & MuliScribe font file,

highlight

hght will appear durk, and vice versa,

I-boam
1] yuufn: wang anouse, the [-beam is one of the three types of pointers used in
Muduficnbe, You use the I-beam 1o set the insertion point and o select teat in the
document vandow for edining, deleting, and replacing,

Input bars
Inmthmawcarindiaiogbmumdnﬂowymmtypcinmfmnum Whea you

click on an iput bar with & mouse or move 1o the input bar using keyboard commands

(aruws, Tab and GTab) an insention point appears, allowing you o type.

Inserntion polnt

The place al which text is entered into your document, marked by the Mashing vertical bar

OF cursar,
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keyboard equivalents _
Some MuliiScribe commands can be executed without going 10 the menu by pressing
the O key and a character key simultancously; these commands with keyboard

equivalents have the O and character keys Lo press specified 1o the right of each
command on their respective menus.,

kllobyts

Abbrc{‘muzd as K, a kilobyte is equivalent to 1,024 charciers including spaces. In
the Save As, Open, and Delete dialog boxes the space remaning on the specified
volume is displayed in K(kilobytes); in the About MuluScribe dialog box the
amount of room in memory for MuluScrnibe documents is also specified in K.

menu bar .
A horizonlal bar at the top of your screen thal contains the names of the pull-down
menus from which you choose commands.

online :
Commands and functions that you can choose directly from MultiScribe and that

also don'l require you (o reboot in order 0 return MuluScribe are considered online,
operatlon >y

An operation, also called a task, is any word processing job performed by MulliScribe.

optlon
Frequently, choosing a MultiScribe command displays a dialog box where you are
given a choice of several different ways a task can be performed. These choices are

called oplions,

optlon line

In conunands where it is necessary 10 choose from a variety of options, option lines
appear in the command's dialog box. An option line is a Line of option scltings
and/ur input bars,

page content

The dimensions of the page length and the two margins are governed by what is called
page conlent. The page content length resinctions are a maximum of 14" and a
minimum of 3" for actual ext. This is relevant o the Page Setup command from the
File menu where you specify page lengihs wnd margin sizcs,
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pixels

In FontEduior's edit window a character grid appears which consists of a matrix of filled
and blank |)u.c!:.‘ For the purposes of this manual, filled pixels, which represent parts of
the actual fual being created or edited, will be referred 1o simply as pixels. The blank

polnter

I youre using a mouse, the pointer is a small shape on the screen that moves ag you 4@) )k'poo
% B

muove the mouse. When you're creating text, the pointer takes the form of an I-beam and
it b wed 0 set the insenion point and also wo select tent for editing, deleting, and
replacing. When some forn of selecuon is required - when you're on the menu bar,
AL @ o, o watun 3 dislog box ~ the Poinier appears us an aow. When
MuluScabe performs an acuon wluch Likes a few moments 1o complete, the pointer
changes w an unimoveable winstwilch which essentially funciions 1o Lell you 1o stind by.

pressing
Holding down the mouse button down when you want 1o elfect a continuous aclion.

Propanional spacing

MuluScnbe funts use proportional spucing, which means that characier width and spacing -

are detemuned by the shupe of a particular characler,

scroll arrows

Sl s on the top and bottom of the scroll bar, which, when pressed with the
Mouse powiter, serll the docurment window continuously.

scroll bar

The column oa the night side of the document window which containg a small box called
a thumb which you drag up and down 1o scroll 8 document up and down,

scroll down
When you seroll down You move up in the document,

scroll up
When you scroll up you move down In the document.
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scroll window 4

In commands whatitisnecmuyfo:ymlolmcmloﬁkanrfmu,ldu]o.g
box appears containing a box — the scroll window -- with lists of files or fonts which
you can scroll up and down with the mouse or arrow keys Lo select and desclect the
items contained on them,

seloct

To choose something 10 be the object of a command. You select text for editing,
culting, copying, oc deleting by highlighting it in the docurpcm window. 'In those
dialog boxes that include scroll windows, you select items in the seroll window for
deletion, removal and instullment by highlighting them, In dulog boxes that include
option sclings you sclect options by clicking on them with the mouse or pressing
Rewmn,

task ik
A 1ask or operation is any word processing job performed by MuluScribe.

thumb .

The thumb is dragged within the scroll bar in order 1o move up and down in a
document. The number of the page displayed in the document window appears in
the thumb,

toggle )

A wggle is an on/off swilch. The Esc key is a keyboard equivalent of & ogzle since
il can be used 1o activale and deaclivate the meny bar; the Seleci/Deselect buttons in
some dialog boxes can also be looked on as wyggles.

ward wrap up

When you're deleting text and the number of charucwers w the left of the insertion
point cauals the mumber of spaces available for characiers at the end of the ling above,
the charucters o the lelt of the inserion point and the inscriion point move up w the
end of the line above; this is called wond wrap up.

word wraparound

Word wraparound is a word processing feature that automatically moves the inscriion
point and the word that you're typing from the right margin Lo the beginning of the
next line when you delete 1o the lef; margin,

wrlstwatch

If you're using o mouse, the wristwalch is one of the three types of pointers used in
MultiScribe. The wristwatch appears when MultiScribe performs an action which
Lakes & few moments 1o complete, ‘
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Appendix A: U
MultiScribe wit
AppleWorksm™

=

Because both MultiScribe an
AppleWorks allow you to save o
documents as ASCIT text files, & e
documents from the two programs o
can be exchunged. If you use botid,
provrams frequenty, you'll really i
appreciate this mutual compatibilitygs.
Yuu can ni.se copies of your old
AppleWorks documents, save the
Coupres ay ASCL text files, and read
theve teat fikes with MaliiScribe. You
can then use MuluSenibe 1o stylize
your old AppleWorks files -- by
selecung tent and changing fonts,
sizes, slyles, and fonmaiung.

=)
b

In much the same way, you can save
MulniSenbe files and then use these
tiles wath AppleWaorks 10 da spell
checking and mail merge. Of course,
your docunients will Jose font, style,
atze, and other special MultiScribe
features when they're saved as ASCH
teat tiles,

To Use AppleWorks Files with MultiScribe
1.

2,

Once you've read the text file into the MultiScribe
document window, you can use all the MultiScribe
commands to customize the text fi

Start up AppleWorks,

Choose optlon 1, “Add files to the

Desktop," from the AppleWorks Maln

Menu,

Use the commands on the Add Flles
Menu to read an AppleWorks file from

disk or make a new word
processor fllo.

XY

n

v

Once you've read your documant from

disk or crealed a new one, press QP to

choose tha Print command.

Choose the last option on the Print

Menu, Printing from “A text (ASCl) flle

on disk", to save your document as an k.

ASCII text 1lle on disk.

* Start up MultiScribe and use the Open

cammand to read the text file you've
Just created wilth ApploWorks,

MultiScribe document file on disk,
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To Use MultlScribe Flles with
AppleWorks

Start up MultiScribe. 0

Read a document flle from
disk with the Open command
or creale a new one by
enlering text.

When you've finlshed
modlfylng your document,
choose the Save As command
from the Flle Menu.

A dlalog box appears to let
you speclfy the path and
filename under which you
want to save your document.
Choose tha ASCII text optlon
solling lo save tho text as an
ASCIl text file. For mora
Information on thls command,
seo "Save As" In Chapler 4,
“MultlScribe Relarence."

5. Start up AppleWorks.

6. Choose optlon 3, "Make a new
file for the: Word Processor,”
from the Maln Menu.

7. Choosa optlon 2, "Make a new
flle: From a text (ASCII) flle,"
from the Word Processor
Menu.

8. Type In the pathname and
fllename under which you
saved your document.

9. Type In a name for the new
file.

Once you've read the text file from disk, you

can treat it as you would any other
AppleWorks document.
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Appendix B: Using 2 0%, [] Appendix C:
MultiScribe with Other WoPd ¥, * . = o MultiScribe
Processors 0 7%, 4 File/Disk
(74 D Organization
9% g T ,
% =k
As with AppleWorks, you can use Todise a Flle from Another D gfﬁ?‘iﬁi?ﬁ?ﬁ : uf Mﬁ;n%nc;'cl;c Side 1
lie ird pir 3 5 Wi [ 2
Ml e UM e g * [ Word Pracessar wilh MuiliScribe B e e otae e | plsciame U N
= S . The ocks
!l‘r’:_‘ “‘:r“:_‘_“z:‘fi‘ga‘i‘;i"ﬂ' ‘j\‘?’r(‘:’?ﬁ:g: 1. Save the document as an ASCII L, D program does not require this
files. Iflllxc text files ‘l';c;u‘cd by the text flle using whatever commands B ma g volume name 1950, PRODOS SYS 32
wurd processor are DOS 3.3 ext files the word processor requires. however, both sides of the MS. SYSTEM SYS 19
and not ProbOS, use the DOS 10 L dlslk muat' have the same MULTISCRIBE.1 $00 71
ProalsO8 consersion unlity on the 2. Start up MulliScribe. p. mom q VRIHGRRLmE. FONT.EDITOR $00 63
PraDOS User's Disk (wpnon C on U To.the right is a list of the files FED.SYSTEM SYS 3
e M onvert the :
]'),‘,,N,Ulg?_ 1enu) o convent the files to Choose Open fom the Flle Menu o bt q on the two sides of your
and read the ASCII text file Into = MuhiScribe disk. Side 2
In the same fashion, ASCII text files tha MultiScrlbe Document D
created by MuliSenbe cun be used by Window. T q Filename Type Number of
any word processor which can read 53 Blocks
them D
To Use a MultiScribe File with P oma MULTISCRIBE $00 157
Anolher Word Processor [—] CLIPBOARD.FILE $00 Sﬂi:'\ﬁlﬁﬂ;‘?;ﬂ"d
T material you cut or
1. Save the document as an ASCII e ] copy o the
lext file using the Save As U HENRRGIA S S Cllpbo:rd.)
command on the File Menu. o mm i e ENT .
U WORDSWORTH ~ ENT s
2. Start up the other word processor. MARK.TWAIN ENT g
b o s MILTON FNT )
3. Read the ASCII text file you've Just D DANTE FNT 6
created using the appropriate éﬁ'{‘b%\{R rm: 2
5 ; 5 Ve 4 <
commands from your word | SAKT P EARE ENO g
processor. D MICHELANGELO  ENT 8
t: — 3 NOTE: If you caulog the disk from BASIC, the type for PNT flss bs 307,
D 323 MULTISCRIBE FILE/DISK ORGANIZATION
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Appendix D: Vmé’@g;m 1s entirc disks and hard disks as volumes. Each ("
ProDOS Pathnames |  ProQD é)ﬂig)c must have a name. Volume names must: [-J . Appendix E: Keyboard Mouse
and Filenames Q. © - Keyboard ol )
* “begin with a slash (Y/'), followed by a letter; B -y Commands i The Keyboard Mouse uses keyboard controls o imitate the action of
A mouse,
. cun?n@ only letters, numbers, or periods; 5 3 o
i L op Wn menus:

¢ contain no spaces or characters other than -
periods; 1. Press Esc to actlvate the menu bar.
The menu bar is activated and the last menu you looked at is

pulled down.

e

* contain 15 characters or less, not including the
slash,

vy

2. Press the « and — keys to choose a menu
on the menu bar,

Each volume can contain files and directories. A filename is a
name given (o u file, A file is any information -- application
program, word processing text, spreadsheet data -- stored in one F
place under one name on a volume. The rules for naming filenames

are the same as those for naming volumes, except that you don't

have 1o precede a filename with a slash when you're using the -
MultiScribe Save and Open commands,

Press the T and | keys to select a

command on the seleclted menu.

Pressing the up and down arrow keys moves the command
selector from command to command on a menu,

highlighting each command in tum. When a command is
highlighted, it is the selected command.,

) | | ]|

U VRN VI § -V |

A directory is also a file, but it s a file used 10 organize and keep
track of other files. Directories can contain other directories, in
which case they are called subdirectories. You can use both
directories and subdirectories 1o organize your MuliScribe files on
disk. Dircciones and subdireclories are separated by a slash, The
rules for naming directories are the same as those for numing
volumes,

e

——
—d
»

Once a command Is sclected, press Return
to choose the command. *

When you sclect a command and press Retum, the
- task associated with the command is performed.

[®1

1

m
I
la W W w m

A pathname consists of the volume name, followed by any
nunibier of sulxhirectory names, followed by the filename,

e
HE |

To select text:

For nmrclinﬁmnutiuﬂ on ProDOS files, see the ProDOS User's :,,

Manuul, published by Apple Computer, Inc. Yoot 1ne nsartion point at the place In text

where you want to start the selection.

ot

2. Holding down the & or (3 key, press the

appropriate arrow keys to select the desired
text, pago breaks, or rulers.

w

3. Perform any actlon you want on the selocted
text,

EE
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A_;L Appendix E: Keyboard Commands
Apple l@?ﬁgqmvmenls for Commands

H | (e 1 99] 1Y

S SO

(&
Command Keyboa e Functlon To Remember * =3 Apple Key Equivalents for Commands
Equlvalent d}) . :
25 k. 3| Command Keyboard Functlon To Remember
Equivalent
Fils Menu
F‘ e q Search Menu
New ON Opens & now, empty document New i
in the document window, D Find ar Finds each coccurrence in a Find
‘ document of the specified text
Open... Al Opens  file, reading it from disk Unlike Dend O, lka € b mem ]
into memory and displaying It in ond U, J is an open Replace ORrR Replaces specified word or words Replace
the document window, character, F ; with other specified teaL
. -
Save as Saves a file to disk. Save A Goto Page # ao Moves the insertion point to the top Go 1o Page 8
of tha specified page,
Save As.. QA Saves a document o disk under a Suve A : s ; Format Menu
specified filename snd pathname. D ‘
- Insent Ruler ay Places o ruler in teat st the Y issimilor oV, a
Delets aD Deletes files from a specified path.  Delete B ma ; e o e
U for “insent here®
i ap Produc: Led of tha Pring - i
S mamuudn::::u e B a Show/Hids oM Displays/Hides rulers. Rulers are
Rulers ins truments for
Quit aQ Quits MultiScribe, Quit i D Measurement.
be wm o.m Insert Page g Inserta & page break of the bnsartion The - character
Edit Menu D Break point. looks like the dashed
' [P . line representing the
Cut ax Cuts sclocted text and places it In Scleciod wxl is (e _S page tveak on the
the Clipboard. X-ed ous, [] scroen.
- ‘ Set Paga # O= Sets the number of the first pags Set
oc Copics selectod teat 10 the Copy - pag page number
il Cmmﬂt E 5 In the document, rerumbering all equal 10 (=) the
subsoquent pages acoordingly. specifisd number.
Pate av Inserts or "pastes” contents of the V is u copyreader’s e _ﬂ ‘
Clipbuard, mark for “insert L0
material et this point” D
Select Al oz Selocts al of the cumrent document,  Seloctall s, AwZ, [ me m
26 APPENDIX E
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%
%

Apple Keygij%;&alemé for Commands
0 3%

Command Keyboard . Functlon
~2 Equlvalent
Seyle Menu Su.:.lhe style of seleclod Lexi or
Lext at the inserion point to:
Plain ar Plain
Bold an Bold
lialics At Ialicy
Underline au Underline
Shadow aw Shadow
Oulling a0 " Oulina
Inverted CE Invertsd
Subscript oL Subscript
Supersenipt aH Superscript

Apple Key Commands Not On A Menu
al - Places the cursor st 8 place

in Lext relative o the numbes

key pressed. For example,

Ol takes you ia the beginning

of & document, G5 takes you

10 the middle, A9 uikes you o

the end, etc.

Q, K Scrolls one wreen down, or backward,

0. O Scrolls one screen up, or forward.

328 APPENDIX E

To Remember

Plain Text
Bold
Tialics.
Underling

ShadoW

InvEned

Lower

Higher

Works like relative
cursor posidoning in
Apple Works,

The < charscler points
backward.

The » charecter points
forward.
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Appendix F: Using

MultiScribe with a
a 3.5-Inch Drive

in NiScri i r ri

To use MultiScribe with a hard disk dn‘ve.gour hard drive
must be ProDOS-compatible and have ProDOS installed.
Consult your hard drive user's manual to determine whether
your drive can be configured to run under ProDOS.

Use the Filer utility on your ProDOS User's Disk to copy all
the files on Side 1 and gjdc 2 of your MuliScribe disk to the
ProDOS directory of yaur choice. We suggest that you
create a sepurate directory for MultiScribe; for example, a
good name for this direciory would be
/HARDI/MULTISCRIBE™ You should copy all of the
files on Side 1 to this directory first, fot]uwc«rgy all the files
on Side 2. :

To run MultiScribe from the hard drive, you must first use

the ProDOS PREFIX command 1o set the pathname to the

directory on your hard drive which contains MuliScribe,

Using the supgested directory name above, for example,

you would type in the following command from BASIC:
IPREFIX /HARDUMULTISCRIBE

chl.éou should execute the file MS.SYSTEM. From
BASIC you would type this command:
iMS.S\’STLM

WARHNING: DO HOT RENAME ANY FILES
FROM THE MULTISCRIBE DISK.

Using MulliScribe with a 3.5-Inch Drive

To use MultiScribe with a 3.5-inch disk drive, use the Filer
utility on your ProDOS User's Disk or your Apple
System Ulilities Disk 1o copy the files from your 5.25.
inch disk to a blank, formatted 3.5-inch disk. You should
copy all the files on Side 1 (o the 3.5-inch disk first,
followed by all the files on Side 2. Be careful 1o copy the
files one ata time, and in the order in which they appear on
disk when cataloged. ,
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Appendix G:
Printers and Printer
Interface Cards
Supported by
KultiScribe

(O I

Apple lm:lﬁ’wr‘iplcr <

Epson FX,
Star Micronics ini 10x, ST-10
Okida 92 (lIlr\J){l})l
93, 192, 193
Apple DMP
Apple Scnbe
C. lioh Prowriter/NEC 8023
Brother

kidata 92 (Swandard),

Erintar Intedace Gards Suppared By MultiScriba

Apple Super Serial Card/lc Serial Port

Apple Il Parallel

Grappler +/Parallel

Grappler +/Serial

Oﬁl.lll'!.' |nlt‘r{.‘lL'c, Gmpplcr

O Grppler (Before 1984)
Pr.u.-liu' l’cnphcrulsﬂ’umﬂcl
Practicul Peripherals/Serial
Praciical Penpherals/Microbuffer 1
Videx Unipiint

Videx PS1O/Aarallel

Videx PSIO/Serial

Promethicus Graphind

Promcihens Versacard/Parallel
Promethicus Versicard/Serial
[Lappieard

Founth Diinension

Mountain CIPS/Purallel

Mountain CPS/Serial

Okidata Plug and Play/Graphics On
Okiclaa Plug and Play/Graphics Off
Pervott Printes link

Perisult Messenger

330 APPENDIX G

PKASO ;

Microtek RV-611 o

Microtek Dumpling GX _
Microtek Dumpling 64 =
Microtek SV-622C-Serial
Tymac PI'C 100, Tackler
Micromux Printmax
Micronux Graphmax
TexPrint Printit ‘
Spies Super-MX (Niceprint)
SSM Appic

S5M ASIO

Epson APL

ALS Printenmate

Star Micronix Graphstar
Old Star Micronix Graphstar
Thirdware Finperpring/Serial
Thirdware Fingerpring/Taralle]

Old Thirdware Fingerpriny/Parall

Wizard IP]
Laser 128 Pons
Automatic lce
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Appendix H:
MultiScribe Font
Specifications

MuliiScribe reserves the font
numbers 1-200 for
MuliiScribe fonts created by
StyleWare. When creating
your own fonts, assign them
font numbers greater than 200
and less than 255,
Unnumbered fonts are given
the number 0. Font numbers
for fonts on a volume are
displayed next to the names of
the fonts in the FontBditor
Open command diulog box
and on the FontEditor Font
Menu.

This appendix lists the
fontnames, numbers, and
point sizes for the fonts on
your MultiScribe disk, and
includes example characlers
from each font. Please use
the additional spaces provided
for recording font information
for any addutional fons you
create or purchase,

For more information on fonts
and font numbers, "About
MuliiScribe Fonts," in

Chapler 5 of The MultiScribe
User's Manual for
MultiScribe Version 2.0,

331 MULTISCRIBE FONT SPECIFICATIONS

Font Pi.Siza  Example
Hemingway 1 8 ABCder45608%
Standard,B0 2 10 | ABCdef4S6esx
Wordsworth 3 12 | ABCdef456@%$7
Mark. Twain 4 11 ABCder456982
wion |5 | | Acasidzoert
Dante 6 12 .ancm;uss_‘
Asimov 7 14 CEdei95CE
Chaucer 8 12 13Evefa606
Shakespeare 9 14 04 BC_d.e:— f:tﬁéu
Michelangelo | 10 12 | OBl IDe
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Using MultiScribe with a RAM Bijvay, %
0% P,
Inladuction 4
R
%%

Euginecring's RumWorks,™ and Ch
plEE TS oty . cckmate Technol i ™ | ili
::.:: \[Ill\,.\l.l-l -dnvcs. Lodded mto and executed from a Mléjr'ilﬁm: n:ms lhmc Capi;lblhly of ‘?u“'h. cards to
sy e Laster than nonmal, I you own one of the extehded mc'rmpry cards ir‘::::ndn;n?dungmbc :
above,

(@ .
Oue of the great henefits of extended memory cm?%xpplc's Memory Expansion Card, Applied
» Appl
create a RAM dnve and use it 10 make MuluSeribe faster and more powerful

you can

Taise MuluSenbe with a RAM drive you must do two things:

li you mustinstall ithe RAM drive;
S0 you st load MaluSente into the RAM drive,

These two procedures are explained below,

Step 1 Instaling The RAM Dava

The Mrst step requires it ‘

e cucn‘lrl-d ”L“m e n}o:s: cffu_r; on your part. You should consult the user manual provided with

J ok i ry card for detailed instructions on sening up 8 RAM drive with 0 i
ppesdix will only provide brief instructions for using the three cards mcndoncd\:tl)oviomcard: o

If vodre wsing an Apple 1 Memaory Expansion Card, you don'i even have to install the RAM drive

< MuluSeribe automatically detects i .
S 1 vally detects the Apple card and treats it as a RAM drive. You're ready 1o go on to

I vedre wnng an Applied Engin ering RumWorks™ i .
i ¢ un ! Engineering curd, i

;\llll‘lltl \,\.,”,‘.M I ‘-,'.‘"".' I-.\||.uuh-|."d|\k. which was pmvidmlil?:‘;%lr(gl;!:\remsscsﬁg)?\f;»l;c'sup“
;.‘[-|I\L bl ;tfl:nrs‘.. t wwse apnan A, “ProbDave options menu," from the Main Menu., The ProD: 'mnw"u
pLe. “h\l..‘z .:I:,pll;m I Install l:rnlinvc (4m)," from the ProDrive Menu, A RAM drive i;wc ;m
e urll'J‘c."l"m nve lnsalled,” appears on the sereen, along with the Apple BASIC )" rc)rcut ¢
gty i ¥ pr}mnpl, type an the Jullowing: PREFIX MULTISCRIDE, Place side 1 ofp e
;)ul..m\ s be disk in the duave Irom which you wish 10 run MultiScribe. If you're using a one- ]
u.-.'k\ " '.L\HI;;V.{. your R.fllleb:‘i"Ulllmc.‘. disk from the drive and replace it with si(lcbl of the &vc!l.is ibe
gk ) I\- etarn, Again the "|" prompt appears. Type in the following: -MS.SYSTEM, TI AR

clianbe ile sorven appews. Tum over the Jisk sl press Retum, . g

You're now ready to continue with Step 2.

W,
[P -..-lmh«nmdwhg—-.h. h-‘--llhumuu—nd&-n-h-ﬁ'm
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For additional information on installing 8 RAM drive with RamWorks, scc Chapter 5 (pp.|3-24). J
"RamWorks Il RamDrive,™" in the RamWorks Il User's Manual, published by Applied Engineering,

Inc.

If you're using a Checkmate Technology MultiRam™ card, boot side 2 (MuliiRam Udlites side) of the
ultiRam AppleWorks Memory Expander and Utilities disk. A Main Menu screen appears. Choose

option 3, "Install MULTIDRIVE.PRO (ProDOS RAM disk)" from the Main Menu. A second menu, tided

“MULTIDRIVE.PRO," appears. Choose option 1, "Install MultiDrive.PRO," from this menu.

When the RAM drive is created, a message appears on the screen, asking if you want w “Run the F[l-Efl
now (Y/N) 2" Answer no by pressing N. The Apple BASIC “|* prompt appears. To the right of the ]
prompt, type in the following: PREFIX /MULTISCRIBE, Place sufe 1 of your MuluSenbe disk in the
run MultiSeribe, If you're using u one-dnve system, remosve your
Multiktam Utilities disk from the drive and replace it with side | of the MuluScribe disk. Press Rerumn.
Again the “]" prompt ;I[Lllk:ilrs. Type in the following: -MS.SYSTEM. The MuluSenbe title sereen

appears, Turm over the disk and press Retumn.
You're now ready 1o continue with Step 2.
For additional information on installing a RAM drive with MultiRam, please consult Chapter 5, "RAM

Disk Emulation”, in the Preliminary Manual For The MultiRam Card, published by Checkmate
Technology, Inc.

e The RAMOH

Once you've instulled the RAM drive and started up MultiScribe, the menu bar Is displayed and a dialog
box appears, telling you that a RAM drive has been detected (as well as its slot and drive location) and
asking if you want MultiScribe loaded into it.

1f you click on the Cancel button or press Esc to cancel, MuliScribe ignores the RAM drive. If you press

Retum or click on the OK button to load MuliSeribe, the fonts are loaded into the RAM drive, and a
message appears, telling you that MuliScribe is wansferring your fonts to the RAM drive.

If you press Esc while the fonts are being loaded, MultScribe stops loading the fonts and continues
booting normally. When MultiScribe needs to access fonts, it looks for them on the MuluScribe disk and
not in the ram drive. If you don't press Esc while the fonts are louding, MultiScribe looks for the [onts on

the run drive,

333 USING MULTISCRIBE WITH A RAM DRIVE
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1
T

P, %
After the fonts have been transf F i i |
dnve, and this message Ippcmf Aﬁiox%f RS el lowded lio the RAM

When you use a RAM drive, you should be aware of three possible pitfalls:
{ use the Printer Setup command while using MultiScribe with a RAM

| 2
-
A D o .
N 1) You shouldn A _ Mult \
%y 2 % “m ) drive. If you Store (3S) the setup specifications with MulaScribe running on & RAM
S (HEL E drive, the specificutions are not written to a physical disk and will be lost when you
v d’% % turn off your Apple. The same is true of any files saved to the RAM drive path.
Transferring MULTISERIBE to ram disk. B 2) If you load the fonts and MultiScribe into the RAM drive but not the FontEditor
P E \%} : A ; rogram and leave MuldScribe to go to the Fond:ditor, use the FontEditor, and then
- gt i Olrlnsfer, ater return 1o MuliScribe, you'll have 1o reloud the fonts and MuliiScnbe back into
25 B the RAM drive ‘when you retumn to MultiScribe.
| Y0 5

1=

ake changes to fonts with the FontEditor in the RAM drive, save the font to
& pryr?;lﬁl disk wi&h the Save As command. If you just use the Save cormnmand, youll
only save the font 10 the RAM drive and it will be lost when you tum off your Apple. '

For more information on using a ram drive with MultiScribe, scc Appendix J, "Configuring Your
MultiScribe Disk For RAM Drive Auto-Install.”

If you press Esc afizr the fonts have been loaded into the RAM drive but ¢ iScri

) ve b ut before the Mul o
In,;.!ud into the RAM drive, MuluScribe stops loading the rogram into the RAM dn'v:. u\mmmﬂﬁ;' )
reL b program overlays or write 1 the Clipboard, Muithanw accesses the physical disk drive on which the

Mu'tsonibe program is located. 1f MultiScribe needs o access i '
i ceds (o access fonts, however, it looks for them on the

FY

il il

'F1

If you don't press Esc, MultiScribe is loaded into the RAM drive, and MultiScribe i

y . | ; ads the RA
when it needs to load program overlays and write to the Clipboard. MuliiScribe bc;cins ?omﬁing uP;flcdnvc
FamEdior program into the RAM drive next, and a message 1o that effect appears:

il

vy

iy

14

aJ

Transferring FONT.EDITOR to ram disk.
Press ESC to cancel the transfer.

Il you press Ese while the Fontliditor program is being loaded Mulu'Scribc.Ioolu for fonts a

5 ; ! : aded, nd the
MultiScnbe progruntin the RAM drive, but looks for FontEditor on the physical disk drive on which the
proveam disk is located. I you don't press Esc, all three major portions of the program are loaded into the
RAM drive and the program reads from and writes (o the RAM drive as if it were a physicul disk drive.

o
:DIDIDIB!DIDIHIEIEI_.
L

H'P_—tr!
|

-
b Lo L
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C}O
About FontEditor Comman Qﬂgj
About MultiScribe Command 3925;},

)

163
Apple (3) Key commands 31,
326-328
Apple (3) Menu (FontEditor) 287
Apple (3) Menu (MuliScribe) 163
Apple Il System Ulilities 18, 336-337
Apple ProDOS User's Disk 16, 18
AppleMouse I1 16
AppleWorks= 332-333
using MuliiScribe with 139,
320-321, 322, 328
arrow pointer 21, 26
ascent 224
ASCII text file format 136, 137,
178-179, 321, 322
ASCll text files 139, 140,175,
178-179, 320-321, 322

B

backing up (making copies) 18
backups, making 18

base font 229

base line 224

BASIC 178, 329, 332, 336
blank pixels 235

bottom margin 121, 128
butlons 25, 26, 32, 33

337 INDEX

N ey e e | e e St . gt

c
Caps Lock key 103

carriage returns  44-4§
deleting 92
entering 87
inscriing 89
Case option (Find command) 68, 99, 197
Case option (Replace command) 101,
198-199
center text 46, 54-55
chaining files for printing  157-159,
189-190 '
Change Font # command 295
Change Font Height command 250-251,
277-278, 309-310
changing
font 106
font number 280
format as you enter text 117-118
format of existing text 118
indentation 116
justification 116
line space 116
margins 115-116
setting on aruler 114-116
size of text 105
style of text  103-104
dimensions of a character 248-249,
275, 308
font height 250-251, 277-278,
309-310
font numbers 280
tabs 116
width of a character 248-249, 276,
308




character 86

character keys 86

Character Narrower command 248,
249, 276, 308

character spacing 224

Churuacter Wider command  248-249,
276, 308

character width 224, 248-249

choosing
characters 230-233, 264
communds 17,25, 28, 30, 80

Clear command (FoniEditor)
243,272,300

clearing a document 69

clicking 22-23,25-26, 81

Clipboard 65, 92, 194, 195
replice contents with Cut and
Cuopy 66, 194, 195

Close commiand  255-256, 283, 294

Closing foms 255-256, 283, 294

comnund 17

Copy command 31, 66, 95-96, 194

Copy I Plus™ utilities (Central
Point Soliware) 18, 178, 337
copying |
between documents 96
rulers 113
ext 66

within & document 95
current seiting 33, 34
currently selected command 28
cursor 19, 40, 88

338 INDEX

6‘00

°’&‘h
7 My,
Cut command 31, &?é% 2, 0/,
Vdp- % 5'4-/ 96‘@0

deleting rulers
to move text 93

to move text between documcn

cutting text 65, 93-94

D

date icon
footer 131
header 124

Delete command  148-149, 180-182

dialog box 180

fonts 213
Delete key 62,92
deleting

carriage relurns 92
files with Delete command
148-149, 180-182
fonts 213
footers 212
headers 208
rulers 113
selected text 62
text 44, 87
with Seleet All command 195
with Cut command 92
with Delete key 87, 92
descenders 22
descent 224
deselecting
fonts 191
selected text 61-62
Design Menu 301
dialog boxes 25, 29, 32
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dimmed
menu choices 206, 210
commands 31
files that cannot be deleted 148,
181
directories, ProDos 324
distinct word 68-69, 99, 101, 197,
199
document 17
document window 19, 82
gelting around in 84
using Apple 1-9 keys 84
using Goto Page # 84
using scroll bar 84
dot-matrix printer 223
dots 235, 267
double-clicking 22-23
to open a file 147
dragging 22, 81
I-beam 1o select text 60
icons 206, 210
to choose a command 24-25
to select a Page Break 91
to select text 90
to select a ruler 91

E
Edit Menu (FontEditor) 300
Edit Menu (MultiScribe) 194
cdit window 228
placing selected character in
233
editing footer text 129-130

339 INDEX

header text 122-123
text 60-69, 86-110

editing characters
with apple and armow keys 238-239,

269-270

with the keyboard 238-239, 269-270
with the mouse 235-237, 267-268
with FontEditor 234-248, 266-274
enwering carriage returns 87
tabs 50, 87
text 40, 86
footer text 129
header text 122

Escape key 27
to activale the menu bar 27, 30, 80
to deactivate the menu bar 27
to pull down a menu 27

expansion slots (for interface cards) 155,
164-165

F

file formats 136, 137, 139

File Menu (FontEditor) 288

File Menu (MultiScribe) 171

file/disk organization 323

filenames, ProDOS" 324

files 17

Find command 67-69, 72-73, 98, 196-198
dialog box 196
finding and replacing text 102
specified text 98, 102

flip commands 244, 274, 305

Flip Horizontal command 247, 274,305 .

Flip Ventical command 247, 274, 305




flipping characters 247, 274, 305
Font Menu (FoniEditor) 254, 306
Font Menu (MuliiScribe) 213
| font numbers 108, 192, 220-225, 227
[ 2R0:33]
changing a font's 280
list of font numbers 331
reserved 222,227, 280, 331
unnuwmbered font dialog box 222
| font window 228
| FomEditor 160, 170
| menu bar 226
pre-installed accessory 166
Fontl:ditor command (MultiScribe)
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proponional spacing 225, 248
pulling down a menu
with the Keyboard Mouse  29-30
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